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1 
STRUCTURE OF THE MANUAL 
 
This Manual contains reference and instructional materials for the broadcasting and scheduling system 
DIGISPOT® II.  
The DIGISPOT® II system is a complex of various-purpose software utilities, the backbone of which is the 
broadcasting and scheduling system DIGISPOT® II DJin, called “DJin” by its developers. 

Section 2 is devoted to familiarization with the DIGISPOT® II system as a whole. It describes in brief 
the functional capabilities of the entire system and provides information about the constituent software 
products and their functions. Because DJin and some other system's applications are based on the 
modular principle, the section gives a brief description of the modular organization and its advantages. 
The same section lists the system's operational hardware requirements and givesa short review of audio 
cards from several manufacturers. The last subsection provides background information on the remote 
control options used in DIGISPOT® II. 

Section 3 provides information on data types used in the DIGISPOT® II system. It describes types 
and formats of audio files supported by the system. It also presents the concepts of the main data types 
specific to the system: skeletons, schedules, projects, etc. The structure of schedules and skeletons, their 
function, differences and similarities are considered. Some procedures employed for creating and filling 
schedules and for using time control points are described. 

Section 4 is devoted to the DJin program exclusively. It contains descriptions of all system modules, 
windows, and settings, and short examples of using various modules. The section is constructed 
according to the sequence of actions performed with a schedule during all its life cycle, starting from the 
moment of its creation and ending with its broadcast. Therefore, the beginning of the section describes 
creating a schedule. Next, the process of editing a schedule and the player modules that broadcast a 
schedule are described. Then the descriptions of the main data source modules come, followed by 
explanations of auxiliary modules and windows. At the end of the section, the description of the program's 
configuration system is given. 

This Manual is intended for users who have a certain level of experience working with the Microsoft 
Windows operating system. Users are assumed to be familiar with the typical for this system user 
interface controls (such as menus, buttons, lists, etc.) and their operation (double click, Drag & Drop, etc.) 
Some knowledge on the radio broadcasting subject is also assumed, so common terms and names used 
in this field are given without explanation. 
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2 
INTRODUCTION TO THE DIGISPOT® II SYSTEM 
 
This section sets forth introductory information necessary to understand the essence of the DIGISPOT® II 
system. This information includes the following: 

• A general outline of the system's purpose and its application areas. 
• An enumeration of the system's functions and modules being implemented 

in these applications. 
• Modules of the DIGISPOT® II system. 
• The requirements for creating a studio computer network and its software. 
• Concise recommendations given by the development team that regard selection of audio cards 

for workplaces of the hardware and software environment, in which the DIGISPOT® II system is 
used. 

• Capabilities which open at the combined application of the DIGISPOT® II system and remote 
control equipment. 

2.1. The Purpose and Application Areas of the DIGISPOT® II System 
 
A bird's-eye view on the problem of organizing broadcasting makes it seem very simple and comprising 
only three items: preparing a schedule, filling it with content, and broadcasting it on the air. However, a 
closer look will reveal that everything is not so simple. 

First, a schedule for the next 24 hours needs to be put together. For this, you need to specify 
exactly the airing and running time for such constituent parts of the program as music, voice, on-the-air 
news, and commercials, as well as for the jingles delimiting individual blocks. 

This abstract schedule needs then to be filled with due content. You need 
to select music and organize its rotation. Rotation means the freshest hits are repeated most often; songs 
that were popular just a short time ago and will 
be in demand for some time in the future are played less often; the frequency 
of never-getting-old golden hits follows the recent hits, etc. In short, a user tuned into the radio station for 
a prolonged period must be supplied with all music of the type he expects today. In addition, the text of 
running commentaries to be read 
by the announcer on the air needs to be prepared for displaying on his monitor. Also, a good supply of 
jingles needs to be stocked up and their alternation organized in such a way that on one hand, none of 
them would become trite, while on the other hand they would create an individual, well-recognized audio 
"image" for the radio station. 

Finally, the designed and filled with content schedule needs to be implemented in a high-quality 
broadcast. For this, the schedule blocks that are to be executed automatically need to be informed of the 
current time and of the location of the files to be played. These files must be loaded into the virtual player 
a certain time in advance, and a signal for their playback must be issued at the proper time. 

If some segments of the schedule require human (e.g., an announcer, operator, or DJ) participation, 
all the necessary material (e.g., text) along with his own virtual player and the necessary controls (e.g., 
the player's on/off buttons and faders) must be made available for him. And, of course, the man must be 
reminded about the approach and arrival of the time when he is due to go on the air solo. 
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DIGISPOT® II handles all tasks of the three described broadcast organizing stages outstandingly. 
It is easy to say "Put together a schedule." But how is it done? What are you to begin with? The 

DIGISPOT® II concept gives an unequivocal answer: by developing 
a schedule skeleton. A special skeleton-editing window is provided for this task. 
A skeleton is essentially a schedule blank that specifies types of blocks that must 
be in it, the start and end times of each block, and the order of different type blocks. Just like Lego blocks, 
these blocks can be used to construct a skeleton for 
a one-hour schedule and then make 23 more copies of this hour. Later on, when converting the skeleton 
into a schedule, the program tasks can be specified. For example, instead of the vague "play music" 
command, a concrete song can 
be specified. Also, DIGISPOT® II can be instructed to use an external rotator program 
to place into the music block a track that the program extracts from its stock using a special algorithm. 

A group of logical conditions can be used to define, which of the available skeletons is to load at the 
start of a specific weekday, to execute during a certain month, or to broadcast on the New Year's night, 
the Mother's Day, or some current holiday. 

The program's developers clearly see the difference between a plan and its implementation. Many 
things may not go as planned: The announcer may rattle through the text quicker than intended, or on the 
contrary, mumble it longer (although the system is equipped with means for estimating the time for 
reading text), or a music file may turn out to be not at the specified location. Consequently, an extensive 
system for automatic conflict resolution and for filling up gaps, both long and short, is provided. Those 
blocks that are rigidly fixed to the schedule, for example, the time signals, will be reproduced on time 
without fail. If there is time left after all scheduled material has been played, the potential gap can be filled 
with music. 

Although all functions are automated, the broadcast presenter can intervene into the schedule 
execution at any time. While the current song is playing, he can prepare a text, save it to a file, and 
immediately edit it. Then he can smoothly crossfade music into voice, using only two controls for this. If 
for some reason 
an advance recording cannot be made, a real-time microphone insert can be made. 

Sometimes, there is reserve in the schedule especially for the DJ's creative work. While the 
previous music composition is being played, he can use the pre-fade listening (PFL) system (listening to 
the audio without sending the signal on the air) to select the next song from his personal subject category 
or from the common database, reduce its play time by cutting off the Intro and the Outro, and send the 
result on the air at the proper time. He also has a jingle machine at his disposal that allows him to 
reproduce a jingle suitable for the given situation by a touch 
of a button. For example, an incorrect answer to an interactive game question can be booed, while the 
right one reacted to by playing back a sound recording 
of a storm of applause or wild cheers. 

What deserves a special mentioning is the fact that all program functions can be controlled both 
from the computer keyboard using hotkeys and from the specially designed console. The latter is 
extremely convenient to use and 
is so simple in design that it will be difficult to mix up buttons or knobs even 
in a stressful situation. 

The DIGISPOT® II system is designed to be used as part of a complex that includes several 
workstations. These are one mandatory broadcasting workstation and 
at least one workstation for preparing schedules. The need for the latter is obvious: if a radio station 
broadcasts most of the day, the broadcasting workstation cannot be used to prepare schedules. The 
workstations for preparing schedules must 
be separate but interconnected with each other. Usually, a schedule has several parts that are put 
together in the end. These are a separate commercial schedule, 
a separate musical schedule, and, if the radio station is engaged into news broadcasting, a separate 
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news schedule. Consequently, it is desirable to have three scheduling workstations in addition to the 
broadcasting workstation. 

The workstations are connected in a network. As a rule, a network has a file server that stores on its 
disks files with music, commercials, jingles, etc. References to these files are stored not only in the file 
system but also 
in a convenient database, which allows the user to rapidly find the necessary material by a diversity of 
characteristic attributes (e.g., the composition name, the author, the performer, etc.) Schedules can be 
edited from any workstation. However, to prevent this process from becoming chaotic and getting out of 
control, an administration system was developed. Each user has only those rights that are granted to him 
by the administrator and secured by a personal password. 

In the event of the server crash, there is a backup system provided, which allows the broadcasting 
workstation to work autonomously (not communicating with the server) for 48 hours. 

It must be noted that no physical tape or CD players are needed for the broadcasting itself. All 
music is digitized beforehand and saved to files that are compressed without noticeable quality loss and 
saved to hard disks. The files are played back using software players. There are many of them in 
DIGISPOT® II, for all occasions and for all tastes. The bank of music compositions can be replenished 
both from CDs and from the Internet. 

As they develop and get economically stronger, many radio stations strive 
to expand their audience. This goal can be approached both in a creative way 
(e.g., creating programs that are of interest to various age, social, and professional categories of 
listeners) and in a purely technical way by extending the radio- station's coverage area. It would be the 
easiest to increase the transmitter's power. However, this is prohibited by the conditions of the 
broadcasting license, compliance with which is closely watched by both the responsible state structures 
and the competitors. Another way would be to rent an antenna taller than the antenna of the competitors 
and directed at those sectors, in which the most profitable advertisers reside and the most active potential 
buyers of the advertised products live. But this technical solution is expensive, is not always available, 
and there is a good chance it may never be profitable. 

At the same time, practically any radio station already has in its arsenal 
of technical means a device that in principle can increase the quality coverage area by a good ten percent 
without entailing any extra expenses or violating any laws. This device is called the Frequency-
Modulation processor (FM) and operates 
as follows. Before being fed into the transmitter's modulator, the audio signal that was generated at the 
studio undergoes various processing. Among other operations, the signal spectrum is corrected and its 
volume compressed. The quality of the received signal (or the maximum distance from the antenna to the 
receiver at which reception is possible) depends on the average value of the signal parameter called the 
frequency modulation index. This parameter can be varied, regulating the degree of the signal volume 
compression in the FM processor. However, there is a major problem with this: The real audio signal is a 
time-varying random process, as its parameters (in particular, the dynamic range) continuously and 
randomly vary. Therefore, it is difficult to automate this process. Thus, if the FM processor is configured to 
process music, at the edge of the reception area voice will be almost inaudible. If, on the contrary, voice 
processing is optimized, music will be distorted. Moreover, even if the radio station were to continuously 
transmit only music, the problem would not go away anyway. There is music, and then there is music. 
The dynamic range of the modern electronic dance music is extremely narrow (it is even compressed 
beforehand in anticipation of FM broadcasting). Retro music has a wider dynamic range, and that of 
symphony music is so wide that without a substantial compression it will not fit into any record-transmit-
playback channel. 

Looks like there is no easy way out of this situation and you have to put 
up with the distortions during the transition processes that are caused by the change of the audio material 
when the FM processor operates in the automatic mode (and lose your audience instead of expanding it). 
Or you could put 
an operator to the FM processor who would have to hold the device controls, watch the "musical score" 
prepared especially for him, and try not to miss the moments 
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of his "performance" on the round-the-clock basis. Even if this hypothetic solution could be implemented, 
most likely the results would be even worse than with the automatic controlling. 

But there is a simple and perfectly logical solution to this problem offered 
by us. Its essence is as follows. As you know, references to the played back files are stored in a 
database. In addition to the name of the audio item, author, copyright, and other similar useful data, each 
database item has many other attributes. These attributes define and describe the item very precisely. 
They, 
in fact, compose a portrait of the file, which can be as detailed as specified beforehand. Well, when 
reproducing files with different sets of "facial features," the program can direct each audio signal into a 
corresponding channel. In turn, each channel has its own FM processor preconfigured for the optimal 
processing of the given type of signal. The outputs of the FM processors are joined and connected 
to the transmitter's modulator. Consequently, regardless of the audio signal properties, its processing is 
optimized. The reception is always of the highest quality at the maximum radio station's range. 

Along with other information, the schedule blocks of the DIGISPOT® II system can store remote 
control commands. Over the RS-232 interface, these commands can be sent to any external device, 
including the FM processor, to adjust its parameters according to the properties of the material to be 
played back. 

All this time the DIGISPOT® II system was discussed as something uniform. In fact, the system is 
multifaceted. Depending on their requirements, users can order any configuration best suitable to the 
nature of their radio station.  

A schedule can be broadcast completely in the automatic mode. Should the circumstances require 
an urgent human correction of a schedule, this task can 
be easily handled by a single DJ operator. He has at his disposal the pre-fade listening capability as well 
as a few faders and buttons that are simply impossible 
to mix up. These are quite enough for airing (on-the-air work). Basically, in order 
to expeditiously control broadcasting of even a largest radio station, only two more employees are 
needed besides the DJ: a duty engineer and a duty system administrator (in case of the radio or 
computer equipment malfunctions). 

Lately, there has been a rapid growth of commercial music and commercial radio stations in 
relatively small communities. They constitute a noticeable part 
of the users of our production. These radio stations mainly retransmit music programs produced by their 
"elder sisters," inserting in them blocks of local news and commercials. For them, there is no need to 
equip themselves with expensive configurations of the DIGISPOT® II system; their needs can be met by 
other, less expensive, configurations The most popular of such configurations is DIGISPOT® II DJIN 
Retransmission. 

For all its outward simplicity, DIGISPOT® II DJIN 777 handles perfectly any most difficult task 
facing a retransmitting radio station. Blocks of the local news and commercials must replace the 
corresponding blocks from the central radio station schedule without audible flaws and without butting in 
on the music composition time. To attempt to carry out this switching manually (which capability actually 
does exist), an operator would have to be on duty at the console around the clock, being in a state of 
constant tension and ready, upon hearing the jingle preceding 
a commercial, to instantly switch to airing a local block. 

DIGISPOT® II DJIN 777 does this job without human participation. The program stores samples of 
jingles that serve as cues to switch to the relevant blocks. Audio patterns of jingle signals are recognized 
using spectral-correlation analysis and artificial intelligence methods, and a decision concerning 
automatic cessation 
or resumption of the broadcast is made. 

Another way of extending the coverage area of a large FM radio station 
is creating a network of unmanned retransmission stations. Traditionally, the signal is delivered to them 
over leased communications channels. Often, these are expensive satellite links. It was noticed long ago 
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that commercial blocks are frequently repeated and that practically the same music may be rotated during 
several days or even weeks, selected from a rather limited repertoire that 
is relatively seldom renewed. The jingles themselves stay the same virtually over the entire radio station's 
existence. It turns out that expensive satellite links are used to pump to the repeater mostly the same 
information. All content of the central station database in there at the time the retransmission station is 
first put on the air (i.e., music, commercials, and jingles) can, in principle, be stored in the retransmission 
station's local database (e.g., brought on a CD along with the equipment). Afterwards, the retransmission 
station functions based on a very interesting algorithm.  Using the Internet, the retransmission station's 
computer will periodically connect to the central station's computer to first renew the broadcast schedule 
and second to check its database against the central database. Because only text descriptions of audio 
files and not files themselves are transmitted during this operation, it does not take much time. The files 
absent 
in the central database are removed from the local database. And vice versa, new files in the central 
database are downloaded to the repeater's database. Because there are not many new files (which are, 
moreover, compressed), transferring them over the Internet is not a problem either. This technology is 
based on the effective delta modulation principle, whose essence lies in transmitting over 
communications links only the change of information and not the whole information. As a result, the costs 
of maintaining a network of retransmission stations are significantly lowered because of dispensing with 
expensive satellite data transmission links, as well 
as because of considerable savings on equipment and its maintenance. 

2.2. DIGISPOT® II Functions 
To perform the entire complex of the tasks of preparing a schedule and broadcasting it, the DIGISPOT® II 
system contains a whole series of function modules. Various DIGISPOT® II system configurations are 
built from these modules to meet 
a specific radio station's needs and capabilities. 

The following is a list of the function modules available at the time this manual was being prepared, 
and their short description. 

Base Platform. A set of basic functions needed for the overall system functioning. 
Multichannel X Player. Broadcasts a schedule through several physical outputs. Distribution over 

the outputs is automatic. Manual, semi-automatic, and automatic operating modes. Audio items and 
crossfades can be edited directly 
in the player.

Block Player. Playback of playlists (sequences of audio items) over one physical output. Schedule 
blocks can be loaded into the player automatically. 

Retransmission Player 777. A block player controlled by the retransmission switcher 
Audio Pattern Recognition Module. Analyzes the retransmitted signal 

to detect one of the predefined patterns. When a pattern is detected, generates 
a command to switch to local broadcasting (or to return to retransmitting) for the retransmission switcher 
module. 

Retransmission Switcher Module. Controls the Retransmission Player, the Audio Pattern 
Recognition Module, and the Guard player. 

Guard Player. A block player controlled by the retransmission switcher. Broadcasts backup 
material when the main retransmitted signal is lost.  

Fast Jingles Player. Plays back a jingle from a group of jingles by pressing 
a keyboard key or a button in the external button field (keypad). Has its own simple rotation algorithm to 
avoid repeating jingles from the same group. 

Jingle Machine Player. Allows a necessary jingle item to be promptly aired. The table organization 
of the items provides for a rapid location of the needed item. Can be controlled from an external button 
field.  
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Insert Player. Serves to automatically create a local program from a mother-station program by 
replacing a part of the main program with local content. The player is controlled by the main station. 

Schedule Module. Used to display, edit, import, print, and do other operations with schedules. 
Schedule Skeleton Wizard. Serves to organize the broadcast subject pattern and to optimize the 

schedule preparation process.  
Track Marking and Normalization Module. Provides track marking (setting the Start, Stop, Intro, 

etc. marks) and sound level correction capabilities. 
Start Point Seek Module. Used to find the point, from which playing back 

a track is to start. An easy search method allows the module to be easily controlled both from the 
computer keyboard and from an external button field. 

Module to Record Voice Tracks in Schedules. Records schedule fragments containing DJ voice 
at the crossfades between two schedule items. 

Schedule & Player Crossfade Edit Module. Makes it possible to splice two adjacent schedule 
items to be played back overlapping each other. The volume levels of the spliced items can be controlled, 
the Intros and Outros chopped off, and the fades edited.  

Schedule Audio item Edit Module. Used to perform any type of editing, including multichannel, of 
any schedule item, to superimpose a jingle on a track, etc.  

Gap Filler Module. Provides the capability to automatically generate 
a fragment of a schedule broadcast in the unattended mode in the event of a gap due to, for example, 
scheduling errors or communication breaks. 

Data Backup Module. Handles storing to the local hard disk all on-air material needed for the 
broadcasting. Allows long-term uninterrupted broadcasting maintained (up to several days) in the event of 
communication link failures. 

Schedule Import Module. Used to import schedules from text files that were created by an outside 
schedule-generation system. The import module has flexible configuration and can be preset to import 
practically from any known format file.  

Files Module. Intended for viewing the contents of the local hard disk or LAN, listening or viewing 
files, and editing file properties (e.g., markup, textual description). 

F-Categories Module. Makes it possible to organize a simple two-level operational material 
storage system. Provides a capability to create subject track groups and to edit or view them from any 
workstation of the system. 

On-Air Log Generation Module. Creates a text file log with information 
of the broadcast tracks. The log can then be printed using report templates that allow the document's 
appearance and content to be customized. 

BCS Multichannel Audio Editor and Text Editor. This is an independent application that can be 
installed on the workstations along with other components of the DIGISPOT® II system, as well as 
without them. Its main purpose is to provide capabilities for independent production of audio and text 
material for subsequent broadcasting. It is also used to replenish and edit the media database.  The 
application is targeted at performing typical radio production editing operations: recording, editing, level 
adjusting, processing the signal by external DirectX plug-in modules, etc. One or more channel tracks can 
be edited at a time. 

Media Database (MDB). This is a specialized database operating under Microsoft SQL Server 
2000. The database contains descriptions of items, a set 
of categories and attributes created by the user, and other relevant information. The database solves the 
problem of categorizing the items, with the capability 
of item's belonging to several categories at the same time. Some of these capabilities are the following. A 
hierarchic category structure with an unlimited number of nesting levels is allowed to be created. Also, the 
items that have the same value of a certain attribute can be filtered out, for example, all songs 
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by a certain author or all news items prepared by the same reporter. Items can 
be searched for by compound search conditions. The list of the database capabilities can be continued, 
but those already enumerated should be sufficient 
to give an idea about its prowess. The main task of the database is to store items 
in order to rapidly locate the material needed. The built-in administration system makes it possible to limit 
the rights of an individual user allowing him to work only with the due material and perform only a 
predefined set of functions. The same database can store materials from several radio stations and all of 
them can share a certain part of the material. For example, quite often on the same premises main offices 
of several radio stations can be located that have different broadcast content but share the same 
commercial service. This makes it possible to centralize the commercial advertising preparation process 
and to avoid redundant production for each radio station. When several radio stations share the same 
database, user access rights to the own station's material and to the material belonging to other stations 
can be configured separately. The MDB functions are used by many DIGISPOT® II system modules to 
perform a wide range of tasks.  

MDB Module. This is the main tool for working with the media database. The module allows all 
MDB operations to be carried out. These are viewing, searching, sorting, filtering, adding, and deleting 
items and categories, and other operations. In addition, the module allows the administration functions to 
be carried out. These are configuring the MDB, adding and deleting radio stations, restoring mistakenly 
deleted items, and other specialized functions. The availability of functions can 
be curtailed through the system administration means of the DIGISPOT® II system.  

Automatic musical schedule generation and jingle rotation program DIGISPOT® II MAG. This 
is a full-fledged program for automatic generation of musical schedules using a set of templates and rules 
defined by the user. In addition, the program automatically embellishes the generated schedules with 
jingles, whose rotation rules are also defined by the user. The databases of music and jingles used in the 
rotations are stored in the MDB. 

DIGISPOT® II CD Grabber. This module is used to import information from audio CDs into files. 
During the copying process, the signal can be normalized, compression into MPEG performed, gaps at 
the beginning and the end of the track removed, etc. The application automatically accesses a CD 
database on the Internet and reads information about the track names, performers, and the like from 
there. The imported information can be automatically added to the specified MDB categories. 

DIGISPOT® II Logger. This module's function is to automatically record to the hard disk the signal 
from the workstation's external input. A typical application 
is around-the-clock high-compression recording of the broadcast material and its subsequent 31-day 
keeping for the content control purposes as required by the Legislation Regarding Mass Media. Another 
common application is high-quality recording of broadcast fragments for a subsequent playback or for 
using the recorded material to prepare one's own programs. 

2.3. DIGISPOT® II Software Structure 
The following is a list and short descriptions of the main components of the DIGISPOT® II software 
system. 

Names of the corresponding executable files are given in the parenthesis after the program names. 

2.3.1. The Basic Software 
DIGISPOT® II DJIN (DJin.exe) program is used for planning and preparing schedules, broadcasting, 
retransmission, backing up and uploading, broadcast log keeping, etc. The program has modular 
construction, which makes it possible to create various auxiliary workstations for working with schedules, 
as well as special-purpose workstations based on the corresponding modules. A detailed description of 
the program is given in Section 4 of this manual. 

BCS-Editor (BCS-editor.exe) is used to record, assemble, and edit audio and texts. It can also be 
employed to edit contents of the MDB and schedules, accessing these items via the standard modules. At 
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the same time, a simplified version of the program is used as a splice and schedule-item editor, which is 
called from DIGISPOT® II DJIN. The program is described in a separate document. 

DIGISPOT® II Logger (Logger.exe) program is a broadcast logging recorder. 
It records the audio signal (possibly, from multiple channels) for the accountability purposes (radio 
stations must keep a month's amount of on-air broadcasting records) or for reruns. The standard signal 
recording and log viewing modules are used. The program description is given in a separate manual. 

DIGISPOT® II MAG (Mag.exe) is a music rotator program. It performs music and jingle rotation. 
The program automatically creates musical schedules for specific dates using a set of templates and 
rules. It is based on the MDB. The program 
is described in a separate document. 

2.3.2. Utilities for Database Work 
The DB Import (DB_Import.exe) utility is used to import data from text files and the file system catalogs 
into the database. 

Schedule Agent (DB_Schedule.exe) is used for tasks related to storing schedules in the MDB. It 
synchronizes the schedules stored in the MDB with the schedules used by the DJIN program. The utility 
can pack schedules for transmission to a remote station. 

2.3.3. Data Manipulation Utilities 
DIGISPOT® II CD Grabber (CD_Grabber.exe) is a utility for transferring audio from CDs to hard disk 
using MPEG encoding. It can also be used to obtain CD information from the FreeDB Internet site. 

MWConvert.exe and AFConvert.exe are utilities for converting audio files. The following 
conversions can be performed: WAV-to-MP3 format change, PCM-to-MP2 or -MP3 recoding, sampling 
rate change, and normalization. 

Record (Rec.exe) is a utility for recording audio stream from an input of the audio card. It has level 
indicator, auto marking, and other relevant features. 

PIPrint.exe is a utility to print reports (using configurable templates) from data generated by the 
other programs (contents of schedules, categories, MDB, 
on-air broadcasting logs). 

2.3.4. Auxiliary Utilities 
Starter.exe is a utility to restart applications. 

Proc.exe is a sound processing utility using DirectX plug-ins.  It is called from the BCS Editor 
program. 

Set_lang.exe is a language selection utility. It performs the same functions as the Language tab in 
the DIGISPOT® II DJin properties (Section 4.12.1). 

AgentsLogView.exe is a utility to view agent logs. 
The DIGISPOT® II system is constantly developing, so the number of its components is increasing. 

2.4. System Requirements 
The DIGISPOT® II software operates under the Microsoft Windows XP operating system (file system 
NTFS) on Intel-compatible computers. The computer system performance requirements are following: 

• RAM: + 128 / 256 MB (depending on software configuration of DIGISPOT® II). 
• HDD: 50 Mb hard disk space are required for installation and start of work. Current requirement 

are put proceeding from a final software configuration 
of broadcasting automation DIGISPOT® II. 
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• Processor: they are different for different automation system components. Minimal requirements 
are the same as for the operating system. 
It is recommended to use higher figures for work of cueing stations and loggers.  

• LAN with 100 Mb/s capacity (in a case if more than one workstation are used). 
• USB-ports must be available. 
• Keyboard and mouse must be available. 
• DIGISPOT® II software interface is designed for the screen resolution beginning from 1024x768 

pixels. 
• Connection of remote control (for example, air console) needs an availability of LPT-port or a 

special USB device (for example TP-308). 
• If a media database is used, Microsoft SQL Server 2000 Standard Edition (or higher) must be 

installed on one of network’s computers. 
• The audio card type is determined depending on the task at hand (see Section 2.6). 

The reliability of the computer hardware components is much more important, as well as the proper 
configuration of its operating system. It is strongly recommended not to assemble the system on the-best-
of-the-cheap principle. Repairs or replacement of the broadcasting computer cause temporary disruptions 
in the radio station's operation, switching to the backup broadcasting equipment, and, most likely, a 
temporary drop in the broadcasting quality. The latter, in turn, will lead to users deserting the radio station 
and, in the end, to financial losses that can exceed the money saved on the equipment. 

2.5. Recommended Audio Cards 
Programs comprising the DIGISPOT® II system work with all audio cards supported by Microsoft 
Windows XP as an audio device and available to user applications. In other words, if after installing the 
audio card and its drivers, an available audio device corresponding to the installed audio card appears on 
the Audio tab of the Sounds and Audio Devices section in the Control Panel, the DIGISPOT® II 
programs will work with it more likely than not. Nevertheless, there are certain peculiarities in the way 
audio cards from different manufacturers work. Therefore, you should select audio cards for your radio 
station carefully.  

From their side, based on their accumulated experience, we can recommend you several audio 
cards that have proven to be reliable and of high quality. 

2.5.1. Antex Audio Cards 
Audio cards developed by Antex Electronics Corp. (USA) were considered to be very reliable and of high 
quality. Unfortunately they were taken out of production. Support of these cards is kept in DIGISPOT® II 
software, although they could not 
be delivered due to discontinuation of production.  

The Web page of the company devoted to professional broadcasting audio cards is located at the 
following site: 

http://www.antex.com/products/prof_audio_broadcast.html. 

Advantages 
• High reliability. 
• High audio quality. 
• A very good, handy, built-in mixer. 
• Have hardware signal transit with a level-adjustment capability. This allows Antex cards to be 

used in the DIGISPOT® II DJIN 777 configuration. 
• Balanced inputs and outputs. 
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• Cards with two stereo inputs and two stereo outputs are available (LX44 and LX24 respectively). 

Peculiarities 
• Two versions of the drivers are available. One, older but also more refined, version is without 

Plug & Play support. The other is a WDM Plug & Play version and has some advantages, but at 
the moment this manual was being written it was somewhat raw.  

• Cases of hardware conflicts with integrated audio cards and Creative Labs audio cards have 
been noticed. 

The main card for the broadcast station is Antex LX44; Antex LX24 and Antex SC22 are suitable for 
the scheduling and edit stations. 

2.5.2. Digigram Audio Cards 
Digigram is a French company that develops and manufactures specialized professional audio cards for 
broadcasting and radio manufacturing industry. The Europe radio industry uses mainly this company's 
cards. The company develops its own API, which allows third-party developers to actively use the internal 
capabilities of Digigram cards. 

The company's Web site is http://www.digigram.com. 

Advantages 
• Very well implemented dynamic level adjustment. 
• High reliability. 
• Balanced inputs and outputs. 
• Some cards models have digital inputs and outputs. 
• There are card versions with several stereo outputs. 
• Hardware signal transit with a level-adjustment capability. This allows Digigram cards to be used 

in the DIGISPOT® II DJIN 777 configuration. 

Peculiarities 
• Some functions can be accessed using only a specialized non-standard driver (NP driver). The 

DIGISPOT® II system supports this driver. 
• No capability of several applications using one card concurrently. 

There is an extensive assortment of Digigram cards. They can be used for any workstation. The 
best choice for a retransmission station is VX 222 (because of its high-quality mixer). 

2.5.3. RME Audio Cards 
Founded in 1996, German RME has already occupied a strong position in the multichannel audio cards 
market. The main advantages of the RME cards are their high reliability and low price. Most cards 
produced by RME are intended for multichannel (more than eight channels) recording and playback. At 
the same time, the RME product line has the Digi96 series that is quite suitable for broadcasting. 

The company's Web site is http://www.rme-audio.com. 

Advantages 
• A large number of outputs. 
• Balanced inputs and outputs. 
• Both cards with digital and analog inputs and outputs are available. 
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Peculiarities 
• No hardware signal transit, which makes cards unsuitable for retransmission. 

2.5.4. Audio Cards from Echo Audio 
The USA Echo Digital Audio Corporation has been in business of producing professional audio cards for 
studio work for over 20 years.  

The company's Web site is http://www.echoaudio.com. 
Currently, the following three cards from Echo Digital Audio can be used for broadcasting: Layla24, 

Gina24 and Mia. 
Layla and Gina are multichannel studio cards (8/8, 2/8); Mia is a two-channel card with the support 

of the virtual player technology. 

Advantages 
• Balanced inputs and outputs. 
• Layla and Gina cards have stereo outputs. 
• Digital inputs and outputs (SPDIF: optical and coaxial, ADAT: optical). 
• A very good value for the dollar ratio. 

Peculiarities 
• Overloading the bus deprives cards of the next portion of data and may cause the playback to 

stop. Perhaps this shortcoming has been already corrected. 
• No hardware signal transit, which makes the cards unsuitable for retransmission. 

We position these cards below Antes and Digigram cards. At the same time, owing to a quite large 
number of inputs and outputs, they can be used both for broadcasting and for production. Layla and Gina 
cards can be recommended for hardware voice studios (due to the extensive interface); Mia can be used 
as general-purpose cards in the entry-level systems. They can also be used with the scheduling and 
music editor workstations. Some internal construction singularities make these cards unsuitable for 
retransmission. 

2.5.5. Creative Labs Audio Cards 
Products of Creative Labs are well known; its inexpensive and simple audio cards are sold virtually in all 
computer stores.  

The company's Web site http://www.creative.com. 

Advantages 
• Low price. 
• Ease of installation. 
• Availability. 
• Hardware signal transit with a level adjustment capability, suitable for retransmission. 

Peculiarities 
• Relatively low audio signal quality; extraneous noise on the output. 
• Unbalanced outputs. 
• Potential problems could be encountered when trying to install more than one card. 
• Low-quality signal adjustment by the hardware mixer. 
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As a rule, the more expensive the cards, the better their characteristics. These cards are 
recommended for prefade-listen use in control and schedule-preparation workstations. They can also be 
used for on-the-air control log recording together with DIGISPOT® II Logger. It is not recommended to 
use Creative Labs cards as the main card of the broadcasting computer. The tests conducted have 
shown that Audigy2 ZS Pro cards can be used for retransmission with DIGISPOT® II DJIN 777.  

2.5.6. Audio cards Marian 
Marian is German firm engaged in development and manufacture of specialized professional audio cards 
for a sound recording, mastering, broadcasting and radio industry. Products of firm are inexpensive, 
qualitative and reliable. At the present they are optimal for the implementation of many tasks from the 
standpoint of a ratio price / quality. Development of own API is conducted, that allows foreign developers 
to use internal capabilities of these cards actively. Audio cards of greatest interest are: MarcX, MarcA, 
Trace PRO, Marc 2 PRO. Marian engineering team is very responsive to our technical requests and 
suggestions, it reacts very fast to noticed issues, so at the time being we are mostly using MarcX and 
Trace PRO cards in our installations. 

Company’s Web site in Internet is http://www.marian.de. 
 
 

Advantages 
• High reliability. 
• Some cards have digital inputs / outputs. 
• There are cards – add-ins with several additional analog or digital stereo inputs / outputs. 
• Very good, multifunctional and flexibly adjusted mixer. 
• Hardware transit of a signal with a possibility of level adjustment in MarcX card. It allows using 

Marian MarcX cards in DIGISPOT® II DJIN 777 configuration. 

Peculiarities 
• Some cards have no balanced analog inputs / outputs. 

2.5.7. Audio cards Lynx 
Lynx is American firm engaged in development and manufacture of specialized professional audio cards 
for sound recording, broadcasting and radio industry. Products of this firm are inexpensive, qualitative 
and reliable. At present they are optimum for the decision of tasks of own broadcasting with use of digital 
channels from the standpoint of a ratio price / quality. Cards of greatest interest are: Lynx TWO, Lynx 
AES16. 

Company’s Web site in Internet is http://www.lynxstudio.com/. 

Advantages 
• High reliability. 
• High quality of broadcasting. 
• There are multichannel cards. 
• Good internal mixer. 

Peculiarities 
• Only balanced inputs / outputs 

http://www.marian.de/
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2.5.8. Axia IP Audio Driver 
US company Axia is a manufacturer of IP-Audio mixing consoles and other equipment based on Livewire 
Audio network. They have developed IP-Audio driver that connects PC audio directly to the network via 
Ethernet and without sound cards. This software works with DIGISPOT® II system. Provides one stereo 
input and one stereo output via the Livewire network.  

A multi-channel version of the IP-Audio Driver supports 16 stereo inputs and 16 stereo outputs via 
the Livewire network, connecting PC audio directly to the network via Ethernet and without sound cards. 

Company’s Web site in Internet is http://www.axiaaudio.com/. 
Axia IP audio driver is to be used in the radio stations equipped with Axia Element or SmartSur-face 

mixing consoles and with Axia Livewire audio interfaces, or nodes as they call them. This is clear, that in 
Axia environment there is no sense in using audio cards at all; IP-Audio driver, installed on a PC, is 
treated as a stereo in/stereo out or 16 stereo in/16 stereo out audio card for DIGISPOT® II application. 
DIGISPOT® II system has special means to configure playback and recording of audio to and from 
Livewire channels. Besides, the virtual GPIO control is supported over the Livewire network which allows, 
for example, to start playback opening a fader 
on Axia mixer channel, or to start PFL using the preview button on Axia mixer surface. IP-Audio is the 
most modern technology in radio broadcast industry; more and more audio equipment is appearing with 
Livewire interface allowing easy integration in Axia environment (most modern digital telephone hybrids 
from Telos, FM processors from Omnia etc). 

2.6. Remote Control 
Remote control as applied to the DIGISPOT® II system means both a capability to control a broadcast 
program by various external devices and a capability to control external devices by the program. The 
tasks that can be handled by the remote control system can be conditionally divided into the following 
categories: 

• Controlling the program from the broadcasting console using Fader Start and PFL signals, as 
well as other simple external events. 

• Controlling the program from an external button field. 
• Controlling the signal level adjustment from external fader-movement sensors, that is, from a 

virtual mixer. 
• Issuing by the program certain controlling signals when playing back a block, or schedule item, 

or jingle. 

Let's consider these tasks in more detail, referencing the descriptions of various modules and 
windows of the system, in one or another way connected  

 
to the tasks being described. 

The first, and the most frequently used, control method appeared in radio broadcasting long before 
automation programs. Virtually all broadcasting consoles outputs an external control signal indicating that 
a certain fader has got out of the zone of the complete signal suppression (i.e., is open) or, on the 
contrary, has entered this zone (i.e., is closed) so that the audio signal from this fader does not reach the 
console output. The control signal is used to launch the device connected to the given channel, for 
example, a tape player, a CD player, etc. 

Some consoles can indicate that the Cue/PFL button is pressed on some channel. This means that 
this channel's incoming audio signal is not reaching the console output but has been switched to the 
internal prefade-listen bus and is being played back on the control monitors. 

Most often, the information of these events is issued via the General Purpose Interface (GPI). The 
GPI is the simplest way to exchange information, which transmits data about events by closing and 
opening a pair of contacts. In some cases, the signal is issued not by closing or opening the contacts, but 
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by generating a voltage drop, for example +5 V, on the contacts of the given pair. In this case, the task is 
easy to reduce to the previous case by using optoelectronic decoupling. 

There are two ways of controlling these signals. One is to use only one pair of contacts, whose 
state reflects the state of the signal all the time, for example, the pair is closed all the time the fader is 
open. The other method uses two contact pairs for one event. A brief closing of one contact pair (about 
0.1 – 0.5 sec) signals the beginning of the event; a closing of the other contact pair indicates the event's 
end. The latter method is called pulse signaling. The DIGISPOT® II system is not designed to work with 
the pulse signals. All broadcasting consoles using GPI have the option of selecting either the continuous 
or pulse type of the signaling. 

How does the signal enter the program? If there are no more than four signals being used (four 
fader-start signals, or two pairs of fader-start/Cue signals), the task is solved without using additional 
equipment, simply by using the built-in printer (LPT) port.  Some contacts of this port serve to send the 
printer status information to the computer, for example "Out of paper," "Ready," "Error," etc. These 
contacts can be used to send information to the program. The way the LPT port is constructed allows 
these contacts to be shorted to the ground, which changes the port status information. A special driver 
GPI_DRV, which must be installed separately, reads out this information for the program. 

If there are more than four signals, for example four fader-start/cue pairs, or the computer is not 
equipped with the LPT port (as is often the case with new computers, which use the USB instead), 
additional equipment will have to be used. We have developed two blocks (TP-216 and TP-308) that 
receive and output GPI signals on one side and have the RS232 or USB interface on the other. In order 
to connect these signal adapters, special CDU configuration files need 
to be installed. These files are included into the installation package for the systems with the signal 
adapter option ordered. 

These adapters convert GPI signals into control commands, which are sent to the program over 
serial interface. 

One adapter can handle eight GPI signals. Several adapters can be connected to the system at 
once. The program sees an adapter/GPI source as a set of 32 bits, each of which is associated with one 
GPI signal and can assume values 0 or 1. 

The number of available GPI sources and their names depend on the specific workstation 
configuration. There is always a GPI LPT+ device active in the program and connected to the LPT port. 
How are GPI signals assigned to their corresponding actions? For player modules, there is a standard for 
all players dialog window, which can be opened by the Remote control setup command in the player-
configuration context menu. This window is used to assign actions available to control GPI signals with 
the specific bits of the specific GPI source devices. In addition to players, the broadcasting control log-
recording module uses this window. 

There are certain cases when the control logic is more complex than simple launching and stopping 
a process, for example, an acknowledgement can be needed. It is also possible for an event signal to 
arrive not through the GPI, but to be issued by the console via the RS232 or USB interface. For such 
cases, the exchange protocol and the algorithm to react to the external signals are described in the 
configuration files (VID, CDU, and RMT).  
We can handle this task. The specific configuration files are included in the distribution kit. The 
configuration window is not used in this case. The advanced language used to describe the exchange 
process with external RS232 or USB devices makes it possible to configure the program to work 
practically with any device.  

Another control task is to perform certain actions when buttons are pressed on an external (i.e., 
connected via RS232 or USB) button field. Using an external button field makes it possible to 
ergonomically organize the workstation. For example, a button field can be built into the broadcasting 
console, which allows the operator's attention to stay undivided when working concurrently with the 
console and the computer keyboard. Button field buttons are usually sufficiently large and their placement 
configuration is convenient for the operator to work with, which also facilitates broadcasting work. Usually, 
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the following most frequent operations are placed on a button field: the playback start, playback stop, and 
loading an item into a player. The navigation buttons and the jingle-machine or fast jingle player buttons 
are also located there. 

Button field devices from third-party companies can be used. Dedicated remote controllers can be 
incorporated into the broadcasting console. In either case, it is connected using the configuration files 
(CDU) and a bidirectional exchange can be organized. For example, if a button has a backlight, the 
program can turn it on when indicating, for example, a certain mode state. 

How are the buttons assigned to their corresponding actions? This is done 
in the dialog windows that can be accessed by executing the Service > Customize Keyboard. 

The Customize keyboard and remote keypads dialog window (see Fig. 4.145) has a list of 
actions that can be executed for various objects by clicking a button. The result of such clicking depends 
on current active window (current focus). 

The processing performance of modern computers and the capabilities of audio cards make it 
possible to work with a virtual mixer, or a virtual console.  Here, the operator works with a control console 
that looks practically the same as a regular console, but in fact this console is just a sensor of fader 
movements and button states. Sound is played back and processed by the computer according to the 
commands received from the console. This approach to organizing broadcasting makes it possible to 
save money, because the price of a virtual console is much lower than the price of a hardware console. 
Either the entire console can be virtual, or just a part of it, specifically intended to be used by software for 
its purposes not necessarily having anything to do directly with the broadcasting. 

In particular, virtual faders make it possible to implement the voice track recording in a convenient 
and ergonomic way. Working with a small virtual console transmitting information about fader 
movements, the operator records tracks as if he were working on the air. The program remembers the 
fader movements that the operator made performing the transition from one track to another. When the 
tracks are played back on-air, the program repeats those movements, changing the level of the tracks 
accordingly. Listeners get an impression of a live operator, despite the fact that the broadcasting is 
carried out completely automatically.  

To communicate with a virtual console, a special object is created in the DIGISPOT® II system. It is 
called a mixer. It is configured using special configuration files (CDU). When configuring a module to work 
with a virtual mixer, you need to specify the mixer to use (there can be more than one mixer in the system 
at once) and the mixer's faders that regulate the signal in a module. All main player modules of the 
DIGISPOT® II system — Block and X-Player — support virtual console operations. 
In addition, the Voice-track recording module also supports the virtual console.  

The last task handled by the remote control system is to generate control signals when reproducing 
a schedule. When working with a schedule, a set of control commands can be created by specifying the 
contents of a command (a sequence of bytes) and its name. Afterwards, any command can be assigned 
to a schedule item, a skeleton item, a block, a jingle-machine item, or the MBD. The issuance of the 
command can be tied both to the start of the item's playback and to its end. Commands are assigned in 
the standard Properties window of the track on the Remote control tab; commands for blocks are 
assigned in the Block Properties window. The assigned command will be issued via the control device 
that is defined in the workstation configuration and linked with a RS-232 or USB port. A command 
assigned to a track will be issued when the track is played back 
in any player. Commands assigned to blocks are issued when the playback of the first track starts and the 
playback of the last track in the block ends. Commands controlling the Insert player can serve as an 
example of command use. In the main station schedule, all commercial blocks have commands 
specifying their beginning and end that are issued, for example, via RS232 to the Insert player, launching 
playback of the regional commercial blocks.  

Being able to assign commands to schedule items makes it possible to control virtually any external 
device. Connecting a GPI signal conversion unit to the output of the RS232 or USB port, through which 
commands are issued, makes it possible to control external devices that support the GPI protocol. 
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In addition to the described capabilities, the DIGISPOT® II system has a capability to control the 
4×1 TP-102 audio signal switch either locally or remotely (via TCP/IP). For this, a special switch control 
module is used. 
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3 
DIGISPOT® II OPERATION AND TECHNIQUES 
 

3.1. Data Types 
The DIGISPOT® II system efficiently works with all types of data necessary to create 
a schedule and put it on the air. 

These include the data that are standard for the most diverse applications (e.g., digitized audio and 
text) and the particular types of data that are specific 
to the DIGISPOT® II system (e.g., a project, a schedule, a subject, and a block). In order to operate the 
system efficiently, you need to understand the essence of the various ways and forms, in which digital 
and textual information can 
be represented. The necessary information for this is given in this section. 

3.2. Digitized Sound 
The main type of data that any automated broadcasting system works with 
is digitized sound. Having undergone the analog-digital conversion, sound is stored as files. To reduce 
the amount of the disk space taken up by a file, the sound signal is compressed using various algorithms 
(in most cases, the compression causes losing some sound quality in the process). Currently, the most 
common of such algorithms is MPEG. 

3.3. Metadata 
To work with files, the operator needs to have additional information describing each specific file. The 
aggregate of all descriptive information is called metadata. This information is necessary to identify or find 
a track. At first glance, the most logical place to store metadata would seem to be the sound file it 
describes, 
as in this case the metadata will never get lost when copying or moving the file. But for a large number of 
files, the operation to read the metadata from all the files will take lots of time; also, when a file is missing, 
working with the metadata will 
be impossible. Therefore, the task of storing metadata separately from audio files arises. Metadata are 
often stored in a database (DB). 

The database management system provides capabilities for a rapid track search by a certain criteria 
and for grouping tracks by certain characteristics. But this approach requires that special software be 
installed on the computer to work with the database, which raises the cost and complexity of the entire 
system. 

The DIGISPOT® II system uses a complex approach to storing metadata: they can 
be stored both in audio files and in a specialized media database (MDB). Using 
a database is not mandatory, which in simple cases allows the cost of the complex to be lowered (no 
need to purchase the database). Moreover, metadata are stored in the special data structures, such as 
Schedule and F-Categories. 

When a file is initially added to a Schedule, F-Categories, or MDB, the metadata are read from the 
audio file and stored in the corresponding structure. Subsequent editing item's properties changes 
metadata that are stored separately from the file. This editing does not change the information stored in 
the file. Metadata stored directly in a file can be modified only from the track properties window of the 
Files module. 
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3.4. Audio Files Supported by the DIGISPOT® II System 
The DIGISPOT® II system supports the following three types of files: 

• WAV files 
• Files containing pure MPEG stream (MP3, MP2, S44, etc.) 
• Project files DIGISPOT® II BCS-EDITOR 

NOTE 
Do not confuse a file format with an audio signal compression format. Here it is a file format that is meant, that is, its internal 
organization. 

WAV files allow sound to be stored in both uncompressed Pulse Code Modulation (PCM) format 
and compressed using various compression methods, with the information about the compression type 
stored within the file. Moreover, in addition to the audio, the WAV structure allows any amount of 
descriptive information (metadata) to be stored in it. This can be both standard information (e.g., the 
author and composition names) and specific for a particular application (e.g., the Start and Stop marks). 

Files that store pure MPEG stream, the most common of which are MP3 files, contain sound 
compressed in the MPEG format. No standard method of storing metadata is provided for this type of 
files. These files do not even store an explicit description of the signal compression format and it has to 
be determined by analyzing the MPEG stream. The need for storing metadata and the lack of a standard 
method to do this led to the development of several methods for storing metadata in files of this type, the 
most common of which is the ID3 format. The earlier versions of this format allowed only a very limited 
amount of information to be stored in a file. The currently used newer ID3 format v2.3 allows any amount 
of information to be stored in a file.   

Project files are files with the TPR extension created by the edit station DIGISPOT® II BCS Editor. 
A project file contains a multitrack edit list, as well as all audio material included in the project. This 
means that project files are self-sufficient and can be freely copied and moved without losing information. 
(In the earlier versions of the DIGISPOT® II system, project files stored only the edit list, while the audio 
was stored separately, which often caused problems when copying files.) The audio format of project files 
is always defined as PCM, regardless of what audio format the files included into the project at its 
creation had. 

The DIGISPOT® II System supports the following audio formats: 
• PCM: without compression, stored in the WAV format files. 
• MPEG 1 Layer 1, 2, and 3: stored in WAV, MP3, MP2, AU and some other file formats.  

There are certain limitations on the use of the MPEG 1 Layer 3 format audio: the system does not 
support operations with variable bit rate (VBR) files. These files are reproduced without problems, but the 
system determines their length incorrectly. Therefore, it is recommended not to use the VBR MPEG 
compression. 

MPEG decoding is done by the built-in system modules and does not require installation of 
additional software decoders. 

3.5. Text Files, Projects, and Subjects 
In addition to audio files, the DIGISPOT® II system supports operations with text files. The contents of a 
text file can be displayed in the special text-viewing window, which opens for text items in the same way 
as the prelisten window, usually by pressing the space bar. Text items included into a schedule can be 
displayed in the announcer window module and added to the subject contents. The DIGISPOT® II system 
supports the TXT and RTF format text files and the SBJ subject files. 

So, a project is an aggregate of audio material (all included in the project audio files) and an edit 
list, which specifies the files to be played, their starting positions, the sequence, and the levels. A project 



Cooperation for Development of Hard-and Software 
for Audio and Video Broadcast Studios in East and 
West Europe. Design and Manufacturing of Studio 
Equipment  for the Audio recording Industry and the 

 

 
e.mail: info@tract.ru   e.mail : infor@barthkg.com  
 web :http//www.tract.ru   web : http://www.barthkg.com 
 

    

 

copyright: RBKG&TRC  Page 29 of 219 

in field of Video Postproduction. 

can have many audio channel tracks. A project can simultaneously contain different-format audio files 
(WAV, MP3), which in turn can contain different format audio (PCM and MPEG). The automatic sampling-
rate change function is provided when adding a file. Moreover, a project can have the text part that can 
be accessed only from the BCS Editor program. 

The broadcasting station perceives projects as joined audio files and for working with them, 
provides the user with functions analogous to the functions for working with regular audio files. 

A project can be created and modified by the BCS Editor program (which can be called directly from 
a schedule to edit any audio item). It is saved in a project file, which can be edited in the future. This 
takes place automatically when editing schedule item. Moreover, a project can be reduced and the result 
saved in a regular audio file, for example, WAV. In this case, the auxiliary information used during the 
editing (channel tracks, segments, the "rubber line," etc.), as well as the associated with the project text, 
is not saved to the file and will be lost after the editor program is closed. 

A subject is a sequence of text and audio material (audio files or projects). A broadcasting station 
perceives a subject as a textual sequence with audio tracks included in it. 

The subject information is stored in files with the SBJ extension. 
From the viewpoint of the DIGISPOT® II BCS Editor program operation, a project and a subject 

have the same environment for recording and editing audio and editing text. The principal difference 
between the two is that the DIGISPOT® II DJIN broadcasting station perceives and displays a project on 
its screen as a purely audio item, while a subject is perceived and displayed as a text-audio sequence. An 
expanded subject is displayed in a special window of the broadcasting station. Moreover, you can convert 
a project into a subject and vice versa when saving your work.  

It must be mentioned, that in development of DIGISPOT® II system the format of projects and 
subjects storage have been changed (with all this going on the expansion of files remained constant). For 
preservation of all new files new formats are used only; at the first opening of new version of the file 
program which has stayed from the old version, it converted automatically in a new format. The old 
version of the program does not open files of a new format. 

NOTE 
If there are stations supporting old file versions in your complex, after viewing with the help of new versions of the 
software, projects become inaccessible on "old" stations. Thus, modernization of complexes is recommended so 
new software versions are installed on all workstations simultaneously. 

3.6. Schedules and Skeletons 
A schedule is a defined, scheduled, and generated sequence of broadcast material. A schedule consists 
of multiple blocks ordered by broadcasting time. A block is a container that can have a time reference and 
a planned duration, as well as some properties that define the conditions upon which the block items are 
put on the air.  Blocks consist of items: audio items, subjects, and control and information items. An item 
is added to a schedule by adding it to one of the schedule's blocks. An item cannot be added to a 
schedule without adding it to a block. 

A schedule is a source of information and control commands for the players that put the material on 
the air. A DIGISPOT® II broadcasting schedule is a conglomeration of many daily schedules. Schedules 
are edited in the special Schedule module. Only a one-day schedule can be edited by this module at a 
time. A schedule for more than one day cannot be edited. Schedules can be edited in advance, for 
example, for the next day. They can also be edited in the real-time mode, directly during the schedule's 
being broadcast. For example, the contents of a news block can be changed immediately before it is 
aired. A one-day schedule can be viewed and edited from any number of the system workstations. 
Changes made by one workstation are automatically reflected on the rest of the workstations. The 
DIGISPOT® II system can import schedules for a specific date from a text file created by an external 
schedule-preparation system and containing a complete or partial (e.g., musical or commercial) schedule 
for the corresponding date. For example, a musical schedule created by the Power Gold music rotation 
system can be imported. 
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In the DIGISPOT® II system, several independent schedules can exist simultaneously. Here, a 
general schedule is meant (not a daily schedule): for example, the main schedule and schedules for the 
regional stations, or schedules for different broadcasting frequencies. Each schedule has a name and is 
stored on the disk independently of the other schedules. The system has one default schedule: the main 
schedule, which is accordingly called MAIN. 

A schedule is saved as a group of BLK files, with one file for each schedule block. Schedule blocks 
for a specific broadcast date are stored on disk in one folder named by the corresponding broadcasting 
date in the YYYY-DD-MM format. The block files internal format is binary and their names or contents 
cannot be changed by the user or other programs. In addition to files, a schedule can be saved in an 
MDB as items of a certain set of database tables. In this case, a schedule can be edited by outside 
programs connected to the MDB via the ODBC interface.  

To facilitate the schedule preparation process, DIGISPOT® II employs a skeleton system that 
allows blanks of typical schedules to be designed.  

A skeleton is a schedule blank not bound to a specific date but with a defined temporal scope, for 
example, a skeleton for Mondays from June 1 until September 1. A skeleton is those common and 
repeated with a certain periodicity blocks and items that are present in all schedules for the specified 
temporal scope. A skeleton is organized identically to a schedule, with the only difference of its not being 
bound to a specific date. When a new schedule is created, a search for a skeleton is conducted among 
the collection of the skeletons effective for the date, for which the schedule is being created. If such 
skeleton is found, its contents are copied into the new schedule. Consequently, the new schedule is 
created based on a skeleton. Note that the new schedule will be created based on a certain skeleton 
regardless of on which of the system's workstations it is created. A skeleton is saved to the disk in the 
same way as a schedule is. 

In the DIGISPOT® II system skeletons can be accessed for viewing or editing via the Skeleton 
Wizard; schedules are accessed via the Schedule module. These two modules look very much alike and 
use a unified system to display schedules and skeletons. Both modules use the same window to display 
schedules and skeletons. This is the schedule window that displays blocks and items included in the 
schedule. Main editing operations using context menus, hotkeys, and drag-and-drop operations can also 
be performed in this window. The same window allows auxiliary windows to be opened to view and edit, 
for example, properties of a block or a block item. Most functions of these modules coincide; however, 
specific functions exist that are available only in one of the modules. 

Despite their similar appearances, the functions of schedules and skeletons are very different. The 
main function of the Skeleton Wizard is generating a broadcast grid. A broadcast grid is a long-term plan 
defining the subject content for each broadcasting day for the duration of the plan's temporal scope. 
Using the DIGISPOT® II DJIN schedule terminology, a grid is collection of skeletons, each of which has a 
set of blocks of a certain type, duration, and the airing time. Moreover, the Skeleton Wizard allows all 
permanent broadcast and informational items 
to be added to a skeleton. Consequently, the Skeleton Wizard takes care of the long-term planning and 
the beforehand schedule preparation tasks. 

The function of the Schedule module is to fill the broadcast schedule for a specific date with 
broadcast material, edit it in the real-time mode during broadcasting, and to provide information about the 
progress of the schedule playback in the player. In addition, a schedule serves as an information source 
(of data and control commands) for the players. In other words, the Schedule module takes care of the 
short-term scheduling (within 24 hour limits) and of the real-time support of the manual and automatic 
broadcasting tasks. 

3.7. Schedule-Creation Methods 
How is a schedule for a specific date created?

There are several ways of creating a schedule in the DIGISPOT® II system. These are the 
following: 
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• A fully manual schedule generation. Creating the set of blocks, setting block properties, and 
filling the blocks with specific content is carried out manually for each day. This method is 
practical only for small retransmission stations, which use it to create schedules of 5 to 10 
commercial blocks inserted into the program being rebroadcast. Its labor intensiveness and the 
large number of monotonous operations increase the chance of making a mistake. 

• A skeleton-based schedule generation. This method requires 
an existing broadcast pattern in form of a collection of skeletons. When creating a schedule for a 
specific date, the user obtains a schedule blank from a skeleton. All blocks of this blank have its 
properties set and, perhaps, all the repeating items (i.e., jingles, background sounds, etc.) 
installed. The content of the block is filled manually. This is a more convenient method than the 
first one, but it still has the manual schedule content-filling stage. It is often used by the 
government regional stations with relatively low volume of their own, usually informational, 
broadcasting. 

• A skeleton-based and content importing schedule generation. This method also requires an 
existing broadcast pattern. In addition, the system needs to have a system or several external 
systems that generate schedules for specific dates (for example, the Power Gold music rotation 
system and a commercial schedule generation system). A schedule 
is created in the following way. First, schedules in the music rotator and in the commercial 
manager program are created, which are saved as text files. Then a new skeleton-based 
schedule is created in the DIGISPOT® II system. Next, the schedule is imported from the 
earlier-saved text files into the existing block grid. The DJin program, using the information 
specified in the import format and stored in the imported file, distributes the schedule items 
among the blocks. The import operation needs to be carried out for each of the text files; the 
blocks of different types are filled: musical, commercial, etc. The import can be carried out from 
different workstations. Music is imported in the music format, while commercial ads are imported 
in the commercial format. The final product is a practically complete schedule, divided into 
blocks with their attributes set and filled with specific content. Note that the existing broadcast 
pattern must coincide with the pattern used by the external schedule-generating programs. This 
is the most common method of creating schedules, which is used by most music FM radio 
stations. 

• An import-only based schedule generation. This method differs from the previous one only in 
that it is not necessary to have an existing grid of skeletons. In this case, the information about 
the blocks and their parameters (i.e., the airing time, duration, etc.) is contained in the imported 
file. This is the simplest method, but it requires external schedule-generating systems generating 
a complete schedule and providing the information about how to divide the schedule items into 
blocks. (Consequently, the stage of forming the broadcast pattern is carried out when 
configuring these systems, externally to the DIGISPOT® II system.) As a particular case, a 
schedule can be imported from a file that has no information about the division into blocks. In 
this case, DJin will break the schedule into hour-long blocks. Another method presupposes 
using a preprocessor program at the import stage. Such a program can be written for the 
customer by the developers, or the customer can create it on his own. It performs additional 
processing of the schedule files created by the external systems; for example, it combines the 
commercial and the musical schedules, places jingles, and adds specific material to the 
schedule (e.g., material for playing games with the listeners' participation and the like). The 
results of this program's work are imported by the DJin program. This method makes it possible 
to accommodate the specificity of creating schedules at a particular radio station to the greatest 
extent, but requires the use of special programs. 

In practice, different methods can be combined, for example, the music part of the schedule 
imported and the commercial or news part created manually, and the like. 

In the general case, the schedule creating process has four stages: a preliminary stage of the 
skeleton creating (generating the broadcast pattern), importing the schedule content from a text file, and 
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editing and arranging the schedule manually. The last stage means performing such operations as 
splicing, recording voice tracks, and the like. 

3.8. Blocks 
The building unit for schedules and skeletons is a block. A block is a container that has a certain set of 
properties (parameters) and contains a group of items connected logically or by the subject, for example, 
a commercial block or a news block. Blocks structure a schedule, breaking it into parts. Blocks are used 
in skeletons, most of all for breaking a 24-hour interval into time slots. In a prepared schedule, blocks 
contain sequences of audio items and information items; they also define the rules, by which the players 
will play back the contents of the blocks.  

A block can be of one of the following four types: commercial (C), news (N), music (M), or program 
(P). It may also have no type (B). 

 
 

3.9. Block Creation Methods 
The essence of the block-creating process is breaking a 24-hour broadcast interval into subject slots; 
another part is placing the time check points that the program will follow during broadcasting in the 
automatic mode and that must be followed by the operator when broadcasting in the semi-automatic or 
manual mode. 

A schedule usually has a repeating hour structure, or several intervals within 24-hours that have the 
same hour structure. Therefore, the order of creating blocks is creating all different one-hour blocks and 
subsequently multiplying each obtained block over those corresponding time slots that have the same 
hour structure. Special time slots, for example, the hours during which a morning talk show 
is conducted or some other specific broadcasting hours, are filled with blocks explicitly, without copying, 
or by modifying the previously-copied hourly structure. 

In addition to the hourly structure, we will need some questions answered. For example, how the 
schedule is to be aired, to what extent the time referencing of news and commercials must be observed? 
Who will be responsible for following the time referencing, the operator of the program? What player is to 
be used for playing back the schedule? This information is necessary to set the properties of the blocks 
responsible for the time referencing.  

If the broadcasting is carried out mostly in the manual mode, the task of following the time 
referencing is entirely the broadcasting operator's responsibility. The most often used configuration for 
this purpose is the DIGISPOT® II DJIN Europe+ configuration, which is based on using several block 
players that do not provide a detailed following of the schedule. The program in this case only provides 
the operator with the information about the desired airing time of one or another block and evaluates to 
what extent the schedule timing is being followed. In this case, there is no need for the blocks to contain 
any time-referencing parameters. The main time parameter of a block in this case is the airing time itself. 
If all or part of a schedule is planned to be carried out in the automatic mode, attention must be given to 
the time-referencing flags. 

3.10. Block Items 
What items can a block contain? 

There are several types of items that a block can have. Each block type has special symbols shown 
in the schedule that allow the item type to be visually identified. Each item has a particular collection of 
properties, which depends on the type of the item. 

A block can contain audio items, pauses, stop points, and information items. 
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Audio items have a set of marks that define the playback part of the file, the playback starting point, 
and the starting point of the next schedule item. Audio items can have their playback level changed. 

Kinds of marks established on audio items are shown on fig. 3.1. 
Audio items can be overlapped by each other. The interval of simultaneous sounding of audio items 

is called crossfade. 
In addition, a schedule can include text items containing information to be read on the air by the 

announcer. 
 

Entire audio file duration

Mark Stop 
Mark Start 

Mark Start Next

R untime

Duration

Mark Start Point 

Playback Start point

If Start Point is 
missing

 missing, then duration is counted from mark Start.  

Fig. 3.1. Kinds of marks established on audio items. 

Audio items and pauses can contain auxiliary control commands affecting the schedule playback by 
the players. 

A command can be assigned to a schedule item that is issued to a serial port when the item is 
aired. 

3.11. Time-Referencing and Conflict-Resolving Methods 
As said previously, in the DIGISPOT® II schedules, only blocks can be time-referenced, thereby defining 
the starting time of the first item of a block. The rest of the block items are played back continuously one 
after another. (The case of using playback stop points in a schedule is not considered, as here the 
announcer is responsible for controlling the timing.) Consequently, the time referencing of the first item 
unambiguously determines the airing time of the rest of the block items. When describing time referencing 
of schedule items, we will do so for the automatic broadcast schedule with the program observing the 
time check points. The following two players can do this type of broadcasting: the multichannel X Player 
and the Rebroadcast Player 777 in the local broadcasting mode. A detailed description of the X Player is 
given in Section 4.7.3. 

A block has the following five flags that affect its time reference: 
• Fixed time 
• No sooner 
• No later 
• Cut off blocks 
• Cut off items 

A player takes into account the information about the block's airing time only if at least one of the 
No sooner and No later flags is set. Setting any of these flags causes the Fixed time flag to be set. 
When at least one of the flags 
No sooner or No Later is set, the player will attempt to observe the time specified in the block. No set 
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flags or only the Fixed time flag being set tells the player not to undertake any actions as to observing 
the airing time specified in the blocks. 
In this case, the airing time specified in the block affects only the calculation of the planned airing time for 
the block items, determines the block's position in the schedule, and is used by the operator to manually 
keep the timing. (When block players with automatic loading are used, this time also determines the 
moment a block is to be loaded into a player.) 

Flags that cause a player to interfere into the broadcasting process can be divided into two pairs. 
The first pair — No sooner and No later — determines the way a block can be offset relative to the 
specified time. The other pair — Cut off blocks and Cut off items — determines the actions a player 
can perform in order to air the material included into the block without violating the rules specified by the 
first pair. In other words, the second pair of flags is intended only for automatic resolution of conflict 
situations. Setting either the Cut off blocks or Cut off items flag causes automatic setting of the No 
later flag, because otherwise there is no need to cut anything, as the block has the right to come out later 
than the specified time, after all the preceding schedule items conclude. 

Time referencing a block (and, subsequently, its items) is needed in order for its items to go on the 
air on time. For example, the first item in an hour, which plays time signals, must come out exactly at the 
start of an hour, otherwise there is no sense having it. The same holds for jingles, in which the time is 
mentioned. The airing time of news blocks is also practically always fixed, especially on informational 
radio stations.  

What can prevent this item from being aired on time? 
One cause is imprecise following of the scheduled durations of various blocks when filling them with 

real content. This is a perfectly natural situation. It is impossible to fill all commercial, news, and music 
blocks with content with the absolute precision. In one commercial block, there will be less content, while 
in another — more than planned. 

Another reason for the scheduled and actual block lengths not matching may be a break in the 
communications line (e.g., on LAN or WAN), as a result of which a part of the content included in the 
schedule becomes unavailable. 

Finally, there is the human factor, for example the operator's making mistakes when preparing a 
schedule. 

The discrepancy between the actual length of a block and its scheduled length creates conflict 
situations in those parts of the schedule, in which time referencing is employed.  

Calculation of duration of the block and starting time of its items is illustrated on fig. 3.2. 
There may be two types of conflicts. The first one is a shortage of the broadcast material, which 

may lead to a gap before the time check point. Another one is an excess of the broadcasting material, 
which goes over the check point. 

How can the conflicts be avoided? The following are some recommendations to this effect. 
• Do not use time check points unless it is necessary: no check point means no conflict. To a 

certain extent, this method can be applied to the commercial blocks: moving a commercial block 
a few minutes this or that way is perfectly allowable. This will hurt the advertiser not in the least. 
But the news and the blocks coming first in a hour usually cannot be moved. Time-floating 
blocks also create problems for the retransmission stations that replace the main commercial 
and/or news blocks with their own. 
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( StartNext) 

Start 1 
Block start time 

Start 2 Start 3

Real block duration consisting of 4 audio elements.

Time 

Audio element 4

Start 4

 

Fig. 3.2. Calculation of duration of the block and starting time of item. 

• Do time reference blocks using only either the No later or No sooner flag. Using the former will 
prevent the first type of conflict from ever arising; using the latter will exclude the second type of 
conflicts. This method is applicable depending on whether the material being fixed in time can 
be moved in either direction from the fix point.  

• Conflicts of the first type can be avoided by including beforehand excessive material into the 
schedule, usually musical, which is used to fill potential gaps. This method eliminates conflicts of 
the first type completely but may cause conflicts of the second type. 

• Conflicts of both types can be prevented by manually correcting the schedule changing the block 
length: adding or deleting items, creating a crossfade between the audio items, shifting the audio 
item start point. All these operations can be done with the music components of the schedule. 
But the commercial material cannot be cut or the news material mixed. This method produces 
the best sounding schedules but is the most labor-intensive and requires skilled technicians who 
can make high-quality music adjustments. 

• Conflicts of the both types can be prevented without changing the number of block items by 
inserting at the end of the block preceding a check point a repeating audio item with an 
unnoticeable transition between the end and the start. In the DIGISPOT® II system, audio items 
of this type can have the allowed duration of their playback set manually, specifying it explicitly. 
This method makes it possible to avoid relatively short conflicts, but requires the schedule to be 
edited manually. In a particular case, these parameters can be already set in the imported file, 
which dispenses with the manual editing. 

These methods make it possible to prevent conflicts from taking place while still at the short-term 
schedule planning and preparing stage. However, they cannot be used to resolve conflicts arising at the 
schedule airing stage caused by mistakes in schedule planning and preparation, breakdowns, or other 
contingencies. 

Should a conflict happen? How can it be resolved automatically, without human intervention? 
• Software can resolve conflicts of the first type by generating the necessary schedule fragment 

when a gap happens. The DIGISPOT® II has such gap-filling system. It suits equally well the 
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task of filling gaps caused by planning mistakes (usually rather short ones, up to several 
minutes) and the task of filling gaps caused by breakdowns or other contingencies (these gaps 
can be several hours long). This method requires a license for using the gap-filling system with 
the settings of the latter being properly configured. 

• Software can resolve conflicts of the second type by force-ending the playback of the material 
that causes the conflict. In the DIGISPOT® II this is done by setting the Cut off blocks and Cut 
off items flags for the time-referenced block. Setting both flags guarantees that the conflict will 
be resolved. To enable the force-ending of broadcast material, it is necessary to place some 
material broadcasting, which is not critical, before the time-referenced block.  Most often, music 
is used for this purpose. Having only the Cut off blocks flag set for a block does not guarantee 
to resolve a conflict, but makes it possible to reduce the duration of the error condition and to 
avoid automatic cutoff of the audio item being broadcast. 

• Conflicts of the both types can be resolved by dynamically adjusting the playback rate without 
changing the sound tonality. Only relatively short errors can be resolved by this method and the 
sound quality is degraded. Moreover, it increases the processor workload, as it requires rather 
resource-intensive mathematic operations and increases the responsiveness of the entire 
playback system. This method is not implemented in the DIGISPOT® II system. 

From the presented material, a conclusion can be made that in order to construct a conflict-free 
schedule and to provide for automatic resolution of the conflicts that do happen, the structure and 
attributes of the schedule blocks need  to be well-thought out as early as at the skeleton-creation stage. 
The choice of the final block structure of skeletons and schedules depends on the radio station's format, 
the volume and subject content of the broadcast material, and the broadcasting and scheduling 
techniques used at the particular radio station. 
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4 
DJIN – A SCHEDULING AND BROADCASTING 
SYSTEM 
The DJIN program is one of the main software elements of the DIGISPOT® II system. The program's 
main function is to prepare schedules, fill them with the broadcast material, prepare them for 
broadcasting, and to finally broadcast them. In addition, the program's modular construction allows it to be 
used as a base for creating different workstations directly or indirectly taking part in the schedule 
preparation and planning process. These can be, for example, workstations for preparing and controlling 
schedules or reserve broadcasting workstations. A DJin-based workstation may not take part in the 
scheduling and broadcasting process altogether. An example of such a workstation is the MDB 
maintenance workstation or the on-air control log recording workstation.  

What determines the feature set and appearance of a specific workstation? The functionality and 
appearance of a workstation is determined by its configuration. The workstation configuration is saved in 
a file with the VID extension. For example, the AirX configuration is stored in the AirX.vid file. The name 
of the current configuration is shown in the title of the program's main window. A specific workstation can 
have a typical configuration, that is, one of the most frequently used workstation versions. It can also 
have a unique configuration, created expressly to satisfy either the requirements of the specific tasks 
performed at this workstation or the customer's wishes.  

A configuration construction unit is a module. A module is an object that provides capabilities to 
perform a certain function or several functions by the program. A module can have a window permanently 
present in the main program window. A configuration can have several same type modules to provide 
more ergonomic work conditions or to attain the necessary functionality. For example, 
a configuration can comprise several Files modules located at the opposite parts of the screen for a 
convenient execution of Drag & Drop operations; another example is several Block Player modules for 
more convenient organization 
of broadcasting. 

Examples of concrete configurations are resulted in the Application. 
Currently, there are several tens of modules available in the system that can be divided by their 

functions into the following groups: 
• scheduling modules 
• schedule content-editing modules 
• player modules 
• data source modules 
• informational modules 
• auxiliary and service modules 

In the following description of the DJin program, each individual module will 
be described, including its function, controls, and configuration features. As already mentioned, the 
program's main function is to prepare schedules, fill them with the broadcast material, prepare them for 
broadcasting, and to finally broadcast them. Therefore, the modules are considered exactly in the same 
order. First, the planning and editing modules are considered: the Skeleton Wizard and the Schedule 
modules. Next, the modules used to prepare schedules for broadcasting are considered. Followed are the 
player modules, which are used for broadcasting schedules. Then the modules serving as data sources 
when preparing schedules are examined, and finally the auxiliary and service modules are discussed. 
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4.1. Planning and Editing a Schedule. The Skeleton Wizard and the Schedule 
Modules 
In the DIGISPOT® II system, skeletons can be accessed for viewing or editing via the Skeleton Wizard; 
schedules are accessed via the Schedule module. These two modules look very much alike and use a 
unified system to display schedules and skeletons. Therefore, both of them are described using just one 
module 
as an example but indicating the differences for the other. 

Both modules use the same window to display schedules and skeletons. This is a schedule window 
that displays blocks and items included in the schedule. Main editing operations using context menus, 
hotkeys, and Drag & Drop operations can also be performed in this window. The same window allows 
auxiliary windows to be opened to view and edit, for example, properties of a block or of a block item. 
Most functions of these modules coincide; however, specific functions exist that are available only in one 
of the modules. 

Contents of a schedule or a skeleton are displayed in the schedule window as a list depicting 
information about the blocks and their items. The information about individual items is displayed in a 
single line that is divided into columns depicting properties of blocks and items. The higher a line is in the 
list, the earlier broadcast time it corresponds to, and vice versa.  

The parameters of the displayed columns can be adjusted. The user can change the number, order, 
and width of the columns by right-clicking on the list header. 

At the moment of description it was about 30 various columns accessible for displaying including 
also properties of a audio items, appointed in a musical rotator MAG (Mood, Energy, Start tempo, Start 
texture and others), and the user item attributes of MDB. By the way, the user item attributes of MDB 
appear in the list only after updating MDB. In case if at loading of application there is no connection with 
base, columns of attributes which have been seen at last preservation of parameters of the list will be 
displayed. 

Fig. 4.1 shows the Schedule module window with the main items marked off.  
Information about the current contents of the module is shown in the window title. For a skeleton, 

this is the name and the parameters of the loaded skeleton; for a schedule, the date and the weekday are 
shown. If the schedule date coincides with the current date, the text is green, otherwise it is red. The 
name of a skeleton is always in red. 

After the program is launched, the Schedule module is loaded with the schedule for the current 
date; nothing is loaded into the skeleton module when the program is launched. 

The view mode bar has several buttons to change the view mode of the schedule or skeleton.  
The first group of buttons C, N, P, M, B serves to choose what types of blocks are to be shown in 

the schedule. On Fig. 4.2. there are Commercial (C), News (N), and Program (P) blocks shown. The 
Music (M) and blocks with no type (B) are not shown. The state of these buttons can be preset in the 
module settings and the buttons themselves can be hidden. 

Button  enables or disables showing blocks that have been broadcast. A block is considered 
to have been broadcast, if all of its items have been broadcast (in other words, if all items of the block 
have the broadcast time fixed). Pressing the button enables showing these blocks; blocks are not shown 
if the button is released. 
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Fig. 4.1. The Schedule module window. 

 

Fig. 4.2. The view mode switching buttons 

Button  enables and disables the associated schedule-scrolling mode. The mode is enabled 
concurrently in all Schedule modules present in the current configuration. With the mode enabled, when 
the schedule is scrolled in one window, the contents of the other window will synchronously scroll in such 
a way that the window's top line shows blocks for the same time. The mode is useful for comparing 
schedules for different dates. 

Button  enables and disables the playback position display mode, analogously to the same-
name context menu item Always show playback position. In this mode, the list is automatically scrolled 
in such a way that the item being currently played always remains on the screen.  

Editing schedules and skeletons and performing various auxiliary operations when working with 
skeletons and schedules is accomplished in one of the following four methods: 

• By selecting an item in the context menu that opens when right-clicking anywhere in the 
schedule window. The content of this menu depends on the type of the list item selected at the 
moment the menu command is called, on the state of the clipboard, and on other factors. 

• By selecting one of the items in the service menu, which opens by pressing button  in the 
upper right corner of the screen.  

• By clicking a button on one of the toolbars at the top of the program main window. 
• By pressing a key combination assigned to perform some action.  

The design of the DIGISPOT® II system allows a schedule to be edited simultaneously from several 
workstations, with the changes made at any one of them virtually instantly reflecting on the other 
workstations working with this schedule. 

When working with a schedule, user's rights can be restricted by the administration system means. 
The administration system is not considered in this section and the user is assumed to have full rights as 
to editing a schedule. 
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The program executes all schedule/skeleton editing operations as transactions (groups of 
operations), including saving the changes to the file, in which the contents of the block being edited are 
stored. If for some reason the results of an editing operation cannot be saved, the operation transaction is 
not carried out and the contents of the schedule do not change; moreover, an error message is issued. 
Consequently, there is no explicit Save operation for the schedule/skeleton editing operations. In other 
words, all modifications to the schedule are saved automatically, immediately upon execution of the 
editing operation. 

Working with schedules and skeletons is discussed in detail later, after discussing the information 
displayed in the schedule window. 

4.2. Displaying Schedules and Skeletons 
What information is displayed in the schedule window? How can a rising of a conflict be determined or a 
block's total duration found out? 

A brief description of how the values of the main parameters of the schedule blocks and items are 
displayed will be given. In this subsection, fragments of a schedule list will be shown, each illustrating 
how different schedule parameters are displayed. 

The appearance of the schedule window, the order of the displayed columns, fonts, and colors can 
be changed by the user at his discretion. Similarly, displaying certain items, for example headers of 
blocks and items, can be enabled or disabled. Only the columns bearing the main information are shown 
in the given examples. The fonts and colors used are standard. 

4.2.1. Displaying Blocks 
In schedules, blocks can be displayed in two views: the expanded view, with all block's items displayed, 
and the minimized view, without displaying the items. Usually, two lines are allocated to display the block 
information: the block header line, which is displayed before the block item lines, and the block footer line, 
which is displayed after all block items. Information on block items is located between these two lines. 
Note that it is not mandatory for a block to have the block header and the block footer lines; their display 
may be disabled in the module configuration window. The block header line besides playback starting 
time and scheduled duration may also contain its name.  

Fig. 4.3 shows two block views. The first is an expanded view of a music block; the second is a 
minimized view of a commercial block. All main parameters in the figure are supplied with legends. 

Playback starting time is considered the time of starting its first item (displayed in item’s line in 
expanded form). This value can be changed dynamically when broadcasting). 

Block duration (its scheduled duration) can be changed only by editing block. 
Block can be intended for being played back in algoristic moment or can have no exact playback 

starting time.  For example news are broadcasted from the beginning of each hour obligatory, and the 
following musical program simply waits their finishing, which time is not known before – it can be that this 
program can be cut off if it will be not finished to the next beginning of news block. The fixed flags for time 
reference and permission/prohibition of forced cut off of broadcasting are provided for automation of 
schedule editing: Fixed Time Flag and No sooner, No later, Cut off blocks and Cut off items flags and 
also times for allowable from the given value deviation of playback starting time. 
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Fig. 4.3. A block view 

Different combinations of the time reference flags are shown by different colors of the time 
reference indicator. All possible combinations are listed in Table 4.1. The Fixed time flag is implied to be 
set for all cases. The time reference indicator is not displayed if this flag is not set. 

 
Table 4.1. Colours of different time reference flags depending on its combinations  

No sooner No later Cut Blocks Cut Audio items Symbol Color 

     White 

     Blue 

     Green 

     Blue-green 

     Yellow 

     Red 

     Yellow-blue 

     Red-blue 

 
When displaying of block header lines is switched off, the indicator of time reference is displayed at 

the first item of block. 
In case if the set flag Fixed time is "softened" by parameters from Allowable deviation group, 

indication of block time reference does not differ from a case 
of presence only one Fixed time flag. 

It is possible to calculate the real block starting time if Fixed time flag is not set by block, having 
found out previous fixed time nearest to its starting (i.e. block starting time with set Fixed Time flag plus 
playback duration of all blocks located between the found block and the given block. It can turn out, that 
calculated time differs from scheduled time of a starting block. In a block footer line two types 
of schedule error are displayed: 

• Difference between actual and scheduled block duration (total duration 
of all block items). For example, on Fig. 4.3 in music block of 9 minutes and 50 seconds there is 
less material, than it is necessary.  
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• Error in a finishing point of block: how earlier or later playback of material included in the block, 
concerning the scheduled block finishing, will finish. Time scheduled end is scheduled starting 
time + scheduled block duration. 

Note that calculation of an error in block duration and an error in block end point is made only for 
blocks which have scheduled duration. If scheduled duration is not set obviously (by default it is equal 0), 
calculation of errors is not made and the corresponding information is not displayed on the screen. 

• For blocks having set Fixed time flags, both errors are always coincide, 
as block starting playback time does not depend on a condition of other blocks in the schedule. 

• During playback error can vary depending on presence / absence of failures in schedule, as it is 
constantly recalculated concerning the current played back item (when player fixes actual item 
starting playback time in the schedule). 

4.2.2. Displaying Items and Calculating Time 
Information about one block item — an audio item, a pause, etc. — takes one line 
in the schedule window. Item's various parameters are displayed in text 
or as special symbols. At the time this manual was being prepared, there were about 30 columns 
available in the schedule list to display various item parameters.  

Fig. 4.4 demonstrates displaying different type items in a schedule. 
Often, adjacent schedule items are crossfaded and aired overlapping each other – with the mixing: 

playback of the following items starts before finishing 
of playback of previous one. The fact of crossfaded items existing in the schedule 
is indicated by symbol , which is displayed in the name field of the first of the spliced items. This symbol 
means that the playback of the next item will start before the playback of the item marked by the 
crossfade symbol ends. The playback starting point of the next item is indicated by setting the Start Next 
mark (standard module of audio item allows to set as well another marks, influencing 
to its actual duration; more detailed description will be given below). If there 
is no such mark, the playback of the next item will start after the playback of the current one ends. The 
duration of the combined playback of the spliced items 
is displayed in the Fade column (in this time switching of one item to another 
is formed). Quite often, the duration of the "pure" playback of an item is needed; that is, the run time 
between the starting points of the current item and the next one. This parameter is called Runtime of the 
item. Duration of block is equal to the sum of Runtime parameters of all its items. If the item is not 
crossfaded, the Runtime equals the item's playback duration. It is exactly the Runtime that is used to 
calculate the audio item's airing time. 
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Fig. 4.4. Displaying Items 

The airing time (the Start column) is calculated from the previous time-fix point (in the closest block 
with the Fixed time flag set) by adding to it the Runtime sum of all items located between the item and 
the time-fix point. 

Audio items can contain marks determining their starting times. Fig. 3.1. (see Sec. 3.10) shows 
audio item with marks set. 

Fig. 3.2. shows an example of calculation of duration of block, containing spliced items.  
In the event of the program being barred from automatically starting the next item after completing 

the previous, the barred item is underlined by a dotted red line in the schedule. 
The Start column has a place provided for indicating conflict situations and displaying the indicator 

of the item's having already been aired. This indicator 
is a small box on the left to the scheduled airing time. At the moment the player starts the playback of the 
item, this box may be marked with a check mark ( ) and the time displayed in this field will be fixed. To 
provide playback start time fixing 
it is necessary to set same named flag in settings of player, broadcasting by this schedule. Consequently, 
the airing time without a check mark is the planned time, changing dynamically based on the current state 
of the schedule. The airing time with a check mark is the real airing time of the item and does not change. 
If a player fixes the playback time of a schedule item, this affects the airing time 
of the items following it, because the fixed airing time is used as the base for calculating the airing time of 
the following items analogously to the block fixed time points. This makes it possible to take into account 
the real schedule playback rate when calculating the planned airing time. 

In a case if an item must be missed in schedule (has a mark SKIP), in Start column of Schedule 
appears SKIP mark instead of indicator. 

The colour of indicator is used to indicate schedule conflicts. 

4.2.3. Displaying Schedule Conflicts 
Two types of conflicts that can arise at the time check points. The first type causes a gap before a check 
point; the second type causes overlapping of a check point 
by excess material (overscheduling or overflow).  

The first type of conflicts (i.e., gaps) is not displayed explicitly; it can 
be determined by checking the difference between the real and the schedule durations of the blocks.  

Conflicts of the second type are displayed in the schedule explicitly. Conflict indication is foremost 
intended for the decision to be made by the broadcasting operator during manual or semiautomatic 
broadcasting. Therefore, conflicts are indicated with precision not to a second but to one schedule item. 
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When indicating a conflict, the type of the block whose items create the conflict situation is of importance. 
A conflict situation for items of music blocks is displayed differently than that for other types of blocks. 
Let's consider a conflict situation using first a commercial and then a music block as examples.  

 

 

Fig. 4.5. A commercial block conflict example 

Fig. 4.5 depicts a conflict situation involving a commercial block. Its airing time is 16:30 and the 
scheduled duration is 1 minute. The block conflicts with the adjacent news block that has its airing time 
set to 16:31. The conflict is due to the commercial block exceeding its scheduled duration by 50 seconds. 
Moreover, the last clip, McDonald's, starts at 16:31:20, beyond the control point set for following block.  

In the first case, in the picture on the left, the news block has only the Fixed time flag (the white 
time-reference symbol). In the second case, in the picture on the right, the news block additionally has the 
No later flag (the green time-reference symbol). There is virtually no conflict in the first case, as the airing 
time is only recommended for the news block and the actual airing time can be shifted to either side of the 
recommended. Nevertheless, the item completely beyond the control point is highlighted by gray color 
indicating a conflict. Setting the news block's No sooner flag will not change the situation, as this allows 
the block to be played back later than the specified time. 

In the second case, there is an explicit conflict, as the news block is barred to come out later than 
16:31. Therefore, the conflict indicator has more noticeable yellow color. 

In the case shown in Fig. 4.6, the conflict is caused by an analogous situation: exceeding the 
recommended block duration. Here the Hunter item is entirely beyond the 16:30 check point. The conflict 
indicator color for this item is red. And it shows that marked in this way items should be missed in 
schedule for keeping time set for following block. In this respect, it does not matter for the music block 
whether the following block is fixed in time or its airing time is only recommended – music is offered up for 
keeping the following schedule. 

 

 

Fig. 4.6. A music block conflict example 

So we can see that: 
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• Gray conflict indicator marks items of non-musical blocks that do not cause conflicts but entirely 
(in all its duration) conflicting with the airing time 
of the following block.  

• Yellow color indicates an analogous situation, but causing an explicit conflict: the following block 
is fixed in time and cannot be aired later than the specified time. 

• Red color highlights both types of the just described conflicts. 

Conflicts are not indicated for items that start before a check point and end after it.   

4.2.4. Displaying Auxiliary Schedule Items 
It is possible to display additional schedule lines containing auxiliary information. There are four types of 
auxiliary items: 

• Hour Header 
• Hour Footer 
• Free time slot 
• Scheduling conflict — overlapping blocks 

All auxiliary items serve to provide better visualization of dividing the schedule time into the time 
slots and to control the use of time within these time slots. 

Fig. 4.7 shows an example of all types of the auxiliary items. 
 

 

Fig. 4.7. Auxiliary schedule items 

The hour Header (12:00) is located at the top; its Footer showing the unused time is at the bottom. 
The hour has 23 unused minutes.  

The green-background lines with EMPTY mark written in them show free time slots between blocks 
or between a block and the beginning or the end of an hour. The information in them shows the duration 
and the temporal boundaries of the free time slot. The yellow background line with OVER mark written in 
it indicates 
a block structure error. This line indicates that the two adjacent blocks overlap and shows the duration of 
the overlapping.   

When displaying auxiliary blocks, only the scheduled airing time and duration of blocks is taken into 
account. The block content has no effect on the way these items are displayed. Items showing free time 
slots simplify the block-creation procedure. Calling the Create Block command when such item is 
selected in the schedule will automatically set the airing time and duration properties of the new block to 
match the corresponding parameters of the free time slot. 

The auxiliary items are most helpful when working with skeletons; therefore, displaying these items 
is enabled by default for the Skeleton Wizard module and disabled for the Schedule module. Any of 
these four items can be individually enabled or disabled for displaying by the user for both the Skeleton 
module and the Schedule module. 
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4.3. Creating Skeletons 
The created collection of skeletons defines the station's broadcast pattern and makes it possible to 
simplify and speed up the creation of specific schedules in the future. Creating skeletons is a one-time 
preparatory stage. The number of the skeletons that need to be created is determined by the frequency 
and periodicity of changes in the structure of one 24-hour broadcasting period.  

To create a new skeleton, open the Skeleton Wizard module, click the  button in the upper right 
corner of the module to open the service menu, and select the Skeleton item in this menu (Fig. 4.8). 

 

 

Fig. 4.8. Opening the Skeleton Wizard module 

The Select skeleton window will open (Fig. 4.9). 
 

 

Fig. 4.9. The Select skeleton window 

The skeleton list is empty. To create a new skeleton, click the Create button. The Skeleton 
properties window will open, in which the new skeleton's properties need to be set (Fig. 4.10). 
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Fig. 4.10. The Skeleton properties window 

The main skeleton properties are the time slot, for which the skeleton is effective, and the 
parameters defining the uniformly repeated time cells that concretize the skeleton's scope over the given 
time slot. The time slot, for which the skeleton is effective, is defined by specifying the starting date in the 
Start dropdown list and putting a check mark in the corresponding box. Setting only the starting date will 
make the skeleton effective forever from the specified date onward. A skeleton with the Start flag not set 
has no effect on the operation of the DIGISPOT® II system; it is simply stored in the system. 

If the skeleton's time slot needs to be bounded by some future date, this date needs to be specified 
in the End dropdown list with the corresponding check box marked off. If End is not set, skeleton will be 
effective “forever”.  

Next, the periodicity of the skeleton is specified. In the instant case, a skeleton for workdays is 
being created; therefore, the Monday-Friday item is selected in the Day of week dropdown list. 

These parameters are enough for the skeleton to work; however, to make it easy to locate in the list 
visually, give it a descriptive name Workday in the Skeleton name field. 

The skeleton-creation process is finished by clicking the OK button. 
To modify the properties of an already-existing skeleton, its Properties window can be called by 

selecting its name in the list in the Select skeleton window and clicking the Properties button. 
Let's try to create skeletons needed for the description of work of radio station. We shall consider a 

simple example when all the week-days have the same broadcasting structure, and all days off - another. 
First we shall create skeleton of the week-days: in the Day of week list we choose an item 

Monday-Friday. We give the name Weekdays to this skeleton, and we shall not limit the validity of it. 
Press ОК. 

Let's repeat operation of skeleton creation and we create one more skeleton - for days off. 
Let's provide also a special skeleton for preventive maintenance days - we shall assume it is carried 

out on the first Monday of each month. We create a skeleton for all first Mondays of month. Its 
appearance is shown on Fig. 4.11. 

After finishing of skeleton creation in the list of skeletons 3 items (Fig. 4.12) will appear. 
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Fig.4.11. Skeleton’s of preventive maintenance days parameters 

 

Fig. 4.12. Items of the skeleton list 

A check mark in the A column indicates that the skeletons are active for the given date. The date is 
selected in the dropdown date-selection list in the bottom right corner of the Select skeleton window (Fig. 
4.9). By default, the current date is set in this list when the window is opened. By changing this date, you 
can check how accurate the skeleton collection is. When the date is changed, the program selects in the 
list of the active skeletons the one it considers the most suitable for the selected date; the system will 
select this skeleton when creating a schedule for this date. 

The skeleton name is shown in the Name column; the Parameters column holds all parameters 
specified when creating the skeleton. 

Consequently, you have created a set of skeletons defining the broadcasting structure for 
workdays, weekends, and for the maintenance days.  

Now you have to edit these skeletons and fill them with content (blocks that define the subject 
content of the schedule for the corresponding days). This operation needs to be performed for all the 
skeletons. 

There is an alternative way of doing this: to make a copy of a skeleton whose contents has been 
edited and then change the effective period parameters of the copied skeleton. This is done by selecting 
the necessary skeleton in the Select skeleton window and clicking the Create copy button. This will 
open the previously described Skeleton properties window (Fig. 4.10). You need to set the parameters 
for the new skeleton in this window, after which a new skeleton will be created. 

A skeleton is opened for editing by selecting it and clicking the Open button. This will close the 
Select skeleton window, and the selected skeleton will be loaded into the Skeleton Wizard module. The 
name of the loaded skeleton will be shown in the window title (Fig.4.13). 
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Fig. 4.13. The window title 

More than just a collection of blocks can be created when editing a skeleton. Permanent items, both 
audio and informative, can be added to the blocks. Skeleton contents are edited in the same way as 
schedule contents. 

4.4. Editing Skeleton and Schedule Contents 
All commands for loading, editing, and performing auxiliary operations with schedule items and a 
schedule as a whole are called by clicking toolbar buttons or by selecting an item in the schedule context 
menu or in the service menus of the Schedule or Skeleton Wizard modules. Some commands can be 
called from both the toolbars and the menus.  

When calling a command using a toolbar button, the schedule window must be active; otherwise, 
the button will be disabled. The toolbars are described at the beginning of Section 4. 

Fig. 4.14 shows an example of the context menu of Schedule module, Fig. 4.15 shows the 
schedule service menu, and Fig. 4.16 shows the skeleton service menu. In all menus, the current hotkey 
combination assigned to the corresponding operation may be shown in the rightmost position of the menu 
item. The default hotkeys are shown in the figures. 

 

 

Fig. 4.14. The schedule context menu 

The following are the brief descriptions of the menu commands (commands are conditionally united 
in groups divided by a line). 

First group: 
• Properties. Calls the properties window of a block item. Allows the item's descriptive and 

control parameters to be changed.  
• Block Properties. Opens the properties window of the selected existing block. 
• Show text - viewing of text items of the schedule. This command opens the Text window, 

displaying the name of text item, its contents and approximate perusal time. 
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• Show the nearest to current time item- to thumb through the schedule and to mark in it the  
item or the block, which broadcasting time is most close to current time.  

Second group: 
• Copy, Cut, Paste. Clipboard commands to edit block contents. 
• Copy to commandin many respects repeats the Copy command; it serves for copying the 

selected item of the schedule in a file taking its format into account. It calls the auxiliary window 
Audio Files Converter, more detailed about which will be told further. 

Blocks submenu –the group of commands for working with blocks. 
• Create block. Calls the block-creation window. 
• Copy selected blocks, Cut selected blocks, Delete selected blocks. Calls the window to 

copy, cut and delete the selected blocks. 
• Insert copies of selected blocks. Calls the window to multiply the selected blocks in the 

schedule 
• Split block. Allows to split the selected block in two at the indicated point. 
• Expand… / Collapse… - contains a submenu, allowing to develop (unwrap) / to curtail (turn) in 

the schedule all blocks or blocks of the certain type. 

The following is a group of commands for the final menu editing. The commands are described in 
detail in Section 4.4.7, "Final Schedule Editing". 

• Search for start point. Calls the module seeking the starting point of an audio item. 
• Edit Selected Item. Opens the module for editing schedule's audio and text items. 
• Crossfade. Call the crossfade editor to edit transitions between audio items. 
• Crossfade 3. The same as Crossfade but always transition of one audio item to another one en 

route through the intermediate one, i.e. for three items. 
• Record voice track. Calls the voice track recording module to record the track at the transition 

between audio items. 
• Group crossfade. Placing a permanent crossfade on the transition between the selected audio 

items. 
• Auto glue marking - calls auto glue module window. 
• PFL crossfade. Opens the prefade listen window to check the audio quality of the crossfade 

between two audio items. 
• PFL. Opens the prefade listen window to check the audio quality of an audio item.  

The menu on Fig. 4.15 has service and auxiliary commands used to work with schedules (also 
united in groups). The following are their brief descriptions. 
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Fig. 4.15. Service and auxiliary commands 
used to work with schedules (also united in groups). 

First group: 
• Load schedule. Loads a schedule for a specific date into the module. When the command is 

called to load a schedule for a certain date for the first time, the schedule is created based on a 
skeleton.  

• Skeletons – calls a Skeleton Wizard module. 
• Insert skeleton. Used to explicitly copy and paste the contents of a skeleton into a schedule. 
• Import from text file. Imports all or a part of schedule from a text file. 

Further are the independent commands: 
• Create block. An alternate way to call the block creation command. 
• Test blocks. An auxiliary command to check all items in all blocks for files with incomplete 

names, for missing or present files, etc. This action is executed automatically after a schedule 
was imported. 

• Refresh. An auxiliary command to explicitly read a schedule from files. There is no need for this 
command in normal situations as the contents are updated automatically, albeit with a few-
second delay, after modifications were inserted. This command performs an ad hoc explicit 
schedule contents update. The changes updated by this command are those made at other 
workstations. Changes made at the local workstation are reflected instantly. 

The following group: 
• Delete all blocks. Completely clears the schedule. 
• Always show playback position. This command toggles and shows the status of the always-

in-view playback position mode. When this mode is enabled, the program keeps the schedule 
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point being currently broadcast in the visible area of the window. The enabled state of the mode 
is indicated by a check mark against this menu item. Button  in the upper right part of the 
Schedule module has the analogous function.  

• Show playback position. This is an explicit command to scroll the schedule to and show the 
point being currently broadcast when the show playback position mode is disabled. 

• Linked Scroll – switching on mode of schedule linked scroll (used when working with a few 
schedules). 

• Clear «Skip item» marks – the command of clearing marks “Skip item” (acts analogously to 
previous command). 

Following group: 
• Schedule – sub-group of command for working with schedule as a single whole. It contains 

following commands: 
o Save as text. Used to export schedule contents to a text file. The exported fields are 

configured separately on the Log Field tab in the program Settings, called from main 
menu Service. 

o Save to XML-file, Save to binary file – these are commands of loading schedule to XTM 
or binary file (file with schd. extension). 

o Load from binary file – command for loading schedule from binary file (file with schd. 
extension). 

o Add from binary file – this command also works with a binary format, however instead of 
new file creation with an indicated name (or clearing of selected file before saving), it adds 
already existing file with new information. 

o Analyze play logs – this command calls Compare play logs with text file window, which 
allows checking a discrepancy between planned schedule and material actually 
broadcasted.  

• Print. Prints all or the selected part of a schedule using a report form template. 
• Disable editing. Allows the user to temporarily disable any schedule-editing operation to avoid 

changing it accidentally. This mode can be set, for example, after getting a schedule ready. 
Enabled by placing a check mark against the command. 

• Reserve. Used to explicitly make a reserve copy of the contents of a schedule, that is, to copy 
all schedule files to the local hard disk of the given workstation. Requires that the reserve 
copying system be available and enabled. During normal work, the reserve copying is performed 
periodically on the regular basis as a background task. 

And the last group: 
• Gap filler setup. Opens the Gap filler setup window. The system's function is to automatically 

generate pieces of schedule to fill up gaps produced by shortages of the broadcast material in 
the automatic broadcasting mode. 

• Merge to audio file. Used to merge a schedule into a contiguous block of audio files. The 
results of this operation is analogous to broadcasting the schedule and recording the broadcast 
to a file with all splices, time control points, etc. taken into account. The only difference is that 
the merging process is executed tens times faster than the real time recording. The results are 
saved into files by hours, by block borders, or by time control points. 

The separate command Properties opens the properties configuration window of the Schedule 
module. Used to set work and module parameters and other parameters for displaying the schedule. 



Cooperation for Development of Hard-and Software 
for Audio and Video Broadcast Studios in East and 
West Europe. Design and Manufacturing of Studio 
Equipment  for the Audio recording Industry and the 

 

 
e.mail: info@tract.ru   e.mail : infor@barthkg.com  
 web :http//www.tract.ru   web : http://www.barthkg.com 
 

    

 

copyright: RBKG&TRC  Page 53 of 219 

in field of Video Postproduction. 

The service menu of the Skeleton Wizard module differs from the analogous menu of the 
Schedule module. It does not have the commands that are specific only to schedules. 

 

 

Fig.4.16. The Skeleton Master service menu 

4.4.1. Loading a Schedule 
Working with a schedule starts by loading into the module a schedule for a certain date whose contents 
need to be created or modified. Loading a schedule into the module is started by selecting the Load 
schedule command in the service menu. In the window that opens (Fig. 4.17), select the date, for which 
the schedule is loaded, and select one of the schedules available in the system in the Schedule list. The 
list shows the name of each schedule and the category it is stored in. By default, there is only one 
schedule in the list, the main one, accordingly named MAIN. 

If this is the first time the schedule for this date is loaded (that is, it has not been created yet), the 
system will search for a skeleton most suitable for this date in the skeleton list and will copy its contents 
into the new schedule (i.e., creating the schedule based on a skeleton). When creating a schedule based 
on a skeleton, it is not important, on which workstation the schedule is first opened and whether  the 
Skeleton Wizard module is used on this workstation; the only thing that matters is that there should be a 
suitable skeleton for this date in the system. If no suitable skeletons are found, a new empty schedule will 
be created. If a schedule for the given date already exists, it will be loaded into the module unchanged 
even if it is empty and has not a single block in it. 

 

 

Fig.4.17. The Load Schedule window 

A skeleton can be copied into a schedule explicitly after it was created; it is done by selecting the 
Insert skeleton item in the schedule service menu. This will open the previously-described Select 
skeleton selection window (Fig. 4.9), in which the needed skeleton is selected and then loaded by 
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clicking the Load button. This will add the contents of the skeleton to the current contents of the 
schedule. 

4.4.2. Working with Blocks. The Block Properties Window 
Editing a new schedule or a skeleton is started by creating blocks. A block can be created in one of the 
following two ways: by pressing button  on the schedule toolbar (the schedule's window must be active) 
or by selecting the Create block item in the context menu. The latter is opened by right-clicking anywhere 
in the schedule window area (on a block item, a block header, or on the free window area). This will open 
the block properties window (Fig. 4.18) with three tabs in it: General, Remote control and Description. 

The General tab shows the state of all block parameters used when designing a schedule. They all 
must be set as needed and the block creating process completed by clicking the OK button. 

Below there are descriptions of each block parameter: 
• The block's airing time. This time is set in the field to the right of the Fixed time flag. This 

property defines the scheduled airing time of the block's contents. Moreover, it identifies the 
block's position in the schedule, as all blocks in the schedule (skeleton) are ordered by this time. 
The indicated time is used as the reference point when determining the estimated airing time of 
the audio items in the block. How this time affects the estimated airing time of the block items is 
determined by the Fixed time flag. A schedule must not have blocks with the same airing time. 

• The Fixed time flag. When this flag is set, the airing time indicated must be observed precisely 
during the broadcasting. In this case, the scheduled airing time for the block items is calculated 
as the time shown for the block plus the offset time to the start of the specific block item from the 
beginning of the block. An item's offset from the beginning of the block is calculated as the sum 
of the run times of all items in the given block prior to the given item. In this case, the other 
schedule blocks do not affect the estimated airing time of the item. If the Fixed time flag is not 
set, the airing time of the given block is not clearly defined and depends on when the previous 
block ends. In this case, this time does not affect calculation of the airing times of the block's 
items but is used only to determine the block's position in the schedule. The airing time for such 
block's items is calculated as an offset from the airing time of the first previous block with the 
Fixed time flag set. The fact that a block has the Fixed time flag set is reflected in the schedule 
by the special symbol . 
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Fig. 4.18. The block properties window 

• The time reference flags: No sooner, No later, Cut off blocks, Cut off items and Allowable 
deviation of block airing time to one or another direction. These flags are used by the players 
when broadcasting a schedule and to determine conflict situations. They determine just how 
rigidly a player will observe the time reference. Blocks without any of the flags set are played 
back by players sequentially, one after another. The block's airing time is not taken into account 
and is used only to be displayed in the schedule and to calculate the estimated airing time. A 
player takes into account the information about the block's airing time only if at least one of the 
block's No sooner or No later or Allowable deviation flags is set. Different combinations of 
these flags are indicated by different colors of the  symbol (see Table 4.1). The flags' 
functions are understood from their names. The No sooner flag bars the block to be aired 
before the specified time; the No later flag forces the block 
to be aired no later than the specified time, allowable deviation parameters sets the limits for 
block airing time. Setting both of these flags set fixes the airing time within an interval. If by the 
time a block is to go on the air the playback of the previous block has not been completed, then, 
unless the Cut blocks or Cut audio items flags are set, the block will violate the airing rules 
and will be aired later than the scheduled time, after the previous block finishes its playback. It is 
possible to solve this problem by replacement of No sooner and No later flags to the Allowable 
deviation of airing time. There is another way to solve such conflict: setting the Cut blocks flag 
allows the block to interrupt the getting-in-the-way block but only after the current audio item 
finishes. Setting the Cut items flag allows the block to interrupt the previous block at any time 
during the audio item playback. The audio item will be cut smoothly, with a fade. Setting of each 
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these flags follows the automatic setting of Fixed time flag. X-player provides the precise 
reference time observance. 

• Duration. This property specifies the block's scheduled duration. Most often is used when 
working with schedule skeletons. Planned and actual block duration can differ; the scheduled 
duration is used by the program to calculate the error between the scheduled and the real 
duration of the block. Moreover, the scheduled duration allows situations to be detected in 
schedules and skeletons when one time slot is overlapped by two blocks or, on the contrary, 
there is a gap between blocks. The scheduled duration does not affect the process of 
broadcasting the block's contents. 

• Block type. The block's type determines the color the items of the given block will be 
highlighted in the schedule window. Players reproduce different blocks differently.  

• Block name. This is an information field that is displayed in the schedule window. It can contain 
any text string.  

• The Manual loading flag indicates that the given block can be loaded into a player only 
manually. Blocks that have this flag set will never get into a player automatically. Its symbol is 

. 
• The Inner block flag. This is simply an informational indicator shown in the schedule window by 

symbol . It is used to mark out blocks, usually commercial, that are to be aired in the body of 
some program.  

• The Remote control tab. This tab is used to assign the block one or more commands (byte 
sequences) that the system automatically sends over RS232 interface at the beginning or the 
end of the block's playback in the player. This capability is used by the DIGISPOT® II system 
when controlling the Insert player from the main broadcasting station. Moreover, the capability 
to send commands can be used to solve specific tasks of controlling external devices or other 
programs.  

• The Real duration field always shows 0 for a block being newly-created; this field is used only 
to display this property for existing blocks. The Apply to and Apply what fields are also used 
only when editing properties of a previously-created block.  

• Description tab allows assigning description of corresponding block and keeping some user’s 
comments. 

More than one block can be created in one call of the Create block command. For this, the 
Number and Period fields are used. The necessary number of blocks and the interval with which they 
are repeated in the program are entered into these fields, respectively. The interval time is in the HH:MM 
format. Clicking the 
OK button will create a group of one-type blocks. The airing time of each block will be offset from the 
previous block by the time specified in the Period field. 

The Properties window can also be opened by calling the Block properties command of the 
schedule's context menu. The Real duration field will show the actual length of the displayed block. The 
Apply to and Apply what fields will become available, but editing of the Number and Period  fields, on 
the contrary, will become disabled.  

• The Apply to field serves to specify, to which blocks the block editing changes should be 
applied, and in this way change properties of a group of blocks in one go. However, not all 
properties can be changed by the group change method. The property fields that cannot be 
changed for a group of blocks become unavailable when the item in the Apply to list is 
changed. This list can have the following values: 

• Current. The changes will be applied only to the block, for which the command was called. This 
value is selected by default. 
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• All with the same minutes. The changes will be applied to the blocks of all hours that have the 
same minutes as the block being edited. 

• All selected. The changes will be applied to all blocks currently selected 
in the window. 

• All with same type. The changes will be applied to all blocks of the same type as the one being 
edited. 

• All blocks. The changes will be applied to all blocks in the schedule. 

Set of properties which are applied to these blocks, are set by means of the list Apply what. There 
are possible variants: All settings, Block type, Start type, Block duration, Remote commands. 

A group of existing blocks can be duplicated with an offset in a schedule. 
This is done by selecting a group of blocks to be duplicated and then selecting the Insert copies of 

selected blocks command in the schedule context menu. In the window that opens, specify the number 
of blocks to be copied and the time offset, analogously to how it is done for the parameters set in the 
Block properties window when creating a group of blocks. Blocks are selected by selecting their titles or 
one of their items.  

The capability to split a block in two is provided. This may be resorted to, for example, when 
manually editing an imported schedule to split a music block and to insert a commercial block into the 
gap. The block-splitting process is started by selecting in it the item, before which the block is to be split 
(this will be the first item in the new block) and then selecting the Split block command in the schedule 
context menu. A new block will appear in the schedule, into which the contents of the source block will be 
transferred starting from the selected audio item. The airing time of the new block will be the same as the 
scheduled airing time of the selected item of the source block. The new block will be of the same type as 
the split block, but will have no time-reference flags of any type. 

NOTE 
If a block item is selected when the Create block command is called, when the new block is created, the block in 
which the item is selected will be split at that item and the new block will be inserted into the created gap. If an 
auxiliary item EMPTY indicating free space between the block items is selected when the Create block command 
is called, the airing time and the playback length for the new block will be set corresponding 
to these parameters of the free interval. If the block header or its footer is selected when the Create block 
command is called, or if the command is called by clicking on an empty spot in the schedule, no additional 
operations will be performed when the window opens. The Create block command can also be called from the 
service menu. In this case, no additional operations (automatic parameter setting, block splitting) will be performed 
when the block is created. 

A handy function when working with blocks is the capability to minimize (show only the block's title 
bar) or maximize blocks of certain types or all blocks altogether. This is done by the Blocks submenu on 
the schedule context menu. One block can be minimized or maximized by double-clicking the block's title 
bar or by selecting its title in the schedule and pressing the <Enter> key.  

Entire blocks cannot be copied from and pasted to a schedule using the clipboard (the system 
Copy and Paste operations) or to be moved around the schedule by dragging. These operations can be 
performed on block items only. 

4.4.3. Adding Items to a Block 
The following are brief descriptions of all types of items that blocks can contain. 

• Audio item. This is the main block item type. It contains a reference to the file, descriptive 
information, and numerous parameters that affect this item's playback in a player. The file can 
be a conventional audio file, of the WAV or MP3 type, or a project file. A conventional file is 
depicted in the schedule by symbol ; a project file is depicted by the  symbol. 
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• Background sound. Background sound is an audio item that is played back until the last item 
of the block ends or the next background sound starts. The rest of the block's audio items are 
played back over the background sound (with mixing). At the time this manual was being 
prepared, only the X Player supported background sound playback. In a schedule, a 
background sound item is depicted by symbol  in addition to the audio item symbol. 

• Voice track. This is a special audio item. It is created using the voice track recording module. A 
voice track contains recorded speech of the broadcasting operator that accompanies the 
transition from one audio item to another. In addition to the audio item symbol, it is depicted by 
symbol  in the schedule. 

• Pause. A pause is special item that is reproduced by players but makes 
no sound. The item function is to reserve time in a block for some event, for which the 
broadcasting program is not responsible. Some examples of such an event would be playing an 
audio item from a regular CD player, a direct microphone cut-in, etc. This item is often combined 
with the stop command for the player, because to exactly align the pause playback end with the 
end of the external event is usually impossible. Using pauses whose duration gives at least a 
rough idea of the duration of the external event helps for the correct calculation of the airing time 
of the items following it. Pauses are depicted by symbol  in schedules if the playback is to 
resume after the pause and by symbol  if the playback will be stopped after the pause. 

• Microphone Pause. This is a special pause used to reserve time for a microphone insert in a 
block. It is processed by the program the same as a regular pause but is depicted by a different 
symbol: .  

• Stop. This is an information-controlling item. It is an explicit command to the player to stop the 
playback at this schedule point and to await a manual start. Its symbol is .  

• Info. This is an information item. It has no effect on the schedule playback. Its title contains 
short reference of informational text, which is displayed in the schedule. The text is blue color. 
Its symbol is  . 

• Voice track marker. This is a special type of the Info item. It indicates the location in the 
schedule, in which a voice track is to be recorded. This item is not an audio item and is not 
reproduced by players. In the schedule, it is depicted by symbol  but without the audio item 
symbol. The title text is blue color. 

• Text file. Items containing text files (TXT or RTF) can be included in a schedule. These items 
are ignored by regular players; they are intended only for the Report player. Its alternate use is 
to include into a schedule text files containing reference or other information for the broadcasting 
operator. On the air, the text can be viewed in the special window that opens when the item 
Show text is selected, or by clicking the button that launches the prefade listen of audio items. 
In the schedule, it is depicted by symbol . 

• Subject. This is a special item, which contains text and audio sequence. Its function is 
analogous to that of the text files included in the schedule. Its symbol is . 

• Rotated item. This item serves to indicate positions of schedule, in which by press red key R on 
rotation toolbar the real audio items will be set. When an item it created, its type and the MDB 
category are specified. When the actual schedule is formed, the rotated items are replaced with 
real ones taken from the specified MDB category. Such items are most often used to reserve 
place in skeletons for jingles. The replacement is made with the item of the specified category 
that has not been aired longer than the rest. The rotation allows repeating jingles to be avoided. 
In a schedule, rotated items are depicted by symbol .   

Special items like Pause, Stop, and the like are created in a block using the Schedule tools 
toolbar; the rotated items are created using the Rotation tools toolbar. It is also possible to use hotkeys 
for creating these items.  
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Audio and text items can be added to a block only using the Drag & Drop method or the clipboard 
operations.  

The following steps are performed when adding items using clipboard. Using the Copy or Cut 
command, copy the items in the source window to the clipboard. These commands can be accessed 
either from the context menu, using the Editing toolbar, or by hotkeys. Next, switch to the destination 
schedule window and select in it the item in front of which the new items are to be added. Insert the items 
from the clipboard using the Paste command, which is called in the same way as the Copy or Cut 
commands. The new items will be inserted before the selected item. Items that are created using the 
toolbar are also placed before the selected item. To add items at the beginning of a block, the block title 
needs to be selected when performing the paste or create item operations. Items that are added using the 
Drag & Drop operation are placed before the item, onto which they are dropped or at the beginning of the 
block if dropped onto the block title. If Drag&Drop operation carried out in completely empty schedule the 
empty block with zero airing time in which this element will be placed will be automatically created. 

Any data modules — Files, F-Categories, MDB, as well as the schedule window itself — can be 
data sources for the Drag & Drop and clipboard operations. Note that when adding an item to a schedule, 
all metadata (parameters) set for the copied item in the source module is added. For example, if the item 
has the Start Next set in the source module, a splice with the next audio item will be automatically added 
to the schedule when this item is added. 

An item can be moved to a new position in a schedule by a sequence of the Cut/Paste operations 
or by dragging it to the new place. When an item is dragged within a schedule, it is always moved to the 
new place and not copied. The Voice track schedule items must not be moved within a schedule 
because this will sever their ties with the adjacent items. 

In addition to being added to a block manually, items can be added automatically when performing 
import operations and when automatically generating a schedule fragment by the gap-filling module.  

4.4.4. Importing a Schedule from a Text File. The Import from File Window 
Schedules can be imported from a text file if there is some external system available that generates a 
complete or a partial schedule for a 24-hour period. The external schedule-generation program must have 
the capability to save a 24-hour schedule as a text file. In the simplest case, the schedule is imported 
directly from a file. This is possible in cases when the information is stored in the imported file as strings 
divided into fields by some separator symbol. Each of the fields holds an item parameter or a block 
parameter. When files of other, more complex, formats are used, for example Excel files, they are 
imported using a special preprocessor program that converts files of the given format into the text format 
files, which the DJin program understands. The result of the import operation depends on the information 
contained in the imported file. If the file contains information about how to the material is broken into 
blocks, the import operation will create many blocks filled with content. If there is no such information, the 
material will be placed into the existing schedule blocks. As a particular case, a schedule can be imported 
from a file that has no block information but has information about the airing times of the audio items with 
the material broken into hour blocks. This is most often done to import the musical content of a schedule. 

Import results to a great extent depend on the import format. The import format is created using the 
Import formats window, which can be accessed by selecting the Service > Import formats command 
sequence in the program's main menu. The import format is created once when configuring the system 
and is saved under the name given to it by the user. The details on configuring the import format are 
given in Section 4.10.8. When executing an import operation, you need to specify the source file and the 
import format prepared in advance and used for working with the files of the format being imported.  

A schedule is imported using the Import from text file window (Fig. 4.19), which is called by 
selecting the Import from text file command in the service menu of the Schedule module. 
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Fig. 4.19. The Import from text file window 

There are quite a few fields in this window, but most of them serve to simplify preparations for 
importing a file. The two lower fields — Import format and File name — are minimally required. In the 
first, the import format is selected from the dropdown list of the formats prepared beforehand; in the 
second, the path to the text file being imported is specified. The standard file-selection dialog window is 

opened by clicking the  to the right of the File name field. After these two fields are set, the import 
process can be started by clicking the OK button.  

The Date field shows the date of the schedule, for which the import is being performed; this is an 
informational field and its value does not change. 

The File properties group allows the file selection process to be automated. Often, the name of the 
imported schedule file contains the full or partial schedule date. Imported files are usually located in the 
same directory. Consequently, the directory holding the files can be specified in the Directories field; the 
template for the text file name can be specified in the Mask for file name field in the following format: 

• YYYY: year, four digits  
• YY: year, two digits  
• MM: month, two digits with the leading zero  
• DD: date, two digits with the leading zero  

When the Apply button is clicked, the system will try to find an appropriate file in the specified 
directory. If it succeeds, the name of the file it finds is placed into the File name field; otherwise, an error 
message is issued. 

The prepared settings, including the name of the import format, can be saved as preset settings. 
This is done by entering the name for the preset settings in the Preset filed and clicking the Save button. 
The current preset settings are deleted from the system by clicking the Delete key. When a preset setting 
is selected from the list of the existing preset settings, the Import from file window fields are 
automatically filled with the corresponding values saved in the preset setting. If a file name mask was 
saved in a preset setting, the system will attempt to locate a file corresponding to the schedule date. The 
system remembers the name of the last preset setting used to import a text file and when the Import 
from file window is opened the next time, it will automatically set all parameters from this preset setting 
and will attempt to find a suitable file. There is no need to click the Apply button in this case. 

After the import format and the name of the source file are specified one way or another, the import 
procedure is initiated by clicking the OK button. If the import process is successful, the schedule contents 
are changed; an error produces a corresponding warning. 
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Immediately after the information from the file is usefully imported, the process of the block self-
testing is started. Blocks are tested to verify the accuracy of the information about block items that was 
obtained during the import as well as to search for information about an imported item, should it be 
necessary. An error during the block testing stage opens a special window with a list of the errors found. 
An example of such an error would be a file specified in the imported file for some item not being there.  

The most important information about the imported item is the full name of the schedule item file 
that contains the audio or textual information for this item. If the system has no item file name, it cannot 
reproduce the item. For the user, important is the descriptive information connected with the imported 
item: the metadata. 

When the schedule is imported, the item file name and its metadata can be specified in the 
imported schedule file. An alternative is specifying the item file name and the location of its metadata 
indirectly. The metadata specified in the imported file is of a higher priority than the corresponding 
metadata that may be stored within the item. For example, if an item file stores its name as "Love" but in 
the imported schedule file its name is given as "Loving," in the schedule this file will be called "Loving." If 
a parameter is not specified in the imported schedule file, it will be taken from the item file's metadata. In 
the previous example, if the name of the item file is not specified in the imported schedule file, in the 
schedule this item will be called "Love." The only item parameter that is always based on the actual item 
file is the item's duration. Even if an item's duration is specified in the imported schedule file, after the 
name of the real item file is obtained, the duration specified in it will be used. 

All possible combinations of obtaining the file name and storing the metadata are presented in the 
following list. In all cases, the metadata contained in the imported file can be specified explicitly. 

• The full name of an audio or text file is specified explicitly in the imported schedule file. The 
metadata are read directly from the file. 

• Only the file name but not the full path is specified in the imported file. In this case, when the 
block verification is performed, the program will search for a file with the specified name in the 
search directories specified in the Import format window.  The metadata are read directly from 
the file after it is located. 

• The item's MDB identifier (DB ID) is specified in the imported file. The metadata, including the 
file name, are read from the corresponding MDB item. 

• The item's unique external database identifier (ID Number) is specified in the imported file. This 
is an MDB field that identifies the item in an external database and not in the MDB itself as the 
DB ID does. This field is also unique, which allows it to be used to search for the item. The 
metadata including the file name are read from the corresponding MDB item. 

• The name of the item (not of the file) stored in the F-Categories module is specified in the 
imported file. The metadata, including the file name, are read from the corresponding F-
Categories item. 

• The item is searched in the F-Categories module by its ID Number and not by its name. In this 
case, the ID Number is simply a unique identifier not related to the MDB or the external DB. The 
metadata, including the file name, are read from the corresponding F-Categories item. 

The import process and its configurations are described in detail in Section 4.10.8. 

NOTE 
When importing into an existing collection of blocks, the imported items are added at the end of the block they 
pertain to (if block type is not specified, these items are added in the nearest block). If there already are items in 
the block before the import, for example those specified in the skeleton, the new items will be added after them. A 
situation may arise when an item added to the block earlier needs to be held at the end of the block. This can be, 
for example, the final jingle of a commercial block specified in the skeleton: This jingle must be played at the end of 
the block. To hold an item at the end of the block when new items need to be imported before it, this item's Keep 
at the end of block during import flag needs to be set. This is done in the item Properties window on the tab 
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Extended. Items that have this flag set are depicted by symbol    in the schedule. The new items will be added before the 
item with this flag set starting from the beginning of the block. 

4.4.5. Editing Item Properties. The Item Properties Window 
How can an item name or Info text be changed in a schedule or an audio item trimmed? How can a 
player be stopped from automatically launching the next schedule item? How can a background sound 
audio be looped and its duration specified? All these and many other actions can be specified by 
changing a schedule item's properties using the audio item Properties window. 

The properties window is called by selecting in the schedule the item whose properties you want to 
edit and then either selecting the Properties command in the context menu or pressing button  on the 
Item tools toolbar. The item properties window can also be called by double-clicking the schedule item 
that needs editing. For this to work, however, the value Properties must be set for the Double click 
parameter, which can be reached at Service > Settings > Other > Schedule. A screenshot of the audio 
item Properties windows is shown in Fig. 4.20. 

 

 
Fig. 4.20. Item Properties

The name of the item whose properties are displayed in the window is shown in the window title. 
The item's different properties are grouped under several tabs. 
The exact number of the tabs depends on the type of the item and the current program settings. 
The following are their brief descriptions: 
• General. This tab holds the main descriptive parameters of the item: the item type parameters, 

the parameters defining the item's reproduction 
in the player, and various other parameters and flags. 
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• Attributes. This tab holds the values of the user attributes created in the MDB. 
• Remote control. This tab serves to create control commands that are sent when playing back 

items over RS232 and to assign these commands to specific items. 
• MAG. This tab represents item properties in respect to musical rotation program of the same 

name. 
• Comments. This tab contains and allows editing a text field containing reference information. 
• Media – information about musical composition (recording medium, number of a track, year of 

issue, LC code and Editor). 
• Marking. This tab can be accessed only for audio items (items linked to audio files). From here, 

an item can be marked with the playback Start and Stop marks, the information marks (e.g., 
Intro and Outro), and other marks. In addition, the level of the played audio item can be 
changed from this tab. 

• Extended. The tab contains and allows modification of a group of rather seldom used specific 
parameters. These are such as the automatic refreshing parameters for MDB items, the X 
Player playback channel, the Keep at the end of a block during import flag, etc.  

The item Properties window is used in all DIGISPOT® II system modules to display item properties 
(the Files, F-Categories, MDB, and other modules). When used in different modules, this window can 
have tabs specific only for one module but not for others. The number and type of tabs depends on the 
item type and the program settings.  

Note that all parameters set for a schedule item are saved in the schedule only. Those parameters 
stored in the file cannot be edited from the schedule item Properties window. 

The most important item parameters are those that modify the way the item sounds and process of 
the schedule playback in the player. Such parameters are the following: 

• The Auto start next flag (on the General tab). If this flag is not set, the player stops after it 
finishes playing the current audio item and waits for instructions from the operator to continue 
playback. Audio items that have this flag cleared (i.e., the automatic start of the next audio item 
is not allowed) are underlined by a red dotted line in the schedule . 

• The Loop playback flag. This flag's being set means that after the audio item finishes playing, it 
starts over again. Setting this flag makes the Dur. (duration) field accessible, in which the 
duration of the loop playback is specified. Audio items that have this flag set are marked by 
symbol    in schedules. 

• The Loop outro flag is similar to the Loop playback flag, but in this case only the part of the 
item between the Outro mark and the item's end will be played. These items are also marked by 
symbol  in schedules. 

• All parameters on the Marking tab. The playback duration is changed by marking the audio 
item's start and end with the Start and Stop marks, respectively. The playback starting point for 
the current item is set by the Start Point mark. The playback starting point of the next audio 
items 
is set by the Start Next mark. Setting the Fade In and Fade Out marks allows the audio item to 
start with a fade-in and end with a fade-out. All of these marks but the Start Point mark and the 
playback level can be set in a more convenient and visual way in the cross-fade editing module. 
The Start Point mark can be set in the Start point setting module. 

Note that the playback duration of only looped audio items can be edited. This cannot be done for 
the regular — not looped — audio items. The part of an audio item that is to be played back can be 
specified either on the Marking tab in the item Properties window or using the Crossfade editor.  

Items like Pause or Microphone pause can always have their duration specified explicitly on the 
General tab. 
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A detailed description of all tabs that the item Properties window can have and of all parameters 
these tabs contain is given in Section 4.10.1. 

Note that when the audio file that is referenced by a schedule item is physically changed (the 
program detects this by the changes in the file's modification date and its size), the contents of the 
schedule item will be refreshed with some of the metadata read from the file. The markers and the level 
setting made for this schedule item earlier (on the Marking tab of the item Properties window) will be 
cleared, as then may not correspond to the new contents of the file; their new values will be taken directly 
from the file. The descriptive fields (the title, author, etc.) will be preserved, as they are not directly linked 
to the file's physical contents. Changing an item's duration causes a recalculation of the airing time of the 
items going after the modified item. The delay between the time a file was modified and the time the 
changes are reflected in the schedule depends 
on the number of items in the schedule and on how loaded the system is, and ranges from a few seconds 
to a few minutes. The visible schedule items are refreshed quicker: with the system operating normally, 
they are refreshed no later than within a minute after the file was modified, 10 to 20 seconds being the 
average time. 

Also note that a user may be denied the rights to edit audio item properties by the administration 
system. In this case, the Properties window can be opened but the OK button is disabled, thus making it 
impossible to save the editing results. 

Automatic Update from the MDB 
There is an indirect method to edit item properties by automatically refreshing them from the MDB. This 
method of item properties editing requires an MDB be installed in the system. This method can be used, 
for example, to work with the news items. 

Blank items are added to the news blocks from the MDB. These are prepared beforehand by the 
chief editor. These are items that do not reference any files yet but already created in some sections of 
the MDB. Usually, these items have only the title set, although any item properties may be preset. The 
chief editor may place these items into the personal categories of the editors responsible for the contents 
of the given items. Then the blank items are added to the schedule manually or imported using the DB ID 
link. These items store a unique MDB identifier — DB ID — in the schedule pointing to the source item in 
the data base. During the broadcast process, the news editors fill the blank items with real content. The 
personnel doing the editing do not resort to using the schedule. The editing is carried out directly from the 
MDB using an MDB module. This can also be done from the DJin program and from the BCS Editor, 
which can also have an MDB module. The editor prepares the contents of an item editing the audio 
himself (this can be done only in the BCS Editor). Using the DJin program or the BCS Editor, the editor 
can also specify the audio file containing the necessary information, fill up the descriptive fields, and 
perform other required operations, after which the item is saved in the MDB. After the state of the item in 
the MDB changes, the system automatically refreshes all schedule items referencing via a DB ID the 
modified item. The advantages of this editing system are the following: 

• To edit an item, the editor does not access the schedule and his attention is concentrated only 
on those items that he has to prepare (e.g., only those that are located in the personal MDB 
category). 

• If there are more than one copies of an item in the schedule, all copies are guaranteed to be 
refreshed without having to look for and edit each copy manually. 

The drawback is the delay between the time an item is changed in the MDB and the time the 
changes are updated in the schedule. An item lying within 30 minutes from the broadcasting point is 
guaranteed to be refreshed in the schedule within 30 seconds after it was changed in the MDB. It takes 
several minutes to update items lying beyond the 30-minute zone.  

The system of the automatic item update from the MDB is configured on the Update from DB tab of 
the DIGISPOT® II system Global settings window.  
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Rotated Items 
Rotated items are most often used when creating skeletons. Working with the rotated items takes place in 
two stages. During the first stage, the rotated items are placed in the skeleton with the type of the material 
and the source MDB category specified. During the schedule preparation stage, rotation is performed and 
in place of the rotated items in the schedule are placed the actual audio items from the corresponding 
MDB category. Most often, rotated items are used to place jingles into skeletons. 

Rotated items are added to a skeleton or a schedule from the Rotation tools toolbar by clicking 
button . Adding a rotated item opens the Rotated item properties window. 

The item type is selected from the Type dropdown list, and from the Category dropdown list 
selected is the category defining the collection of the rotated items. Category duration and Item 
duration fields allow operating the duration of rotating item and set it equal to medium duration in the 
category. 

Clicking the OK button adds the item to the skeleton or the schedule. 
 

 

Fig.4.21. The Rotated item Properties window 

This window also opens when calling the properties window for an existing item. 

Items are rotated, that is, replaced with the actual audio items, by clicking button . For the 
replacement, the item that has not been aired the longest is selected from the specified MDB category. In 
other words, the items in the category are cycled. After such substitution of real contents the item ceases 
to be rotated one. 

There is an opportunity to save changes of item properties of the schedule not only in the schedule, 
but also in MDB. For this purpose it is necessary to mark the corresponding parameter in Properties 
window of the Schedule module. It is not recommended to apply this function without absolute necessity. 

4.4.6. Controlling Item Contents 

Prefade Listen 
To control the contents of audio items, there needs to be a way to listen to them without the sound going 
to the program's main output. This task is addressed by the prefade listen system. A detailed description 
of the prefade listen system in given in Section 4.9.1. An item or a crossfade between items can be 
prelistened. 

An item can be prelistened either by selecting the PFL command in the schedule context menu, by 
pressing the keyboard key assigned to this action (the spacebar by default), or  by pressing button  on 
the Item tools toolbar. 

If in settings of the program for parameter Service > Settings> Other> Schedule > On double 
click PFL value is established (this parameter affects also for work of the Skeleton Wizard module, to 
listen an item is possible on double click. 
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A crossfade between items can be prelistened by selecting the PFL crossfade item of the context 
menu and clicking button  on the Schedule tools toolbar, or by clicking the assigned hotkey (<C> by 
default). 

An audio item (not a crossfade) can be prelistened in the following two ways: 
• The PFL window for prelistening of the beginning of an audio item is opened by pressing 

<Ctrl>+<Space> key combination. If the user does not interfere into the playback process, the 
playback window will close after 
5 seconds of the playback. 

• The PFL window for prelistening of the end of an audio item is opened by pressing 
<Shift>+<Space> key combination. The playback of the last 5 seconds of the audio item starts. 
If the user does not interfere into the playback process, the playback window will close after the 
playback ends. 

Text Preview  
If the item selected when the spacebar was pressed is a text item in the schedule or in some other 
module (references a text file or a subject file), the Text preview window opens instead of the PFL 
window. 

The name of the item is shown in the upper left part of the window; in the upper right part shown is 
the approximate time necessary to read the text.  

The text in the window can be printed out using the context menu. 
The text font is selected by executing the Service > Settings > Text > Fonts menu sequence. 

 

Fig. 4.22. The Text preview window 

When displaying an RTF file, its text is reduced to the specified font with all specified in the file 
formatting (font type, size, etc.) ignored. 
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The Text preview window is closed by pressing either the <Esc> or <Enter> key. 

4.4.7. Decking Out a Schedule 
Many commands accessible from the schedule context menu are intended for decking out the schedule. 
By decking out, meant is the final editing of the schedule contents and improving the overall quality of the 
schedule reproduction. At this stage, cross-fades are created, the starting points of audio items are 
modified, voice tracks are recorded, etc. 

All just described operations can be applied to the items located in a schedule and to the items held 
in the reproduction queues of players (such as the Block Player and the X-Player).  

Crossfades, voice track recording, and start point changes (any item parameter changes in general) 
can be performed directly in front of the item already being played back. For example, a new item can be 
spliced to the one being currently played. If an item is edited in the schedule (and not in the player 
queue), the changes will be taken into account by the player even if the modified items are already in its 
playback queue (X-Player). Consequently, a schedule can be expeditiously edited when it is being aired, 
and not only from the broadcasting but from another workstation. The Block Player does not take into 
account schedule changes to the already-queued audio items, but it can have the queued items edited 
directly in the queue. Detailed descriptions of editing player queues are given in the descriptions of the 
specific players. 

The operations of putting finishing touches to a schedule can be started only after the sequence of 
the audio items in the blocks has been distinctly defined. This is due to the fact that moving around 
schedule audio items, for which the crossfade parameters have already been defined or between which a 
voice track has already been inserted, may lead to undesirable changes in the way the transitions 
between audio items sound. 

Note that a crossfade can be made or a voice track recorded between blocks, that is, between the 
last audio item of the previous block and the first audio item of the next one. Presence of non-audio Info 
items between crossfaded audio items does not affect inserting a crossfade or recording a voice track.  

A crossfade without audio control during the insertion can be performed by calling the Set group 
crossfade command in the schedule context menu. Calling this command opens the window in which a 
single parameter — the crossfade duration — needs to be specified. This will add a crossfade of the 
specified duration between all audio items selected when the command was called and the following 
them item. 

4.4.8. Editing Crossfades. The Crossfade Editing Module 
A special module similar to the limited BSC-Editor is used now as the Crossfade Editing module.  

The crossfade editor is called by selecting the Crossfade or Crossfade 3 commands from the 
schedule context menu, after that special window is opened. The first command opens for editing 
crossfades between two or three items. The second command always opens for editing three items: the 
audio items preceding the selected item, the selected item, and the item following the selected item. 
There can be Info type items between the items to be edited but they do not affect calling the editor. The 
crossfade editor window is shown in Fig. 4.23. 
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Fig. 4.23. The crossfade editor 

Calling the crossfade editor by selecting the Crossfade command opens three items if the selected 
item is a jingle or a voice track. This is due to the fact that these items usually are relatively short. 
Therefore, it is more convenient to splice three items at once: the one preceding the jingle, the jingle, and 
the item following the jingle. 

The items in the crossfade editor are shown in separate lines, each following item lying below the 
preceding. A waveform is displayed for each of the items showing graphically the level of the item's 
signal. The left channel signal level 
is shown in the upper part of the track; the right channel signal is shown in the lower part. Each item has 
a frame with four points on them; moving these points with the mouse modifies certain parameters of the 
item. The frame of the active item (in particular, those one, for which in the moment indications of level 

indicator are valid) is selected by left-clicking of  buttons within their frame area. 
The simplest case of crossfade editing is done by dragging one of the items being spliced to 

overlap the spliced items in time (the X-axis). In this way the position of the Start Next point for the upper 
item of the pair is defined. 
In general, the following item parameters of the items opened in the editor can be changed: 

• The playback starting point (the Start mark) 
• The playback ending point (the Stop mark) 
• The Fade in 
• The Fade out 
• The playback starting point of the next item (the Start Next mark) 
• The playback starting point at the transition from other item on Start Next point (Start This)  
• The playback level of the audio item 
• The playback level-regulating with the rubber line 
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Any part of the crossfade can be prelistened to from any position by double-clicking anywhere on 
any of the tracks. The playback will start from the point of the click. The playback is stopped by a single 
left click on any of the tracks. The playback of the tracks can be controlled by the S and M buttons (Solo 
and Mute, respectively) located in the left part of the track. Pressing the M button removes the given track 
from the playback; clicking the S button plays back only the given track. The S button can be pressed 
only on one track. The button states can be switched during the playback. 

Scrolling and drugging of audio items are carried out using the mouse (the mouse moving at the 
pressed and hold left key). Scrolling and dragging at splicing two or three items are under the following 
general rules: 

• Dragging any audio item, except for the first one on top, by the top half of signal waveform (i.e. 
capture of audio item in area, limited by its envelope from above and a "zero" line) leads to 
reduction or increase of overlapping time of dragged and located above audio item; 

• Dragging any audio item, except for the lowermost one, "grasps" all audio items located below, 
simply moving all "picture" on the screen; at such dragging overlapping times of selected audio 
item all of them located below, do not change. For the lowermost audio item this rule is carried 
out only if capture is made by the bottom half of signal waveform (i.e. by the area limited signal 
waveform by its envelope from below and a "zero" line); 

• Dragging of an “empty place” (a place which are taking place behind borders of all signal 
waveform’s envelopes) not depending on its location leads to scrolling "picture" on the screen. 

Note that it is impossible to move an item in such a way as to create a gap between the items, that 
is, a gap between the end of the previous item and the beginning of the next one. 

A fade editing is carried out using the mouse; for this purpose you need to “grasp” and move upper 
nodes of the signal waveform frame. An example of editing a fade in using the mouse is shown in Fig. 
4.24. 

 

 

Fig. 4.24. Editing a fade in 

The level is regulated by using the combined level indicator/regulator located in the left part of the 
main program window. 

At playing audio items selected using the  button, the indicator displays a level of the left and right 
channels in dB (if there is no track with selected Solo mode, all tracks for  which Mute is not switched on 
are played back, but the indicator displays only the level of one of them). At the playback switched off, the 
dark blue toddler allows to choose sound amplification gain for entire track. Double click on the bottom 
area of the level indicator (on the window segment in which numerical values of amplification gain are 
displayed) resets all changes. Level adjustment can be made separately for the left and right channels. 
For adjustment of one of channels locate the mouse cursor not on the center of a regulator, but 
on its left or right part (the part where the level is displayed and in which the adjustment slider of 
corresponding channel is located) and press the left key of the mouse. Dragging the mouse causes level 
adjustment only of one channel. 
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Editing the signal level using the rubber line is done as follows. 
• Click button  on the Draw level toolbar. This button enables the rubber line editing mode. 

 

Fig. 4.25. The Draw level toolbar 

• Then click button  adjacent to it. This button enables the node-placing mode. In this mode, 
clicking the left mouse button on the track places 
a node where the click was made. 

• Place the necessary number of nodes on the line. 
• The node-placing mode is exited by clicking button  again or by right-clicking anywhere on the 

track. 
• Then the nodes on the level curve are moved to obtain the desirable configuration of the signal 

change in time. The nodes are moved by moving the mouse cursor over the node and holding 
the left mouse button pressed and dragging the node. Moving the nodes up or down changes 
the gain factor at the given node with the current factor being shown in the information window 
next to the point. Dragging the node to left or right moves the node relative to the item, changing 
its position in time. Releasing the left button fixes the node's new position. Clicking the right 
mouse button while holding the left button pressed cancels the node's move, its position 
remaining at the starting point.  

A section of the curve can be also moved between two nodes. For this, the mouse pointer is placed 
over the curve section to be moved (the green line) and is dragged in the same way as a node. 

An example of the waveform editing by dragging nodes is shown in Fig. 4.26. The green line 
depicts the graph of the gain factor changes in time. The red dots are the level nodes. 

The nodes between the green and red markers can be deleted by clicking button  on the Draw 
level toolbar; all nodes on the track can be deleted by clicking button .  

Clicking button  again closes the level curve editing mode. The track level change graph will still 
be depicted by the green line but the line no longer can be edited. 

The image scale can be changed using the Scale toolbar (Fig. 4.27). The toolbar has several 
groups of buttons. The first group serves to set the size of the view zone to 10, 20, 30, and 60 seconds. 
The All button sets such scale that all edited item can be seen entirely. 

 

 

Fig.4.26. Rubber line 

 

Fig. 4.27. The Scale toolbar 
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Button  zooms the scale in by 1/4 of the current scale; button  zooms the scale out by 1/4 of the 
current scale. 

Buttons  serve to specify the reference point for the scaling operations. It has two positions. 
When the first button is pressed, the reference point is set at the center of the screen; the right button 
sets the reference point to the left side of the screen. 

The following three buttons 1, 2 and 1+2 are used the crossfade to be viewed. Pressing of the 
button 1 changes the point of viewing and the scale in such a way that entire fist crossfade are placed 
onto the screen.  The 2 button allows viewing the second crossfade (in a case if three items are opened). 
And the button 1 + 2 sets such scale that both crossfades fit onto the screen. If one of these buttons 
remains pressed, it redefines the reference point by scaling. In this case, the scaling center can be the 
center of one of the crossfades or the central point between two crossfades. 

The M button enables the scale memorization mode. If a button was depressed, the program 
remembers the scale of the image when saving the crossfade, and when the next crossfade is opened, 
the analogous scale is set. If no button was pressed before exiting, the scale specified in the Service > 
Settings > Other > Audio Editor > Crossfade editor > Scale settings will be set for the next crossfade 
opened. Additional window showing the current playback speed, can be also referred to parameters of 
displaying. 

Crossfade editing is finished with saving the changes in the schedule by clicking the OK button in 
the lower left corner of the program window. Clicking the Cancel button ends the crossfade editing 
without saving the changes. 

Note that when working with the crossfade editor, the control over the broadcasting program is 
retained from the console faders to the buttons of the external control consoles connected via RS232 or 
USB.  

Autoglueing (Auto crossfade) 
Command Auto glue marking is implemented for simplification of schedule editing; this command 

is called from the context menu of the Schedule module. This command opens auxiliary window 
Autoglue settings where the following parameters can be set: 

• Normalize - normalizes the audio items selected for autoglueing. 
• Cut edges – cuts off the edges of audio items if sound level less than the input specified in a 

field. 
• Autoglue – autoglueing is carried out when this parameter is chosen. 

By default for all mentioned above parameters the module receives values from settings of 
DIGISPOT® II system; it is possible to change them in Service menu - Global settings - Other - Audio 
files marking (more detailed these settings are described in section 4.12.2). 

4.4.9. The Schedule Audio Item Edit Module 
Schedule audio items, as well as subjects, are edited using the BCS Editor program, which is called from 
the DJin program.  

To start editing an item, select the Edit selected item from the schedule context menu. All 
functions of the BCS Editor program are available for editing schedule items and the contents of the 
selected item can be edited as desired. Other files can be added to the project that was created when the 
item was opened. The audio can be processed using DirectX plug-ins.  

The results are saved in the schedule in place of the source item as a project file. Editing can be 
continued when the editor is called again. For example, if at the first editing a jingle was placed on the 
auxiliary track, when the item is opened for editing again, the capability to work with several audio tracks 
remains and the jingle can be moved to another place. 

More detailed information about the BCS Editor operation can be found in the dedicated manual. 
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4.4.10. The Search for Start Point Module 
The Search for start point module is another module that allows the sequence 
of audio items to be changed. Its only function is finding the point, from which the playback of the audio 
item will begin when broadcasting the schedule. Changing this point allows the duration of an audio item 
to be changed, by skipping, for example, the Intro zone. An easy method allowing the needed place in 
the audio item to be located is used to search for the start point: by ear, using the keyboard or an outside 
button field to control the process. 

The module allows the start point to be positioned on one of the three positions prepared 
beforehand (Intro) or to be searched for by ear varying the speed and changing the direction of the 
playback to help the process. To facilitate the search, the item's signal waveform is displayed in the 
module's window. 

The start point of the audio item stored in the schedule or preloaded into a player can be changed. 
This function is used most often by operators to change the Intro duration for musical audio items while 
on the air. 

The module is accessed through the Search for start point window 
(Fig. 4.28). 

 

 

Fig. 4.28. The Search for start point window 

This window can be opened in one of the following three ways: 
• By executing the Search for start point command, which can be found in the context menus of 

the Schedule, X Player, and Block player windows.  

• By button  located on the toolbars of the program's main window and the X Player window. 
• By the <X> hotkey on the computer keyboard. 

The Start point serves to determine the position, at which the playback starts in the player. 
Here you may as a natural question: why is another starting point needed when there already is one 

starting point — Start? 
The Start and Stop markers of an audio item define the audio part of the item once and for all; they 

are placed by the musical editor when adding the new audio item to the musical database. These points 
make it possible to avoid editing audio items in order to remove silence gaps, clicks, noises, or very long 
low levels in the Intro or Outro of audio items. Once defined, these points never change. 

The Start point is set by the broadcasting operator for a specific audio item to start it playback from 
a point other than the start of the audio item itself. There can be several reasons for this: not enough time 
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before the next time control point, wishing to skip Intro, etc. Because this problem arises during 
broadcasting, when the operator has very little free time, the tool to find the start point must be capable of 
doing it rapidly.  

The Search for start point module provides an easy method to find the start point by ear and also 
displays in its window the waveform of the audio item 
to visually control its contents. Among the marks placed on audio items already, there is a group of marks 
used to mark the beginning of audio items: the Intro mark group. These marks are usually placed in 
some meaningful positions at the beginning of audio items: the conclusion of the introductory part, the 
start of the main part, the start of the vocals, and the change in the rhythm. Such marks may turn out to 
be very useful for finding the new start point rapidly; therefore, they are displayed in the module's window. 

The start point can be rapidly moved to one of the set Intro points using buttons i1, i2, and i3. 
The search is facilitated by the original search algorithm that employs playing the audio item with 

varying speed. The process of searching for and fixing the point is controlled by only a few hotkeys on the 
keyboard or an external button field. 

Let's consider the search process. Right after the Search for start point window is opened; the 
playback of the audio item is started from the current playback start point or from the start of the audio 
item, if there is no playback start point. If the playback start point is located far from the presumptive 
position of the new start point, the operator increases the playback speed. In the area of the supposed 
start, the operator decreased the speed in order to determine the position more exactly and stops the 
playback. At this moment the stop position, let's call it the tentative position, is fixed. The operator can 
start the audio item from this position with the normal speed, having verified the point found. Should it be 
necessary, additional search is conducted in the area of the tentative position in order to be able to do the 
reverse playback.  

The user cannot change the hotkeys on the PC keyboard (Fig. 4.29), they are chosen based on the 
considerations of convenient one-hand operation.  

 

 

Fig. 4.29. The part of the PC keyboard used to control the search 

Let's consider the functions of the keyboard keys. 

• While the right or left arrow key ( ) is kept down, the playback 
is conducted with the current speed in the corresponding direction. Releasing the key stops the 
playback and sets a tentative position at the point the playback was stopped. Pressing the 
opposite key while holding down the previous one changes the playback direction without fixing 
the tentative position. 

• Pressing and holding the up or down key ( ) changes the playback speed. The playback 
speed can be changed during the playback. Pressing both keys at the same time sets the 
normal playback speed. 

• Pressing the zero key ( ) during the playback stops the playback without fixing the 
tentative position (or changing the previous one). Pressing this key when the playback is 
stopped starts it at the normal speed from the tentative position. 
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• Pressing the period key ( ) during playback is analogous to pressing the zero key and stops 
the playback without changing the supposed position. Pressing this key with the playback 
stopped sets the tentative position point at this point. 

Size of the visible
area

Current
speed

Playback control

Moving the tentative position to the specified point
and starting the playback from it.
Previous point — moving to the old start point, which was set
before opening the window.
i1, i2, i3 — move to one of the Intro points

Positions:
Start point: the tentative position
Position: the playback position
Remainder: from the playback position to the end

 

Fig. 4.30. Functions of the Search for start point window controls 

Tentative position Playback start/end position

Red triangle is the
old start point Graphical depiction of the set Intro

points (the blue stripes)

 

Fig. 4.31. Displaying information in the Search for start point window 
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• Pressing the OK button or the <Enter> key closes the window and sets the start point for the 
given audio item at the tentative position. Pressing the <Cancel> button or the <Esc> key simply 
closes the window without changing the start point. 

The buttons located in the window duplicate the functions of the keyboard keys. Their functions are 
obvious from the labels and should it become necessary can be verified experimentally: Press the 
mentioned keys one after another and observe the reaction of the virtual buttons. In addition, the 
functions of the Search for start point window are explained in Fig. 4.30 and Fig. 4.31. 

The settings that control this module's operation can be found under item Search for start point in 
the Audio files marking category on the Other tab 
of the Settings window. These are the following: 

• Algorithm is one of the several ways to control the playback. The algorithm described 
previously is algorithm 3 used by default. The algorithms differ in their reactions to pressing the 
control keys and buttons. 

• The Minimal and Maximal speeds are the upper and the lower boundaries of the playback 
speed relative to the conventional speed unit, which is taken to be the normal playback speed.  

• The acceleration time From minimal to nominal speed and the acceleration time From 
nominal to maximum speed is the time 
in milliseconds it takes the playback speed to change between the lower and upper speed 
boundaries. It defines the sensitivity of the playback speed control keys.  

4.4.11. Voice Tracks Record Module in the Schedule 
Usually the DJ puts in a few words when the transition between two audio items is taking place. First, this 
helps the user to recognize the station and, second, allows to break up the monotony of the automatic 
broadcasting. Moreover, the DJ maintains a certain mood in his individual listeners, the feeling that the 
broadcasting is addressed to them personally.  

Some stations strictly regulate DJ's goings on the air regarding their duration and number; on other 
stations, this control is not so strict, but every station always has some level of such control. Working live 
on the air demands from the DJ to be concentrated and his actions well coordinated because a mistake 
made 
on the air cannot be remedied. Far from all DJs can simultaneously carry a conversation with the listeners 
and observe the time of their going on the air, control its duration, analyze the information about the Intro 
lengths and the positions of the faders, and so on. This often necessitates advance recording of DJs talks 
and their basic editing. 

The Voice track recording module is the tool for recording voice tracks in advance with a capability 
to subsequently replay and edit the result including replacing unsatisfactory attempts with a new 
recording.  

Using this module, the DJ can record his talk that is to be delivered between two audio items right 
during the broadcasting shortly before playing it. This recording can also be done beforehand on one of 
the scheduling workstations. The circumstance that he does not have to give his talk live on the air takes 
the psychological pressure off the DJ and allows him to concentrate on the contents 
of the talk and the articulation. Being able to repeat track recording allows several attempts to be made 
and the best result selected. After the recording is prelistened, it is saved in the schedule as is or can be 
further edited using the crossfade editing module. 

The Voice track module is most convenient to use in conjunction with a virtual mixer. One of the 
faders controls the fade out of the first audio item, and the other controls the fade in of the following 
audio item. The following audio item is launched at the fader start signal from the fader, so the recording 
process is practically no different than controlling the playback during broadcasting. The external fader-
movement sensors allow the DJ to control fade ins and fade outs of audio items, smoothly lowering and 
raising their sound levels. The program remembers the movements made by the faders and will 
reproduce them on the air, creating the impression of a live DJ at work. 
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Places in the schedule where voice tracks need to be recorded can be marked beforehand with 
special marks. Afterwards, all specified voice tracks can be recorded one after another. 

Let's consider a typical sequence of operations when recording a voice track. 
• The DJ starts the playback of the first of the two audio items, between which he wants to insert 

the voice track. The playback of the first audio item is started shortly before its end. 
• Sometime later, the DJ lowers the level of the audio item, turns on the recording, and starts his 

talk. At any moment, he can stop the first audio item or start the other one. The playback of the 
second audio item is usually started at a low level. Having finished recording the voice track, the 
DJ raises the level of the second audio item to the normal level and finishes the voice track 
recording by stopping the second audio item. Then he listens to the result and decides whether 
the recorded material is suitable to be aired. 

From the start, the DIGISPOT® II DJin recording process was designed to use special remote 
control blocks that can send the information about the fader movements to the program. The block has 
two faders: 

• Fader №1 regulates the level of the first audio item, played using the first playback device. 
• Fader №2 regulates the level of the second audio item, played using the second playback 

device. 

The program receives the information about the fader movements and synchronously changes the 
playback level on the corresponding output. This creates the impression of the DJ moving the handles of 
real faders. The fader movements are memorized and, after the voice track recording is successfully 
completed, saved in the schedule items corresponding to the first and second audio items as a “rubber 
line” (an amplitude envelope). 

The signal from the DJ's microphone is input to the recording device and when the recording is 
turned on, the actual voice track is recorded from it. The level of the recorded signal is not regulated 
because there is no need for this. The signals from the playback channels are combined (in the audio 
card, if it has this capability or by some device or a console, if these are separate physical outputs) and 
the combined signal are input to the operator's headphones. The Start next point for the first audio item 
is defined by the starting point of the recording. The Start next point for the newly-created voice track is 
defined by the starting playback point of the second audio item. 

In this way, a three-item sequence is formed in the schedule, for each of which the playback level 
control information and the information about the playback starting moment of the next item is stored in 
the schedule. When played back in any player that can play a sequence of audio items (the double A-B 
Player, the X Player, the Block player), this sequence will sound exactly the way it did when the voice 
track was recorded. This creates the effect of the DJ's being live on the air at this moment, when in fact 
the program is broadcasting in the fully automatic mode. For example, on Germany's Hit Radio RTL, the 
DJ invited especially for this task, talks up all the content necessary for a 24-hour period broadcasting in 
two hours.  

NOTE 
The settings of the Voice track recording module are set in the Voice track section on the Other tab of the Settings window and 
described in detail in Section 4.12.1. 

The process of recording a voice track is illustrated by the diagrams in Fig. 4.32. 
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Fig. 4.32. The nature of the changes in the signal gain factors when recording a voice track 

After the playback of audio item 1 starts, the operator can lower its playback level by pressing a 
special key to the level set by the Middle level parameter. The result is the fade shown first on the left of 
the diagram for audio item 1. 

When the second key is pressed, the playback level is lowered to the starting, inaudible, level (the 
second fade). This level is specified by the Start fade-in from… parameter in the Voice track section on 
the Other tab of the Settings window (see Section 4.12.1). 

After this, the signal level jumps down to the negative infinity (in dB) (or down 0 in a form of 
amplification gain) level, but at this level it is no longer heard. 

The operator can start lowering the signal to the inaudibility level at once by pressing this key first. 
In the diagram, this is depicted by the first slanted line on the left. In this case, the level is immediately 
smoothly lowered from 0 dB to the inaudibility level at the specified speed. 

The fade in of the second audio item can be controlled analogously, but only in the reverse order.  
A voice track is recorded from the Record voice track window (Fig. 4.33), which is called by the 

same name command of the Schedule window context menu. As a result appears the window shown on 
Fig. 4.33. 

The speed, with which the program automatically adjusts the level, is set in the Voice track section 
on the Other tab in the settings Fast fade (F) (dB/sec), Medium fade (M) (db/sec), and Slow fade (S) 
(db/sec) as the rate of the level change in dB/sec. In the Record voice track window, the mode is 
indicated by letters F, M, and S (Fast, Medium, and Slow, respectively). 

There is an opportunity of the warning that there are several seconds/minutes remain up to the 
starting of a speech track. The given time interval is adjusted in the same place, in the Service menu - 
Settings on the tab Other – the group of parameters Voice Track. For setting of warnings it is necessary 
to replace value of parameter Notify if Voice track should be OnAir in less than (sec). By default the 
parameter is equal to 0, which is equivalent to absence of warnings. 
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Fig. 4.33. The functions of the Voice track recording window controls 

The voice track recording can be controlled by the hotkeys on the number pad of the computer 
keyboard (with <Num Lock> on). In the legends in Fig. 4.33, these hotkeys are shown in brackets. Their 
functions are as follows: 

• <7>. If the first audio item is not playing, start playing it. If it is playing, then gradually lower the 
audio item level to the intermediate level.  

• <8>. If the first audio item is not playing, start playing it. If it is playing, then gradually lower the 
audio item level to the threshold of inaudibility level. 

• <9>. Start or stop the playback of the previous audio item without fades. 
• <4> (←). Move the starting point of the first audio item left by the value specified in the settings. 
• <5>. Start/stop recording.  
• <6> (→). Move the starting point of the first audio item to the right. 
• <1>.  Start playing back the second audio item at the medium level, fading it in. 
• <2>. Start playing the second audio item at the nominal 0 dB level, fading it in. If the item is 

already playing but its level is not 0 dB, fading it up to 0 dB. 



Cooperation for Development of Hard-and Software 
for Audio and Video Broadcast Studios in East and 
West Europe. Design and Manufacturing of Studio 
Equipment  for the Audio recording Industry and the 

 

 
e.mail: info@tract.ru   e.mail : infor@barthkg.com  
 web :http//www.tract.ru   web : http://www.barthkg.com 
 

    

 

copyright: RBKG&TRC  Page 79 of 219 

in field of Video Postproduction. 

• <3>. If the second audio item is not playing, start the playback at the nominal level without 
fades; if it is already playing, complete the voice track recording. 

• <Ins>. Select the fade rate for the first fader. Cycles the F, M, and S buttons. 
• <Del>. Select the fade rate for the second fader. Cycles the F, M, and S buttons. 

The three-dot button  (see Fig. 4.33) opens the Indicator settings configuration window (Fig. 
4.34). 

 

 

Fig. 4.34. The Indicator settings window 

Purpose of settings is clear from legends in this window and does not need explanation. 

NOTE 

Remember, that if while saving of a speech track, the previous item of the schedule is already being played back, 
the recorded track will be automatically loaded in a player. If less than 10 seconds is left before airing of the 
recorded speech track, the Record module gives out the message on impossibility of saving it. 

 

 

 

 

 

4.5. Configuring the Skeleton Wizard and the Schedule Modules 
The main settings affecting the operation of the modules are configured in the Properties window. This 

window is opened by clicking the  button and then selecting the Properties command in the service 
menu that opens. The window's appearance and the set of parameters accessed from it do not depend 
on the module type. The Properties window is shown in Fig. 4.35. 
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Fig. 4.35. The Properties window 

• Color of played block. Indicates the color, in which the title of a completely played back block 
is shown in the schedule.  

• Color of unplayed block. Indicates the color, in which the title of a block that has not been 
played back is shown in the schedule. As you remember, a block is considered played back if all 
of its audio items have the Aired flag set. 

• Color of block with items without files. Indicates the color, in which the title of a block that 
hasn’t elements. 

• Block types. This list defines the type of blocks that are shown in the module window by 
default. 

• Path to schedule. The main parameter of the Schedule module. Defines the schedule to be 
shown in the module. As you remember, schedules are created from the Schedules tab of the 
Global settings window. 

• Border. Defines the width of Schedule window frame. 
• Show name – this flag allows displaying the additional line with the specified name on module 

title. It can be useful at work with the several schedule modules adjusted for work with various 
schedules. 

• Show mode selection button – setting of this flag calls the keyboard with buttons of types of 
displayed blocks selecting and so on in the top of the window of module. 
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• Show block header and Show block footer – switch on the displaying of header and footer 
lines of blocks correspondingly in the schedule. By default they are set. These flags are dumped 
usually for the module of the schedule on the airing workstation that allows to simplify displaying 
of the schedule and to increase the vertical empty space assigned for information on items. 

• Hide headers and footers for typeless blocks - allows to exclude displaying of header and 
footer lines of blocks for no-types blocks (displayed as B). 

• Load next schedule when day change - the given parameter allows loading of the new 
schedule when a new day begins. 

• Open all blocks after schedule load, Update items on change in the database - the sense 
of parameters is obvious from the name and does not need to be explaned. 

• Ask confirmation before deleting item- this parameter initiates warning window at attempt to 
remove the schedule item or skeleton. Presence of such warning can prevent casual removal of 
necessary items. 

• Edit DB item instead of schedule item- this parameter allows saving of the information in the 
schedule or in MBD element. 

In the given window there is only a part of the parameters affecting to work of modules. 
Fonts setting used for display of schedule items is made in setting fonts list window called from list 

setting window. 
The group of settings Block transferring setup, containing parameters of schedule segments 

sending to regional radio stations, additionally includes the following parameters: 
• This schedule can send blocks to regional schedule - this is the parameter including sending 

of the schedule to regional partners (this parameter automatically puts radio station to which it is 
set, in the head of hierarchy of broadcasting network). 

• This schedule can receive blocks from main schedule- the sense of parameter is obvious 
from the name. In contrast to previous, this parameter unambiguously determines a role of radio 
station on which it is established as regional partner of the central studio. 

• The button Settings calls the Send block settings window where paths to schedules of 
regional stations are specified. It is possible there to set the automatic sending of blocks of 
regional radio station (parameter Send block automatically) and parameters of regional blocks 
rerecording if it has been changed (Overwrite regional block if it was modified parameter). 
Note, that at setting of automatic sending the schedule to regional radio station, its sending is 
initiated at once. Repeated sending will be called each time at opening the schedule. 

Separate parameters of modules can be set in sections Schedule and Skeletons, placed on the 
tab Service > Settings >Other. 

4.6. Working with Players 
Audio items are played back using virtual playback devices: players. Broadcasting blocks and individual 
audio items are automatically loaded into players according to the schedule or by the broadcasting 
operator directly from the schedule or from other system modules, such as Files, F-Categories, and 
MDB. 

Depending on the type of the audio card used, each player can be associated with an individual 
physical output of the broadcasting station, or several players can be mixed into one output. 

The following actions can be performed on audio items in the player window: prefade listening, 
crossfade editing and marking, deleting from the player.  

Players can interact with connected to them external devices via the general-purpose interface. For 
example, they can receive control signals from a specialized keyboard to perform playback, open mixer 
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console channels, receive start signals from the fader start controller, and issue signals to external 
indicators.  

Players can be configured in various ways: going to the next audio item enabled or disabled, 
deleting an audio item after the playback enabled or disabled, and the like. 

Playback can be configured to always start from the first or from the current (selected) audio item. 
Settings to block playback can made. Colors and fonts can be customized.  

4.7. Player Modules 

4.7.1. The Block Player 
The block player is used to play short sequences of audio items (play lists). Only one playback device is 
used for the playback with the crossfades between the items taken into account. A play list is in essence 
one schedule block. All schedule editing methods applicable to audio items (crossfade, marking, 
normalization, switching to the next, voice track recording, etc.) are also applicable to the contents of the 
Block player. 

Play lists can be loaded into the player automatically from schedule blocks or be formed manually 
by the operator. A combined approach is also possible. In this case, only that portion of the material that 
is mandatory to be aired is specified in the schedule. The operator then decks out the airing of this 
material by adding his own audio items and jingles from such sources as the database, the jingle 
machine, and the F-Categories and Files windows. 

The player can be controlled from the broadcasting console by the Fader Start and PFL (Cue) 
signals. 

The player can be configured to automatically start the playback or be controlled by the operator. 
Usually, the system has several block players, each of which has a specific function. 

Functions of the Block Player Window Controls 
A screenshot of the block player window is shown in Fig. 4.36. 

The player's header (Music in the instant case) is located in the upper left part of the window. The 
header can be changed in the Player properties window. On the right in the same line, there is a field, in 
which the total duration of the audio items loaded into the player is displayed. 

 

 

Fig. 4.36. The block player window 

The player control buttons are located under the header. Descriptions of their functions follow. 
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 Playback. Starts the playback of an audio item. Either the first audio item in the list or the 
highlighted audio item can be started. The item that 
is actually launched is specified in the Player properties window. 

 Stop. Stops the playback. 

 Pause. Pauses the playback. Pressing the button again resumes the playback from the point 
where it was paused.  

 Next Item. Stops the playback of the current audio item and starts the playback of the next 
audio item in the list. 

 Auto next enable. The green color indicates that the next item will be automatically played 
back after the current audio item finishes. The red color means the playback will stop after the current 
audio item finishes. 

 Auto delete. Enables automatic deletion of the audio item from the player after it was played 
back. The red cross means auto delete is enabled. 

 PFL. Used to prelisten the audio item in the player window. Either the next audio item or the 
highlighted audio item can be prelistened. This mode is set in the Player properties window. 

NOTE 
The prelisten algorithm employed depends on whether the system is equipped with remote control. If it is, then the 
program can receive the signal regarding the state (open/closed) of that console channel, to which the physical 
output of the broadcasting station is routed. The prelisten is possible only if the fader for the given channel is 
closed; otherwise, the button is disabled. If the system is not equipped with remote control, a separate physical 
channel needs to be organized for prelistening audio items. This can be done using, for example, a multimedia 
Sound Blaster audio card. Pressing the Playback button during the prelisten disables the prelisten mode and the 
audio item is continued to be played back with the open fader (i.e., the playback start picks up where the prelisten 
leaves off). Pressing the Stop button during the prelisten stops the prelisten playback and disables the prelisten 
mode. 

Audio items are placed in the player in the form of a list. The list defines the playback order of the 
audio items. The number of the audio items that can be loaded into the player is not limited. If the number 
of items in the list is too large to fit in the list window, a scroll bar appears to help displaying it. In addition 
to audio items, the list can hold special schedule items: commands Stop and Pause (Pause is a 
scheduled gap in broadcasting for microphone inserts). 

For each audio item in the list, its duration, type, and name are displayed. If an audio item was 
previously marked (before it was loaded in the player) and has the Intro point set, the duration of the 
Intro phase is shown in the right column of the list. The time left in the Intro point countdown is shown in 
red in the field located in the lower part of the player window. After the Intro point is passed, displaying of 
this countdown stops.  

Let's consider the other items located in the bar in the lower part of the player window. The number 
of the player in the program is shown in the left part of the bar. In the middle of the bar, the same total 
duration of the audio items is displayed as in the header. However, when any of the loaded audio items is 
played back, the countdown timer of the total duration of the audio items is displayed here. 

Icon  indicates the current state of the fader associated with the player (see Section 4.10.7). 
Yellow slider means it is closed; green slider means it is open. 

Button  (Lock) blocks the player controls. The closed lock indicates locked controls, with all 
buttons disabled and the player automatically playing back the audio items in the list order. 
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To the right of the audio item bar, the stereo playback signal level indicator is located. This indicator 
can be hidden with corresponding settings in the Player properties window. 

The Block Player Context Menus 
The context menu is opened by right-clicking an item name in the player. It contains the following 
commands: 

• Properties. Calls the audio item properties window. Here some properties of the audio item can 
be viewed and edited. More details are given in the Player Properties Window subsection. 

• Copy. Copies the selected audio item to the clipboard. 
• Cut. Moves the selected audio item to the clipboard. 
• Paste. Pasting the audio item from the clipboard. 
• Crossfade. Calls the crossfade editor to edit the crossfade between two audio items. 
• Crossfade 3. Calls the crossfade editor to edit the crossfade between three items. This window 

can be used to create a crossfade, do basic editing operations, and record a new audio item 
(see more details in Section 4.4.8). 

• Insert pause. Inserts a pause in front of the audio item. The duration of pause can be set in the 
Player properties window. 

• Insert a stop. Inserts a stop point in front of the audio item. 

Right-clicking on an empty line of list opens context menu containing reduced number of 
commands: Copy, Cut, Paste, Insert pause and Insert stop. 

Right-clicking on title of player window opens the context menu consisting of three points: Clear, 
Properties and Remote control setup. If select Clear all loaded in the player audio items are removed 
from a player window. Selecting Properties calls the window Player properties (fig. 4.40) in which 
settings of operating modes and appearance of player window are carried out. 

The Player properties window 
A screenshot of the block player window is shown in Fig. 4.37 
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Fig. 4.37. The Player properties window 

• Title. The player's title. Can be edited. 
• Playback device. The physical device to reproduce the player's output signal is selected in the 

dropdown list. The physical audio card installed 
on the computer is selected and the block player is tied to a specific virtual player on this card. 

Check boxes to enable displaying various player window items and to change the nature of the 
playback and prelisten modes are located below the Playback device dropdown list. These are the 
following: 

• Show VU meters. Show or hide the audio signal level meters located in the right part of the 
player window. 

• Show player number. Show or hide the player number in the indicator bar. 
• Show total length. Show or hide the total duration of the audio items loaded into the player. 
• Show fader state. Show or hide the opened or closed fader state. Applicable only to players 

equipped with remote control. 
• Show Intro. Show or hide the indication of the current item's Intro value. The Intro value is 

shown in red font on the right of the line with the audio item's name in the player and also in the 
field of the audio item total duration/audio item timer window. 

• Show blocking button. Enables or disables blocking player controls including the remote 
control. 

• Show PFL button. Enables or disabled the prefade listen. 
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• Show transport bar. Show or hide the player playback control buttons toolbar. 
• Transport bar buttons scale. The size of the player playback control buttons is set by 

changing the value in the field. 

The group of flags that define the specifics of the playback mode is located below the Transport 
bar buttons scale. 

• Playback starting from selected item. With the flag set, the playback starts with the audio item 
selected in the player window; with the flag cleared, the playback starts with the first loaded 
audio item. 

• Show block autostart button. With the flag set, the playback of the block starts strictly at the 
specified time; this requirement is not observed with the flag cleared. 

• PFL selected item. Defines the prelisten mode: either the following the current item is 
prelistened or, if the box is checked, the highlighted item. 

• Use special PFL channel. If the flag is set, the prelisten will be done through a separate 
channel that is not used to broadcast the signal. 

• Restart item if PLAY button was pressed during PFL. If the flag is set, pressing the 
Playback button starts the playback of the item being prelistened from the start of the item. If 
the flag is cleared, the broadcast playback of the item is picked up from the point, at which it was 
in the prelisten mode when the Playback button was pressed. 

• Restart playing item by PLAY button. With the flag set, pressing the Playback when the audio 
item is being played back, starts it from the beginning. If the flag is cleared, pressing the 
Playback button is ignored and the playback of the audio item is continued without stopping or 
interrupting. 

External fader control device. If remote control is available, the control device and the specific 
fader can be selected in this group. 

Set by default. Operations are selected in this group to be performed by default when the playback 
of the current item ends. 

• Start next. Enables or disables the automatic start of the next item after the current one ends. 
Button  in the player window performs the same function. 

• Delete played. Enables or disables the automatic deletion of the audio item from the player 
after it was played back. Button  in the player window performs the same function. 

Color. In this group, the color of the various elements of the player graphical interface can be 
specified. Colors are changed by clicking the necessary button and selecting the needed color in the 
standard palette window that opens. 

4.7.3. The Multichannel Player (X Player) 
The multichannel player (a.k.a. the X Player) is used for broadcasting a schedule fully adhering to the 
order of the audio items specified in the schedule. The main feature that sets it apart from its predecessor 
is the multichannel capability: It can perform playback through several independent physical outputs (up 
to four) automatically distributing the audio items over the channels. It also has several other capabilities. 
The player has an advanced visual user interface and a simple but at the same time convenient and easy 
to understand configuration system. 

The main reason in favor of using a multichannel player has to do with the modern technology of 
processing the modulating signal before it is fed into the transmitter. To obtain more dense and rich 
sound, radio stations use special devices for final audio processing called FM processor. Usually, these 
devices are placed at the very first stages of the audio channel. The nature of the audio material 
broadcast by a radio station is not uniform. Different types of audio signals need different FM processor 
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settings. The usual audio material selecting contains music, commercials, and recorded DJ talks. The 
audio in commercials, as a rule, is already compressed and do not require additional processing; 
however, music and voice require significantly different FM processor settings. Therefore, every time a 
switch is made from voice to music and from music to commercial (and the other way around), either the 
FM processor needs to be reconfigured or different audio material needs to be reproduced through 
independent physical outputs connected to separate individually-configured FM processors. For example, 
commercials are fed to the A output, to which no additional processing is connected. Music is fed to the B 
output, to which an FM processor with fixed music settings is connected. Prerecorded DJ voice tracks are 
fed to the C output, to which a voice processor is connected.  

Of course, this system cannot work normally unless audio items are distributed over the channels 
automatically. The player meets this need with its flexible automatic-distribution configuration system. The 
channels can be assigned the type of materials to be broadcast over them. This is done by executing the 
Service > Global settings > Playback channels by categories command sequence (see Section 
4.12.2). Distribution of the audio material over the channels can be tuned up more finely when an MDB is 
used, as here not only the type of the material can be taken into account but also the MDB category it is 
stored in. Of course, audio items can also be distributed over the channels manually, both at the 
scheduling stage and from the player console immediately before the airing time. 

The Multichannel Player Operating Modes 
The data source for the multichannel player is a schedule. The player reproduces a sequence of audio 
items from the schedule confirming to all the parameters specified in the schedule (crossfades, start 
points, etc.), as well as confirming to all the time marks specified in the block properties. The player's 
three operating modes differ by the degree of the operator's involvement into the playback control 
process. These are the following: 

• MANUAL 
• LIVE 
• AUTO 

In the MANUAL operating mode, each audio item must be started manually by the operator; 
however, the next audio item is loaded from the schedule into the playback queue automatically by the 
player. The responsibility for observing the schedule's time check points lies entirely on the operator. To 
output commercial blocks, whose items must follow each other uninterrupted, the player offers the 
COMMERCIAL BLOCKS NON STOP mode. Enabling this mode allows the contents of the commercial 
blocks to be output continuously. 

In the LIVE mode, the player travels from one item to another by itself and stops at the schedule's 
stop points to be manually started by the operator.  

In the AUTO mode, the player always follows the time marks and always ignores the stop points. 
When necessary, the player can use the gap-filling system to dynamically generate a schedule fragment. 
This capability comes in handy when there is no material to playback due to, for example, scheduling 
errors communication line breakdown, etc. This mode is intended for autonomous operation without 
operator's involvement and is not designed for a manual intervention. 

Of course, the operator can change the player operating mode at any time and intervene into its 
operation. 

The operating modes are essentially player's preconfigured settings. Switching modes sets the 
predefined values of numerous parameters controlling the player operation. 

The main parameters controlling the player operating logic are listed and described in brief in Table 
4.2. Parameters that are switched from the toolbar are given the corresponding player window button in 
the enabled and disabled states. The following abbreviations are used in the table: Mod (Yes/No): 
indicates whether the parameter can be modified during operation (not through the configuration settings 
but from the player toolbar or using hotkeys); Dsbl: disabled; Enbl: enabled. 
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The default settings shown in the table are configured when the program 
is installed, but can be changed by the user. Moreover, the parameters that do not change during the 
process of the player operation (which depends on the broadcasting procedure employed) can be 
disabled in the player configuration settings. The parameter button will not show on the player control 
toolbar with the parameter itself always having the default value that cannot be changed. This simplifies 
the user interface of the player, makes working with it easier, and makes for reducing the number of air 
time errors. By default, the COMMERCIAL BLOCKS NON STOP parameter is disabled (its value by 
default – Off). 

 
Table 4.2.The Multichannel Player Parameters 

Default Setting 

MANUAL LIVE AUTO 

Parameter Button Button 
Color 

Mode Description 

Stat
e 

Mod
. 

Stat
e 

Mod
. 

Stat
e 

Mod
. 

LOCK  
REMOTE 

 

Green 
Red 

Enabling/disabling remote 
control of the fader start 
signal.  

Enbl Yes Enbl Yes Dsbl No 

AUTO NEXT 

 
 

Green 
Red 
 

Enabling or disabling 
going to the next item. 
In the disabled mode, 
each audio item must be 
started manually by the 
operator. 

Dsbl Yes Enbl Yes Enbl No 

COMMERCIAL 
BLOCKS  
NON STOP  

Green 
Red 
 

Enabling/disabling non-
stop playback of the 
commercial blocks. 
It makes sense to use this 
item only when going to 
the next item is disabled. 
By default this mode is 
disabled and there is no 
button on the player 
toolbar. 

Dsbl Yes Dsbl Yes Enbl No 

AUTO LOAD 

  

Green 
Red 
 

Enabling/disabling auto 
load the next item from 
the schedule into the 
player queue. Disabling 
this mode practically 
disconnects the player 
from the schedule: The 
operator has to specify 
each audio item explicitly 
himself. 

Enbl Yes Enbl Yes Enbl No 

 
All said above also pertains to the MANUAL and LIVE modes. The parameter settings of the AUTO 

mode cannot be configured. Moreover, in the AUTO mode the user cannot intervene into the player 
operation altogether, because in this mode all control inputs are blocked: those from the control panel, 
from the keyboard and the mouse, from the external remote control units, and the GPI signals from the 
broadcasting console. To intervene into the player operation, the user must switch it into the MANUAL or 
LIVE mode. This capability is always available and is never blocked. 

The player distributes schedule items over the channels according to the configuration settings 
described above when working in any operating mode. If this distribution is employed, for example, for the 
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final separate processing, it must 
be configured beforehand and the schedule audio items must have the material type set (i.e., 
commercials, music, etc.), according to which the distribution will 
be carried out. (See Service > Global settings > Playback channels by categories, Section 4.12.2). 
This can be done by storing the audio material 
in an MDB, in which case the material type is determined by its location in the MDB, or without using an 
MDB (for example, by specifying the material type explicitly when importing the schedule). Moreover, in 
order to select a correct playback channel, the system must receive information about the current state of 
the fader assigned to this channel. If the fader on the broadcasting console is closed, the playback over 
the given channel is impossible because the signal will not get to the console's output. The system 
usually receives the information about the fader state over the GPI. 

The GPI is configured in the GPI bits configuration window (see Section 4.10.7). This window is 
opened by selecting the Remote control setup command in the player context menu. 

If an audio item does not have its type specified or if the specified type has 
no distribution setting, the channel, to which the player directs such audio item 
to, is either A or B channel. Exactly which channel is selected is determined by the Select Channel 
automatically parameter of the Playback - General category 
in the Player setup window (see Configuring X Player further). By default, the player alternates the A and 
B channels to output such items. The alternation 
is handy when working in the MANUAL and LIVE modes because is allows the operator to start each 
next item independently by the fader start signal. 

The player operation can be visually demonstrated using a diagram. Suppose that commercials are 
assigned to the C output, the voice tracks are assigned to the D output, with the other types of material 
having no channel distribution specified. In Fig. 4.38, the black rectangles depict music, the crossed ones 
correspond 
to commercials, and those marked with circles represent voice tracks. 

When broadcasting in the AUTO mode, the player works in the ideal conditions and fully observes 
the channel distribution rules. Exactly such case 
is depicted in the diagram in Fig. 4.41. However, when the player operates in the MANUAL or LIVE 
mode, the operator intervenes into the broadcasting process. What is the system's reaction when the 
operator attempts to start over the 
C channel the audio item the system had assigned to the B channel? By default, the player launches 
such item over the C channel, as the operator is responsible for selecting the channel. If this type of the 
situation is critical, the player behavior can be changed by modifying the Play item only to selected 
channel set for the item parameter of the Playback-General category in the Player settings window. 
By default, this parameter is set to No. If this parameter is set to Yes, in the situation described above the 
player does not start the playback of the item but displays a warning window for about 2 seconds. 

Another situation that can change the ideal channel distribution arises is the player works in the 
AUTO NEXT mode and assigns the next item to the output whose channel fader has been closed by the 
operator. In this case, the player plays back this item over any available channel. 

 

 

Fig. 4.38. The diagram illustrating the multichannel player operation  

Being able to process the output in various ways is not the only way to use the capabilities of the 
multichannel playback. The multichannel player makes it possible to organize accurate live broadcasting 
without gaps and to playback audio items end-to-end. This is achieved by the original implementation of 
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the Start next function. This function allows the playback of the current audio item 
to be interrupted at any moment and to start the next one. Moreover, the playback of the next audio item 
starts over another channel with the previous audio item concluding with a fade. The transition to the next 
audio item can be made 
by pressing the button in the player window or, which is more convenient, using the hotkey on the 
computer keyboard or an external button field. The transition starts instantly without any noticeable delay. 
With three open channels, this function can be called again even before the previous transition 
completes. If a part of the station time is given to live musical broadcasts conducted by DJs, they may 
find this function very handy. 

The human attention controlling the broadcasting is concentrated on the player. Therefore, it is 
logical to provide the operator with means to perform all the main operations directly from the player 
control console without switching his attention to any other program module. All operations can be 
executed using the mouse, the keyboard hotkeys, or the external button field buttons. The following 
operations can be performed in the multichannel player: 

• Prelistening any of the items in the player playback queue; the prelisten playback process is 
shown in the player. 

• Calling the crossfade editor to edit transitions between audio items in the player queue. It is 
possible to crossfade the item being already played back with the next one. 

• Calling the Search for start point window for any of the items in the playback queue to determine 
the starting point of the audio item by ear. 

• Loading the audio item selected in any of the system's windows (MDB, Files, F-Categories) 
into the player queue at a touch of the button. 

• Evicting the next item from the playback queue (Skip next). 
• Starting the next item while fading out the current item. 

Moreover, the player graphically and numerically displays the Intro zone for all queue items. Also, 
the maximized graphical representation of the Intro zone for the currently played back item can be 
displayed. The Intro playback indicator spreads over the entire item length, showing the boundaries of 
the Intro zone 
if more than one Intro marks are set. An additional signal about the audio item's conclusion is provided 
by the special last-five-seconds indicator.  

The Functions of the X Player Window Controls 
A screenshot of the multichannel X Player window is shown in Fig. 4.39. 

 

 

Fig. 4.39. The X Player window 

We start the description of the X Player functions from the Playback queue group (Fig. 4.40). 
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Fig. 4.40. The Playback queue group 

Each audio item is allocated one line in the queue. All lines have the same set of the indication 
zones. The audio items are entered for broadcasting starting from the top and moving down the queue 
list. 

The main part of the information line is the audio item field, in which the item name and author are 
displayed. In the same field, various progress indicators are displayed, as well as the information about 
some audio item's marks. 

In the left part of the line, the audio item duration indicator is located. When the playback of the 
audio item starts, the duration indicator counts down the time left to the item's end.  

In the rightmost part of the line, the last-seconds indicator is located. The triangle at the right edge 
of the line marks the audio item as the one, to which the operations called from the keyboard (e.g., the 
prelisten, the start point seek, etc.) are to be applied. This operation will be carried out only for selected 
audio item. 

If the block has the Fixed time flag set, its first audio item has in the leftmost field the airing-time 
indicator instead of the duration indicator. Fig. 4.41 shows 
an example of the first audio item in a block with the airing time set for 15:40. 
To the right of the timer, the same block-type icon as in the schedule is displayed. At the moment the 
audio item starts, the scheduled airing time indicator turns the countdown timer. 

 

 

Fig. 4.41. The scheduled airing time is indicated in the leftmost field 

In the leftmost field of the next audio item, the Intro zone is displayed graphically and numerically. 
The Intro zone of the Die Another Day audio item in Fig. 4.40 is 6.8 seconds long. 

If an audio item has more than one Intro points set, the total duration of the zone from the start of 
the audio item to the last Intro point is shown. The duration indicator digits of audio items with Intro 
marks set are of a different color than 
of those without Intro marks. After an audio item with Intro points starts playing, the entire audio item 
area is given to displaying the Intro playback process and the duration indicator turns countdown timer 
for the Intro item with its color also changing. In the example shown in Fig. 4.42, the Intro zone has 3.9 
seconds left 
to the end. The gray vertical line crossing the M letter is not an image flaw but the depiction of the Intro 
point. 

 

 

Fig. 4.42. The Intro zone has 3.9 seconds left to the end 

When playing outside the Intro zone, the part of the audio item that was already played is filled with 
light green color.  When the last five seconds of the item are played back, the indicator in the rightmost 
field starts filling up. In the example shown in Fig. 4.43, the audio item has 3.2 seconds left to the end. 

 

 

Fig. 4.43. The audio item has 3.2 seconds left to the end 

NOTE 
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More than one audio item can be played back in the player at once, for example, when playing a crossfade. 

Left clicking an audio item marks it as the one, to which the keyboard commands apply, and places 
the corresponding marker (the triangle) on it. Double-clicking the audio item field starts the prefade listen. 
An example of the prefade listen playback is shown in Fig. 4.44. 

 

 

Fig. 4.44. The item is in the prefade listen playback 

Right-clicking an item opens the context menu with the list of actions available for the given audio 
item. The context menu is analogous to the block player context menu (see Section 4.7.1). 

In the upper part of Channels group a row of the channel buttons each marked with the channel 
name (A, B, and C) is located. In the instant case, there are three buttons, but their number depends on 
the number of channels the player has, the maximum being four (in such case it will be ABCD). The 
buttons are used to indicate the channel, to which the corresponding audio item is assigned. At first, each 
audio item in the queue is assigned by the player in accordance to its configuration settings but can be 
changed by the user afterwards. 

Pressing the button with the letter of the corresponding channel explicitly assigns the audio item to 
this channel. If the assigned channel is closed, the button is highlighted rose instead of green. The 
indicator of the current channel state (open/closed) is located in the lower part, in the left part of the 
player toolbar. 
An open channel is indicated in green, a closed one is shown in red. The indicator 
is just that, an indicator, and does not react to mouse clicks. 

• The Operation parameters group is described in Table 4.2. 
• Operation mode button group. These buttons serve to switch and indicate the current operating 

mode. Also, hotkeys or remote control signals can 
be assigned to the player functions in the window that opens with the Service > Customize 
keyboard command. 

• Operation mode group is formed by the row of buttons (Fig. 4.45). 
 

 

Fig. 4.45. The Playback and queue control group 

Button  starts the playback in the player. During the playback, the triangle symbol on the 
button turns bright green; when there is no playback, the symbol is gray. Pressing the button when there 
is a playback underway starts the next audio item. This is different than in the rest of the players, in which 
pressing this button during playback has no effect of any kind.  

Button  stops the currently played back audio item and removes 
it from the queue. 

Button  pauses the playback. The playback is resumed from the pause 

by pressing the pause button again or pressing button . 
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Button  opens the start point seek window for the first non-playing audio item in the queue (the 
one highlighted yellow). 

Button  evicts the first non-playing audio item from the queue (the one highlighted yellow). 

Button  loads into the player an item selected in any other window. The added item is placed in 
front of the item selected in the player queue with the playback queue splitting in the process. 

NOTE 

In last versions of DJin one more interface element has appeared - the down counter of the 
commercial block (it is displayed in the bottom line near to the down  counter prior to the beginning of the 
block with fixed airing time); by default time is displayed white); thus commercial can be played back 
without 
a stop even if it is not included in the commercial block. 

Х-player context menu 
The X-player context menu called by right-clicking on one of loaded audio items includes the following 
commands: 

• Search start point - calls the search start point window for the item of the schedule. 
• Properties – calls the Properties window in which it is possible to skip and edit some properties 

of audio items loaded in a player. 
• Copy - copying of selected audio item to the clipboard. 
• Cut - moving of selected audio item to the clipboard. 
• Paste – inserts the audio item from the clipboard. 
• PFL crossfade - start of prelisten of items crossfade. 
• Edit selected item – opens the selected item for editing. 
• Crossfade - calls the window of crossfade between two audio items editing. 
• Crossfade 3 - calls the window of crossfade between three audio items editing. In this window it 

is possible to form the crossfade, and also to carry out the elementary editing operations and 
recording of a new audio item (for more details see section 4.4.8). 

• Insert pause - inserting of a pause before audio item. 
• Insert stop - inserting of playback stop point before audio item. 

Configuring the X Player Window 
The following parameters are involved in configuring the player: 

• The parameters that are edited from the window accessed through the Properties item of the 
menu that opens by button  on the player toolbar. 

• The automatic channel-distribution parameters. These are accessed through the Global 
settings window (by executing the Service > Global settings > Playback channels by 
categories; see Section 4.12.2 for their description). These settings are taken to the Global 
settings window in anticipation that there are several broadcasting workstations in the system. 

The Player properties editing window, which opens by button  on the player toolbar, displays a 
standard parameter tree with the following six categories: Base settings (reloading is needed), 
Appearance, Interface, Playback, Modes and External blocks inserter. 
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The Base settings category (reloading is needed) contains only 1 parameter 
- Way to the schedule, allowing to avoid mess at automatic loading blocks 
at work with several schedules: it sets the schedule from which the player will load blocks. 

The Appearance category comprises the parameters that define the appearance of the player 
window. The following is the description of the main appearance parameters and also of those 
parameters whose functions are not clear from their names. 

• The Color settings – Preloaded items group serves to change the colors used to highlight a 
queue item and the progress indicator of the played back item. 

• The Fonts group is employed to configure the fonts used for displaying text information in 
different areas of the player window. 

• The Show item list parameter opens and closes the window, in which the playback queue of 
the X player is displayed. The window is located below the X player toolbar. If an audio item list 
is assembled manually in the player, it is advisable to set this parameter to Yes, because it is 
easier 
to edit play lists in the block player. In this case, the queues of the X player and the block player 
are synchronized, that is, the changes made in the block player window are reflected in the X 
player queue, and vice versa. 

• When enabled, the Show only the last playing item parameter makes the player display only 
the last played back item in the playback queue, 
if several items are being played back simultaneously (for example, when playing a crossfade or 
traveling to the next item). That is, the upper item 
in the queue is removed not after it completes but at the moment when the playback of the next 
item starts. This parameter does not affect the playback of the item, but only the way it is 
displayed. 

• The Number of visible items parameter defines the number of items displayed in the audio 
item queue. 

The Interface category has only one parameter: On double click action defines the action 
executed when an item in the player queue is double-clicked. 

Let's consider the parameters of the General group from the Playback category. 
• The Number of playback channels parameter defines the number of the playback channels. 

Its maximum number is four. 
• When enabled, the Fix item start time in schedule parameter causes the actual airing time set 

for those schedule items that have already been reproduced by the player: the icon is displayed 
in the Start field 
of a played back schedule item and the item's airing time is always displayed in this field. 

• It makes sense to set the Enable level control from remote mixing console in AUTO mode 
to Yes when working with virtual faders. In this case, the program reacts to the fader 
movements and changes the playback level in the AUTO mode. Note that this option does not 
allow control by the fader start signal in the AUTO mode, but allows the playback level to be 
corrected. 

• When enabled, the Playback item only to selected channel set for the item parameter blocks 
attempts to playback the audio item through 
a channel other than the one assigned to it. 

• Limit crossfades from music to commercials doesn’t need explanations. 
• The Select channel automatically parameter defines the way the playback channel is 

assigned to the audio items whose type is not specified. In this way, the distribution is defined 
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for the audio items that are not configured for the automatic channel distribution. The following 
four options are possible: 
o Alternate the A and B channels as was described earlier. 
o Use either A or B: if the previous audio item was assigned to the 

A channel, the next one will go to the same channel, the same procedure used for the B 
channel. This method makes it possible 
to avoid alternating audio items over the channels. 

o Use A: always assign the new audio item to the A channel. 
o Use B: always assign the new audio item to the B channel. 

The descriptions groups of the A, B, C, and D playback channels are given 
in the Playback category. There are always four of these, regardless of the currently-specified number of 
the playback channels. The parameter set is the same for each channel. These are the following: 

• Playback device: the actual playback device used by the given channel. The general 
assumption is that the playback devices for each channel are associated with independent 
physical outputs. 

• Mixer. This parameter is needed when working using virtual players; that is, the playback level 
is regulated by the program according to the data 
it receives from the external fader movement sensor. One of the mixers available in the system 
is selected in this list. 

• Mixer fade number. The virtual mixer is meant. 
• Mixing console fader pos in AUTO mode dB/Fs. This is the level that the program must set 

for the corresponding mixer fader when switching into the AUTO mode. Applicable only when 
working with the virtual mixer. 

The Modes parameters control the player operating logic. Their detailed description was given 
earlier.  

NOTE 
If Use XXX = No is set for a parameter, the corresponding button does not show on the player toolbar, the user 
cannot change the value of this parameter, and the parameter will always have the Default value XXX specified 
for the corresponding mode. The default value for the AUTO mode is given in Table 4.3 and cannot be changed. If 
the parameter is used, the corresponding button is placed on the player toolbar and reflects the current state of the 
parameter. However, whether the parameter can be changed 
in the corresponding mode is determined by the Enable switching XXX parameter. 

External blocks inserter category contains parameters for adjustment 
of interplay of the basic radio program and inserter. Command preroll parameters (ms), Start external 
block timeout (sec), End external block timeout (sec), Start next item on end of ext block even if ‘ 
AUTO NEXT ’ off and Keep silence during playback of external block are used very seldom and only 
in that case when the standard configuration of the program works incorrectly. 

4.7.4. The Retransmission Player (Player 777) 
The retransmission player (a.k.a. Player 777) automatically inserts regional commercials into the main 
program received from the central radio station and subsequently broadcasts it over a small region. The 
player does not employ an MDB in its operation. 

The retransmission player differs from the other players in that it has 
a switcher to switch between the retransmission and its own broadcasting. Switching can be done 
manually by operator using the keyboard or the mouse, 
on a GPI signal, or automatically at the scheduled time or on a command from the audio pattern 
recognition module. 
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Upon receiving a command to switch and provided the player has material 
to insert, the built-in switcher issues a command to start the playback of the local material, simultaneously 
(or, depending on the configuration, somewhat earlier) starting to lower the level of the retransmitted 
signal until it is completely suppressed. In this way the system is switched into broadcasting the local 
material. 

Having completed broadcasting the local block (or somewhat earlier, and also by receiving the 
command from operator), the module starts gradually increasing the retransmitted signal on the output, 
thereby returning the system into the retransmission mode. 

Local broadcasting blocks are loaded from the schedule automatically. A block is loaded into the 
player in advance and awaits the playback command from the switcher. 

In case of the retransmitted signal loss, an emergency player kicks in that holds a backup block of 
audio items. The contents of the emergency player are preserved even after the program is reloaded. 

The player is designed for one channel and for manual control by the fader start signals. It can be 
used to manually switch the external input line to the main output. 

The jingle pattern-recognition capability is the main feature of the retransmission player. The 
essence of the pattern recognition module is the following. The patterns of all jingles that precede 
commercial blocks broadcast 
by the central radio station are stored in the program memory. The audio pattern recognition module at 
the retransmission station is constantly on the lookout for appearance of any of these jingles. It employs 
the unique recognition algorithm designed by the specialists that uses the latest developments in the 
spectral-correlation analyses and artificial intelligence fields and identifies the received jingle with a great 
degree of accuracy. As soon as a jingle indicator of a commercial block start is recognized, a command is 
issued to replace the central station signal with the signal from the retransmission station. The player 
starts playing back the local commercial block (with the central station playing its own commercial during 
this time). At the end of the commercial block, the central station sends another, specified in advance, 
closing jingle. Having recognized it, the retransmission system switches from playing back its own 
commercials to retransmitting the central station program. 

This allows the retransmission station to work in automatic mode. Consequently, this eliminates the 
need to employ an operator, who would have 
to be constantly on the alert to perform the necessary switching and adjusting.  

The experience of using the audio pattern recognition system on many radio stations has shown 
that, provided the updated jingles are supplied to the retransmission station on time, cases of local 
commercial material broadcasting failures are significantly fewer as compared to such caused by errors of 
the operators of non-automated retransmission systems.  

Functions of the Retransmission Player Window Controls  
Fig. 4.46 shows the retransmission player window. 

The controls of the retransmission switcher are located in the upper part of the window. 

• Button /  enables/disables the retransmission mode. The current mode is displayed on 
the button. On means the retransmission is enabled, the system passes through the signal and 
recognizes audio patterns. Off means the retransmission is disabled. In this case some buttons, 
which are used in the retransmission mode, are not shown in the window. 
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Fig. 4.46. The retransmission player window 

• The RETRANSMISSION button serves to explicitly switch from the retransmission to the local 
broadcasting mode. It also indicates the current broadcasting mode for both the manual and the 
automatic switching. Pressing the button causes a smooth transition from the retransmission 
to the local broadcasting launching the block player playback. If the player has no audio 
material, pressing the button produces no effect. Pressing the button again returns the system 
into the retransmission mode, after which the block player playback stops. When the system is 
in the retransmission mode and there is the input signal, the RETRANSMISSION label is backlit 
green. When there is no input signal, the label is backlit rose. In the local broadcasting mode 
with the player working, this label is not backlit and has the standard gray background. In this 
mode, the player title bar is backlit, which usually has the word Program in it. 

• The AUTO button turns on and off the audio pattern recognition system. 
If the audio pattern recognition system is not configured and has to active samples, the button is 
disabled. When the AUTO mode is turned on, the button color changes from gray to blue. A 
situation may arise when the closing jingle is detected (i.e., a commercial block has ended in the 
main program) while the system is still in the local broadcasting mode 
(i.e., is playing a local block) continuing the commercial playback. In this case, the button starts 
blinking, indicating that a closing jingle has been detected, but the local broadcasting will 
continue until the last non-musical item has been completed. This happens when: 
o The system is working with a configured closing jingle. 
o The local block is longer than the main program block. 

The two horizontal bars to the left of the /  button serve as the signal level indicator of the 
main input (the one to which the retransmitted signal is fed). 

The large dot (circle) left to the RETRANSMISSION button is the input signal presence indicator. 
The red color means there is no signal (a sign of a failure 
or an error); the green color means the signal is present. The indicator is always on, regardless of 
whether the system is in the retransmission or the local broadcasting mode. The signal presence is 
registered only when its input level exceeds the threshold value. When the input level has been lower 
than the threshold value for a specified period of time, the signal absence is registered. The signal 
detection parameters can be configured.  

Below the player title bar, the transport bar is located with the standard player control buttons. 

 Playback. Starts the playback of an audio item. Depending on the settings in the Player 
properties window, either the first audio item in the list 
or the selected audio item can be started.  

 Stop. Stops the playback. 
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 Pause. Pauses the playback. Pressing the button again resumes the playback from the point 
where it was paused.  

 Next Item. Stops the playback of the current audio item and starts the playback of the next 
audio item in the list. 

 Auto next enable. The green color indicates that the next item will 
be automatically played back after the current audio item finishes. The red color means the playback will 
stop after the current audio item finishes. 

 Auto delete. Enables automatic deletion of the audio item from the player after it was played 
back. The red cross means auto delete is enabled. 

Right-clicking the player title bar (the field with the word Program in it) opens the context menu. It 
contains the following five items: Clear, Load, Save, Properties, and Remote control setup. This is a 
standard block player context menu. The player can save its contents to a file and then load it from the 
file. The Load and Save commands are not always available in a configuration.  

The Retransmission Player Properties Window 
The three-dot button  opens the Properties window (Fig. 4.47), in which the retranslation player 
properties are configured. 

The name of the radio station to be displayed on the retransmission player title bar is entered into 
the Radio station field. 

The audio card input, over which the retransmitted signal is to be fed to the program, is displayed in 
the Main retransmission channel list. It is assigned using the Retransmission channel settings 
window (Fig. 4.48), which opens 
by clicking button  to the right of the list. Additional retransmission channel parameters are also 
specified in this list. 

Buttons Add and Edit open the Retransmission channel settings window (Fig. 4.49). 
The name of the radio station is entered into this window, as well as the recording and playback 

devices specified for the retransmission channel. 
• The Keep playback device open flag needs to be set for some types 

of audio cards, in which the hardware transit of the signal from the card's input to its output is 
possible only when the corresponding playback device is opened by software. 
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Fig. 4.47. The retransmission player Properties window 
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Fig. 4.48. The Retransmission channel properties window 

 

Fig. 4.49. The Retransmission channel parameters window 

• Not all audio cards have the capability of adjusting the signal parameters (e.g., the level) during 
its transit from the input to the output. 
To circumvent this shortcoming, the Program data transfer flag enables an alternate data 
transfer method. The input signal is recorded by software to a buffer, from which it is then played 
back over the specified playback device. This technique can be employed with all audio cards. 
However, 
it introduces a delay into the signal and places higher requirements on the computer's 
processing performance and operating stability. The reason for this is the fact that data are 
transferred from the audio card input to its output by software and the buffer size in very small. 
In this case, the recording and playback devices need to be synchronized. 

If data are transferred by hardware (the Program data transfer flag 
is cleared), the mixer controller connections with the audio card for the specified recording and playback 
devices must be configured. This can be done by executing the Service > Hardware devices > Audio 
Mixers > Audio devices and mixers command sequence. 

Let's continue our getting acquainted with the Properties window (Fig. 4.47) used to configure the 
retransmission player. 

• In the Extra retransmission channel group, another signal transit channel is defined. It is 
needed for switching the extra input line to the output, for example, to insert local programs fed 
in at the system's extra input into the retransmitted program. The extra channel is not need 
to be configured in order to be able to carry out the main retransmission task. It operates 
analogously to the main retransmission channel but only under manual control. 

• The Path to schedule field is needed for special cases. Normally, it is left blank and the main 
system schedule is used. 

• The Reserve player setting group is used to: 
o Connect a reserve player by setting the Use Reserve player flag. 
o Attributes of loss of retransmitted signal (a threshold level and the longest permissible 

signal-loss time on the input and also a delay before return on relaying after signal appears 
on input are specified). Last option allows preventing repeated switching between 
retransmission and reserve broadcasting if the signal is not stable 
on input (appears and then disappears). 
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o Connection to the detector of telephone signals is made by means 
of Use Ring detector flag. It can be applied together with the detector of signal loss to 
transition on reserve broadcasting and back. The given function is used only in an unusual 
case when the signal 
is retransmitted by telephone. The near located Ring detect setup button opens the same 
window where parameters of a signal (minimal/maximum level of telephone ring, its 
duration, its period, etc.) are set. 

Clicking the Switcher settings button bar opens the Switcher settings window (Fig. 4.50). 
 

  

Fig. 4.50. The Switcher settings window 

• The values of the Main band and All other bands parameters in the Recognition threshold 
group should be changed only after consulting with the developers. In most cases, the default 
values are sufficient for the jingle-recognition system to work satisfactory. Increasing the values 
expands the range of the admissible deviations from the sample. This increases the probability 
that the signal pattern will be recognized. 

• Clicking the Add pattern button opens the standard file selection and load dialog window to load 
a file with the sample jingle into the system. If the sample does not meet the specified criteria, 
the program issues 
a corresponding warning. 

NOTE  
The audio part of the sample file must be from 1 to 4 seconds long and be of the WAV, PCM, 44.1 KHz format. It 
must have the Start and Stop marks set chopping about 
0.25 seconds off the start and the end of the jingle. The just mentioned 1-to-4 second audio duration must be 
between these marks. The mark up information must be saved 
in the file, therefore, the Properties window and the Marking tab must be opened from the audio item context 
menu in the Files module. Calling its player window Marking tab makes no sense, because nothing is stored in the 
file in this case: (data are saved in the schedule only). 

• To add DTFM image is possible with the help of Add DTFM button opening DTFM window. In 
the top line of this window you need to set the DTFM command. Then in the Process with 
delay field delay of reaction to fixed DTFM command is set. 
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• Edit DTFM button allows editing earlier created command. 

NOTE 
The DTFM-command can contain not only figures from 0 up to 9 and letters A, B, C, D, E, F, but also symbols "*" and "*" which 
are interpreted, accordingly, as E and F. 

The samples of the beginning and end of the local block insert indicator files are assigned by setting 
the flags in these columns:  

• On: the opening jingle (DTFM command), triggers switching to the local broadcasting. 
• Off: the closing jingle (DTFM command)e; triggers switching from the local broadcasting back to 

the retransmitting. 

DTFM-Setup button located separately opens DTFM decoder settings window where it is possible 
to set system of recognition of DTFM-commands parameters. 

Pressing the Crossfades button bar of the Properties window (Fig. 4.47) opens the Crossfades 
window (Fig. 4.51). 

 

 

Fig. 4.51. The Crossfades window 

The functions of the parameters set in this window are sufficiently clear from their labels and need 
no additional explanations. 

Fig. 4.52 shows another example of the retransmission player window (compare this one with the 
window in Fig. 4.46). 
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Fig. 4.52. Another example of the retransmission player window 

In the current case, it is configured as follows: 
• The retransmission is enabled: the On/Off button is On. 
• The system is in the retransmission mode: the RETRANSMISSION button is backlit. 
• The signal is present at the main channel input. It is displayed on the signal level indicator, and 

the green dot and the backlit green RETRANSMISSION label also indicate this. 
• The automatic recognition is enabled: the AUTO button is backlit. 
• The extra retransmission is specified. It is called Local Line and has 

no input signal, which is indicated by the gray signal level indicator and the red dot. 
• The reserve player is enabled and loaded. 

The player has the first item loaded with the airing time of 13:20 and the countdown timer till its start 
time is running (the 0:40:0 digits at the bottom). This block has the No sooner and No later flags set; 
therefore, if by 13:20 the opening jingle is not recognized (the recognition is enabled), the playback of the 
item will start automatically. 

NOTE 
To automatically start items on schedule, a block in the 777 player must have either the No sooner or No later flag 
set. If none of these flags is set, the block is loaded into the player but will not start automatically on schedule but 
only manually or upon sample recognition. 

4.7.4. The Jingle Machine Player 
The Jingle Machine player is used to support live broadcasting and allows instant launching of the 
necessary audio item. The main feature of the Jingle Machine player is the table organization of its items. 
This presentation way makes it easy 
to locate the necessary item on the screen. It is also ideally suitable for controlling the player from an 
external button field whose dimensions (the number of the rows and columns) matches the dimensions of 
the jingle machine field.  Any player item can be instantly aired at a touch of a key on the keyboard or on 
the external control field. The items stored in the F-Categories module or in the Jingle section of the 
MDB can be distributed over the buttons of the jingle machine.  

The jingle machine is controlled using the mouse, the keyboard, and external devices connected to 
the serial port (RS 232). 

If the work is conducted without using a database, the jingle machine contains the F-Categories 
and the files contained in them. 
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If a database is used, the jingle machine contains the aggregate of the Jingle categories of the 
database and the aggregate of F-Categories and their contents. 

The player is most often used in the following two ways. 
• In the first way, the player is used as intended for airing various audio items: audio effects, 

background sounds, jingles, etc. Most often, this 
is required when preparing live broadcasts, interactive games, etc. The operator can prepare the 
needed audio items in advance and place them 
on the buttons of the jingle machine in the way, which is most convenient for him. This can be 
done not only from the broadcasting station but from any production workplace. This player 
variation is included into practically all typical configurations of the DIGISPOT® II DJin program. 

• The other method presupposes using the jingle machine as a data source for a group of block 
players. Button field buttons can be used to switch 
to another category. This makes it possible to organize a system for rapid navigation over the 
collections of audio items prepared in advance. In this case, clicking the jingle machine button in 
the button field simply selects 
an audio item. It can then be added to the end of the block player play list by clicking the 
corresponding button-field button, which allows a play list 
to be rapidly prepared. In this version, the greatest efficiency is achieved when the jingle 
machine is used with an external specialized button field that has both the jingle-machine control 
button and the block control buttons. Specialized remote control devices manufactured by us 
can 
be used as such external button fields. Another option is to use specialized computer keyboards 
whose keys can be combined into buttons and have commands assigned to them. A typical 
configuration consisting of a jingle machine and block players is called a cart machine. 

The Jingle Machine Player Window 
The window of the Jingle Machine player along with the window of an F-Category is shown in Fig. 4.53. 

The figure shows one of the possible versions of the Jingle Machine player windows. The number of 
cells can be changed. Taking into account the monitor resolution, the number of cells cannot exceed 100. 
These and other jingle machine settings are configured in the Settings window on the Other tab (see 
Section 4.12.1). 

Each jingle machine cell serves both as a temporary virtual storage for the reference to the audio 
file and a button to start its playback. The item is launched for playback by clicking its cell. Clicking 
another cell while an item is being played starts the playback of that cell's item. The playback is stopped 
by clicking the Stop button. 

In the same line with the Stop button, but at its opposite end, the countdown playback time is 
located. Between these two controls, the item playback progress-indicator bar is located. 

Below, the bar with the controls for working with the subject categories 
is located. 

Pressing button  takes you out of the subject category in the F-Categories window and clears 
the cells of the jingle machine. 
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Fig. 4.53. The Jingle Machine player window 

Button  is used to move from the current subject category to the previous one. To the right of this 
button, a dropdown list is located, in which any of the created subject categories can be selected. The 
references to the audio items that had been loaded into the jingle machine from this category will be 
loaded into 
it again. 

Categories can be rapidly selected using the buttons with pre-assigned categories located to the 
right of the dropdown list. A button is linked to a specific category by right-clicking the button and 
selecting the category in the window that opens. 

The Jingle Machine Player Context Menu 
The jingle machine context menu opens by right-clicking a cell and has the following commands: 

• Copy copies the contents (the reference to the audio file) to the clipboard. 
• Paste pastes the reference to an audio file from the clipboard into the cell. 
• Clear clears the reference to an audio file from the cell. 
• Clear page clears the references to audio files from all cells of the current page. 
• Clear all buttons clears the audio file references from all jingle machine cells. 
• Create folder opens the window, in which a new F-Category can 

be created and named. 
• List window opens a pop-up duplicate window of the F-Categories window. 

NOTE 
When the jingle machine is used as storage for audio items, it can have more cells than can fit on the screen. They 
can be viewed by scrolling them up or down using the <PageUp> and <PageDown> keys. This is the reason for 
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the two similar commands: Clear Page and Clear all buttons. The former clears the items on the visible page, the latter clears 
all buttons. 

The jingle machine operation can be organized in two levels. 
On the first level, an F-Category or a database Jingle category can be placed into each cell. On the 

second level, each cell holds the contents of an F-Category 
or all database Jingle category items.  

On the first level, the jingle machine is a tool for selecting an F-Category 
or a database category. After an F-Category or a database category is selected, its contents are 
displayed in the table. It is important to understand that 
an F-Category or a database category can hold many items, while the jingle machine table holds only 
those items that were selected by the user and in those cells where the user put them. 

NOTE 
The locations of folders, categories, and items are always constant relative to the cell numbers. 

4.7.5. The Fast Jingles Player 
The Fast jingles player is a development of the Jingle machine player. Its main function is to provide the 
broadcasting operator with means of playing a certain type jingle on the fly. The player can play back a 
jingle from a group of jingles 
by simply pressing a keyboard key or a button in the external button field. The player has its own simple 
rotation algorithm to avoid repeating jingles from the same group even if the items are played back from 
several workstations simultaneously. A group of items may be made up of the contents of one of the 
categories of the F-Categories module or any category of the MDB items.  

Unlike the jingle machine player, the fast jingle player can play any type 
of MDB items (not only jingles). 

The minimal version of the player does not have its own window. The system administrator creates 
groups from his workplace and informs the operator about the keys or button-field buttons assigned to 
these groups by messages "Press 1 for a short jingle, 2 for a long jingle, 3 for a jingle before news."  

If necessary, a window can be added to the system to show groups of items. The window's 
appearance and functionalities are practically the same as those 
of the jingle machine player. Several players of this type can exist simultaneously in the system. In this 
way, items from different groups can be played back through different physical outputs. 

4.8. Data Modules 

4.8.1. The Files Module 
The Files module is employed to search for, prelisten to, and load files into a player or a schedule. With 
the help of the module, the file structure of the station's hard disk or of the local network file storage can 
be viewed in the same way as with using MS Windows Explorer. The module shows audio and text file 
information and allows their contents to be checked. It makes the file format and duration information 
available to the operator. Depending on the format of the file, it can store supplementary information (e.g., 
marking, textual description, etc.). This information can also be viewed and edited. A screenshot of the 
Files module window is shown in Fig. 4.54. 
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Fig. 4.57. The Files module 

The Files window is used to prelisten to audio, view and edit information, and edit descriptions of 
audio files. 

The module can be used for sorting items of the displayed folder on one of the fields and for rapid 
filtering by a string sample. Frequently used directories can 
be placed into Favorites to speed up access to them.  

Let's consider the functions of the File window controls. 

• Button  is used to return to the previous directory. 

• Button  is used to move to the higher level directory. 

• Button  refreshes the window. 

• Button  is used to move to directory Favorites. 

Right-clicking the work area of the Files window opens its context menu with the following 
commands: 

• PFL pre-listens to the selected file. 

• Refresh: this command duplicates the button . 

• Add to Favorites adds the selected files to the Favorites directory. 
• Copy copies the selected file to the clipboard. 
• Paste inserts file from the clipboard. 
• Properties opens the Properties window containing tabs Description, Comments, Marking 

(see Section 4.4.5). 
• Edit selected item opens selected audio item for editing. 
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• Auto glue marking starts crossfade module. 
• Convert opens the submenu with commands to convert the audio file format. 

Items displayed in the module can be copied to other modules using the Drag & Drop method or 
using the clipboard Copy/Paste command sequence.  

Note that this module cannot be used to physically rename, copy, move, 
or delete files. Only the item properties stored in the file can be edited.  

4.8.2. The F-Categories Module  
The F-Categories module is a simple audio material storage system. The stored items can be distributed 
over categories; subcategories are not allowed. 
All operations applicable to items from the Schedule window – marking, editing properties, etc. – are 
applicable to items from the F-Categories module. The contents of the F-Categories are synchronized on 
all workstations of the system: changes made on one workstation are instantly reflected on the rest of 
them. 
A screenshot of the module window is shown in Fig. 4.55. 

 

 

Fig. 4.55. The F-Categories module window 

F-Category items can be assigned to jingle machine buttons (see Section 4.7.4). 
The stored items can be sorted on one of the displayed fields; F-Category items can be filtered by a 

specified string. 
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The F-Categories are not linked with any file system folders. When an item 
is added to an F-Category, the name of the source file is remembered. By default, before a new file is 
added, it is copied to a special folder that can be accessed over the network from any of the workstations. 

Removing an item from an F-Category does not delete the audio file. Unused files are deleted by 
using the Delete unused material function (accessed through the Service/Delete unused material 
command sequence). 

The main function of the module is to store material either on the long-term basis or for expeditious 
use. The operator or the host can place the audio items 
he needs for broadcasting into a specific F-Category in advance from the scheduling workstation thus 
freeing him from the necessity of looking for them when on the air. Saving the file when deleting the item 
that references it allows the information to be preserved in case an item is mistakenly deleted. 

If there is an MDB connected to the system, the F-Categories from the MDB Jingles section are 
also displayed in this window. 

Items from the F-Categories window can be copied to other system modules analogously to the 
items from the Files window. 

The contents of the F-Categories can be made reserved copies of analogously to the schedule 
items. 

4.8.3. The Media Database Module 
The media database (MDB) is a specialized database operating under Microsoft SQL Server 2000 and 
higher. The main function of the MDB is to serve as a structured storage of the information about the 
items it contains. 

An MDB item is a description of an object (e.g., an audio item, text item, project, or subject) that 
contains a set of predefined and user-created fields. The MDB can be used to store materials both on the 
long-term basis and for on-the-fly use. 

The data stored in the MDB are structured by categories. A category is a group of items combined 
by the user by some characteristic. The user himself creates the set of categories he needs, with 
subcategories allowed. The system allows items 
to belong to categories on the one-to-many basis. For example, a jingle can belong to the Long category 
and at the same time to the Night category. The user can also rapidly group items by the field values, for 
example, pick up works of a specific performer or author. If the default attributes are not sufficient to 
describe an item, the user can add the necessary attributes himself.  

The MDB is used for centralized storing and editing of material. It is the core of a system of the 
workstations that use and modify its contents. The MDB material is grouped by five main types: Jingles, 
Commercials, News, Music, and Broadcasts. The category structure and the set of the user created 
attributes are unique for each type, which makes it possible to store them in a conveniently organized 
structure. Moreover, materials from different radio stations can be stored in one MDB with the materials 
from all radio stations accessible for viewing 
or editing. This capability can be used when organizing the operation of a large complex of radio stations. 
In this case, an administration system to control access to the MDB items becomes especially necessary. 
Such an administration system 
is used to limit the rights of specific users to view and edit the specified parts of the database and to 
prevent unauthorized modifications of the MDB contents. As 
a result, the reliability of the system is enhanced. 

A typical example of the MDB use is storing a database of musical, commercial, news, and other 
items that are readily available when preparing 
a schedule. Storing material in a structured way makes for a rapid location of the needed item by its 
belonging to a certain category or by its attributes, for example, the author name. The search and filtration 
system allows the contents of a category to be rapidly filtered by a search string. This may be useful 
when, for example, organizing request performances or interactive games. 
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When the MDB is employed to store material to be available on short call, 
all of its items have references to the files, in which the audio or text material 
is saved. The files themselves are saved in the specified file storage. New items can be added to the 
MDB manually (using the Drag & Drop operation or by editing the existing items in the DIGISPOT® II 
BCS audio editor) or automatically, with the help 
of special applications. For example, the NewsLoader application can be used 
to automatically add to the MDB news items received from Internet news agencies through the POP3 or 
NNTP protocols. When the material is added, the filtration system sorts it by the categories and sets 
values of some attributes. The DB Import application can be used to update the contents of the database 
adding and/or deleting items based on the information obtained from text files or from the file folders, in 
which the new items and their descriptions appear. The contents of these folders can be updated by 
outside systems, including using the FTP. 

The MDB is used as a component for building a system of several databases connected by the 
Internet. Such a system is called a distributed MDB (DMDB). The DMDB workstation operators can view 
the contents of the remote databases permitted for viewing and in their turn lay out some of their own 
material for remote viewing by others. Portions of the MDB can be specified to automatically synchronize 
their state with the state of a remote database. In the process, both the metadata and the contents of 
audio and other files are synchronized when the MDB items have files assigned to them. 

In addition to the regular items that can be edited by the user, the MDB can also store DIGISPOT® 
II broadcasting system schedules. In this connection, outside applications can modify schedules in the 
MDB via the ODBC interface. For example, the contents of a schedule stored in the MDB can be 
displayed on the station's site and dynamically changed by the results of the interactive voting by the 
listeners. The information on the site is displayed and the schedule is edited by a PHP or PERL script that 
accesses the MDB via the ODBC interface.  When working with 
a complex of radio stations, the MDB is also used to store regional schedules. 

Currently, a new program that will expand the capabilities of the DIGISPOT® II system is in the final 
development stages: the musical rotator MAG (Musical Auto Generator). This automatic musical schedule 
generation program uses the MDB 
as the main storage for the material and data necessary to create a schedule. 

The MDB Module Window 
The user accesses the MDB using the MDB window of the MDB module that can 
be included into the DJin and BCS Editor applications. The MDB module window 
is shown in Fig. 4.56. 

NOTE 
When describing user operations, it is assumed that the user has full access rights. User rights restrictions are described below 
in the MDB Administration section. Moreover, 
it is assumed that the system is configured to work with only one radio station. The specifics of working with materials for more 
than one radio station are described 
in section Working with Several Radio Stations. 

The MDB module window consists of the following parts: 
• In the upper part of the window, located is a toolbar with buttons for switching the type of the 

displayed material and buttons for calling the main operations. 
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Fig. 4.56. The MDB module window 

• Under the toolbar in the upper left part, the category list is located, with the current category 
being determined by the highlighted item. 

• Under the category list, the list of attribute values is located. It can 
be disabled as explained in the MDB Administration subsection. 

• The selected item defines the current value of the attribute whose name 
is shown in the dropdown list. In Fig. 4.56, Current attribute is Artists, its value is All. 

• In the right part of the MDB window, the list of items is located. Its contents are determined by 
the values of the category window, the attribute window, and the filter window that can be found 
at the top of the item list. The items shown in the item list are those that satisfy all of the just 
enumerated selection conditions, that is, they are the result of the AND function applied to these 
conditions. The items displayed are those that belong to the categories selected in the 
categories list and those that have one of the selected values of the attribute selected in the 
attribute list and those that meet the filtrations conditions defined by the filter window string and 
type. If All is selected in the list of categories or in the list 
of attributes, the contents of the given item list are not limited by these lists. An empty filter line 
has no effect on the item selection either. In case when All is selected for the list of categories 
and the list of attributes and the filter is not specified, the item list contains all MDB items 
belonging 
to the current type selected on the toolbar (e.g., commercials, music, etc.). 

The MDB Window Toolbar 
The MDB window toolbar is shown in Fig. 4.57. 

The first five buttons of the toolbar allow the type of the displayed material 
to be selected. Changing the type results in changing of all lists, because each type has its own, 
independent of the other types, set of categories, attributes, and MDB items. 

 

Fig. 4.57. The MDB window toolbar 
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Let's consider the functions of the rest of the toolbar buttons. 

 - item readiness to be aired. 

 - item affiliation to the archives. 

 - place the item into the archives. 

 - take the item out from the archives. 

 — creates a new MDB item. To create a new item, a standard item properties window is 
opened analogous to the window displayed in the Schedule and F-Categories modules. If items other 
than All are selected in the list 
of categories and the list of attributes, the analogous values will be set in the corresponding fields of the 
window that opens. Any additional fields can be entered in the window, after which a new item with the 
specified parameters is created 
in the MDB by pressing the OK button. 

 — creates a new category or subcategory. A category is created within the current (selected) 
category. 

 — creates a new attribute, for example, adds a new performer or author. The new value is 
added for the current attribute, that is, the one selected in the list of attributes. 

 — are the standard item operation buttons: copy to the clipboard, paste from the 
clipboard, and delete the selected items. The access to the commands is determined by user rights, the 
clipboard contents, and the current status of the input focus. The operation is performed on the selected 
items of the current list (the one in the red frame). 

 — opens the standard item properties window. 

 — opens the MDB search window. This window differs from the standard search by a string 
window (that opens by pressing <Ctrl>+<F> key combination) in that it has more extended capabilities.  
The standard search window is also available in the list of attributes and in the item list. It opens by 
pressing the <Ctrl>+<F> key combination or the analogous button on the Tools toolbar of the main 
window of the DJin program. The rapid search window is also available; 
it opens by pressing the <Ctrl>+<S> key combination. 

 — refreshes the contents of the entire MDB window to the current database state. The 
modifications to the MDB performed from the other workstations are displayed automatically at the time 
intervals specified in the MDB settings. Pressing this button performs an unscheduled update of the 
window state. 

 — opens the MDB administration window. 
The dropdown list (Fig. 4.58) allows the displayed items to be rapidly filtered by the time they were 

added to the MDB. This is convenient when working with new items, for example, news or commercial 
items. 

 

Fig. 4.58. The dropdown list with the filter time criteria 
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The List of Categories 
The list of categories is located in the upper left part of the MDB window (see Fig. 4.56). If there are 
subcategories, the list is displayed as a tree. All categories available to the user under his rights are 
displayed in the window. The number 
of MDB items belonging to a given category is displayed in the Total column. 

Selecting a category in the list causes the contents of the item list change according to the selection 
conditions described earlier. In the general case, the list will display all items belonging to the selected 
category. It is possible to select several categories. This is done by clicking the categories wanted while 
holding down the <Ctrl> key. Clicking a category with the <Shift> key pressed selects 
all categories between the previously selected category and the one clicked.  

When several categories are selected, items belonging to all the selected categories are displayed 
in the item list. 

When category All is selected, all items belonging to the currently selected type are shown in the 
item list regardless of what category they belong to.  

The MDB allows an item to belong to more than one category. When an item 
is displayed in one line (e.g., in the item properties window), the categories 
to which the item belongs are separated by a semicolon. Consequently, this character cannot be used as 
a part of a category's name. The backslash is used 
in a subcategory name to indicate the parent category. This character also cannot be used as a part of a 
category's name. 

An item whose category is displayed as, for example, Metallica\Early hits belongs to the Early hits 
category located in the Metallica category. The item, however, does not belong to the Metallica 
category. If a category is explicitly assigned to the both categories, they are displayed as 
Metallica;Metallica\Early hits. By the way if the name of an added category contains "\" symbol 
it is interpreted as the nested set of categories, and all nested levels are automatically created in МDB. 

NOTE 
Adding an item to a nested category does not automatically add it to the parent category. These categories are 
totally independent. In some category lists belonging to different program windows, in which categories cannot be 
displayed as a tree, categories are displayed as simple lists with full names including the backslash separator. In 
this way MDB Jingle-type categories are displayed in the F-Categories and DM windows. This 
is due to the fact that the nested categories were introduced after these windows were created. Eventually, the 
design of these windows is also going to be modernized.  

The list of categories is the receiver for the Drag & Drop operations. Grabbing by the mouse a list of 
audio items in one of the DJin program window (for example, in the Files window or in the MDB window 
item list) and dropping it on a category in the category window (during the dragging operation, the 
receiving category 
is highlighted rose) produces different results. The categories of the items already added to the MDB will 
be changed. If the move was performed with the <Ctrl> key pressed, the category, onto which the items 
are dropped, is added to the list of the categories, to which the moved items belong. In other words, the 
items are simply added to the specified category. If the <Ctrl> key is not pressed during the dragging 
operation, the items are assigned only to the category, onto which they are dropped, with the information 
to which category they used to belong deleted. 
In other words, the items are moved to the specified category. 

The items that are not MDB items are added to the MDB to the category, onto which they are 
dropped. The new items will be assigned the selected value of the current attribute (e.g., Artists = 
Metallica). If the attributes window is disabled 
or the All attribute value is selected, the attributes of the added items are not changed. 
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After the dragging operation is completed, the selected category is not changed; accordingly, the 
contents of the item list are not changed either. This makes it possible to rapidly distribute items from the 
item list over the categories using the mouse. 

Right-clicking the category list opens its context menu (Fig. 4.59) which allows performing various 
important actions. 

 

 

Fig. 4.59. The context menu of the category list 

• Rename categories. Currently, the Category properties command contains only the category 
name. The name can be changed, which will affect 
all items belonging to the given category. 

• Create categories and subcategories. 
• Delete categories. Deleting a category does not delete the items belonging to it. These items are 

simply no longer shown to belong to the deleted category. Deleting a category does not affect 
items belonging to the other categories. 

• Items of the Jingle-type categories can be distributed over the jingle machine field (this 
command exists not in all program configurations). When this is done, all items of the selected 
category are distributed over the jingle machine buttons in the alphabetic order starting from the 
first one. The results can be seen in the jingle machine window (see Section 4.7.4). 

• Completely display or reduce the category tree. 
• Print out the contents of a category. 
• Estimate the usability of attributes in the given category (using Category info command). 
• Save the contents of a category (the list of all its items) as a text file. The file format can be 

configured. Selecting the Export selected categories 
to file command opens the DB contents export window (Fig. 4.60). 

 



Cooperation for Development of Hard-and Software 
for Audio and Video Broadcast Studios in East and 
West Europe. Design and Manufacturing of Studio 
Equipment  for the Audio recording Industry and the 

 

 
e.mail: info@tract.ru   e.mail : infor@barthkg.com  
 web :http//www.tract.ru   web : http://www.barthkg.com 
 

    

 

copyright: RBKG&TRC  Page 115 of 219 

in field of Video Postproduction. 

 

Fig. 4.60. The DB export window 

The file to be written to and the preset file format are selected in this window. 
If no preset formats are available or the file format needs to be changed, the DB export formats 

window (Fig. 4.61) needs to be opened. This is done 
by clicking the Edit format button. After the format is selected or edited in this window, the database 
contents are exported to the file. The export process 
is started by clicking the EXPORT button of the DB export window. 

 

 

Fig. 4.61. The DB export formats window 

Let's examine the elements of the DB export formats window (Fig. 4.61). 
In the right panel of this window, the user gathers the fields he needs 

to be saved to the text file. The fields are added by moving the field selected in the available fields list on 
the left to the list of the fields to be saved. The deletion from the list is done the other way around. These 
operations are performed using buttons marked < and >. Button >> adds all available fields to the list of 
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the fields to be saved; button << clears this list. The buttons marked ↑ ↓ change the order 
of the fields to be saved. 

Double clicking in the Sort column sorts the items being saved to the text file by the corresponding 
field (by the Name field in the example shown in Fig. 4.61). The parameters affecting the format the data 
are written to the file are set in the bottom part of the window. There are two methods to save the data: 

• Fields are delimited by separators. In this case, the selected fields are written to the file 
sequentially separated by the character specified in the Delimiter field. The length of the fields is 
not limited. The fields can 
be additionally delimited by the quotation marks. 

• Fixed-length fields. In this case, in the list of the fields to be saved, the length of each field in 
characters is specified. This is done by double-clicking the Width field. If the length of the stored 
field is longer than the specified, the extra characters are truncated. 

The names of the saved fields can be saved as a string at the beginning of the file, which facilitates 
reading and importing the file. 

A collection of parameter settings can be saved as a preset setting. This purpose is provided by the 
buttons and the list located in the top part of the window. The Save button saves the preset format under 
the name specified in the list. The Restore button sets the parameters of the file format into the state they 
were last saved under the specified name.  

The Select button completes the file format editing process. 

The Attribute Values List 
The list of the attribute values is located in the lower left part of the MDB window (see Fig. 4.56). This list 
displays the values of some attributes (parameters) of the items stored in the MDB. The selected attribute 
itself is displayed in the dropdown list; the list of all the values that the selected attribute of the current 
type MDB items can take on is located below this dropdown list. 

Analogous to the list of categories, the Total column of the list of attributes displays the number of 
items that have the given attribute value.  

Selecting an attribute from the list changes the contents of the item list panel on the right (the 
selection algorithm was described earlier). The same as with the categories, several attribute values can 
be selected from the list. In the general case, selecting one of the attribute values displays all the 
database items that have the selected attribute value in the corresponding attribute value list. 

Clicking on attribute value list column header changes the sorting order of the attribute values. 
Clicking on the Total column header sorts the attribute value list by the number of the MDB items with the 
corresponding attribute value. By default, the attribute value list is sorted by the attribute value in 
alphabetical order. The standard search window and the standard rapid search window can be called 
from the attribute value list panel. This is done by the <Ctrl>+<F> and <Ctrl>+<S> key combinations, 
respectively.  

The MDB allows an attribute to have more than one value. For example, the Artist attribute can 
have values Metallica; Pink Floyd. When a multiple-value attribute is depicted as a text string, its values 
are separated by a semicolon. Consequently, this character cannot be used as a part of the attribute 
value name.  

By default, the values of only two attributes can be displayed in the attribute list: the artist and the 
author. In addition, all attributes created by the user are displayed in this list. Creating user attributes is 
described in the MDB Administration subsection. 

The list of attributes is the receiver for the Drag & Drop operations. This works the same way as for 
the list of categories. Dropping a group of items by the mouse on an attribute value assigns to the 
dropped items the corresponding attribute value and, if they were taken from outside the MDB, adds them 
to the MDB. The behavior of the Drag & Drop operation can be changed by holding down the <Ctrl> key. 
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Right-clicking the attribute list opens its context menu (Fig. 4.62). 
 

 

Fig. 4.62. The context menu of the attribute list 

The following operations can be performed using it: 
• Rename attribute value. For example, an error in the author name can 

be corrected. This affects all the MDB items of the current type that have the given attribute 
value set. 

• Add new attribute value, for example, add a new author. 
• Delete selected attribute values from the MDB. This operation affects 

all items that use the attribute value being deleted. The deleted attribute value (e.g., the value 
Metallica for the Artist attribute) is removed from 
all MDB items. 

• Refresh. The performed operation is analogous to the action performed 
by the  toolbar button. 

The Item List 
The item list is the main part of the MDB module window. It displays the items meeting the selection 
criteria defined by the category and attribute lists and by the specified filter. 

Sufficiently voluminous information about an item can be displayed in the item list. The list of all 
columns that can be displayed can be reviewed by opening the List customization window. The window 
is opened by right-clicking the MDB window title. In this window, the number of the displayed columns, 
the order 
in which they are displayed, and their size can be changed (see Section 4.10.6). 

The items in the list can be sorted by the values of a column by left-clicking the corresponding 
column header. With the help of the filter window located in the upper part of the MDB window, the list 
items can be sorted by a specified string that the parameter selected for filtering must contain. Fig. 4.63 
shows a filtered list of all items containing the word "love" in their name. The example corresponds 
to the situation when the Display artist in the Title column parameter is enabled in the settings of the 
DJin program (see Section 4.12.1, section Interface, tab Other).  
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Fig. 4.63. An example of a filtered item list 

The item list is both a source and a receiver for the Drag & Drop operations. The selected items can 
be dragged from the list by the left mouse button.  

The Drag & Drop method can be used to perform the following tasks. 
• Copying or adding the selected items to other system modules, for example, to add an item or 

items to a player or a schedule. Note that dragging items by the mouse to other system modules 
never change the source items. Dragging items to other system modules is analogous 
to executing the following sequence of operations: 
o Copying the selected items to the system clipboard using the context menu or the toolbar 

button 
o Switching the focus to the receiving list (a schedule, for example) 
o Executing the Paste operation using the context menu or the toolbar button 

• Changing an item's category or attributes. This is done by dragging the selected items to the 
category list or the attribute value list and dropping them on the necessary category or the 
attribute value. The operation results can be modified by holding down the <Ctrl> key. Dragging 
and dropping items with the <Ctrl> key pressed adds the items to the specified category or adds 
the specified attribute to those the item already has. Dragging and dropping items without the 
key pressed changes the items category to the specified or sets only the specified attribute. The 
Drag 
& Drop method can be used to rapidly edit the MDB contents visually without resorting to the 
keyboard. This makes it possible to avoid making errors in the author and category names. 

When items are dragged and dropped onto the item list, or when the equivalent Paste operation is 
performed in the list, the items are added to the MDB. The new items are added to the categories that are 
selected in the category list at the moment the operation is carried out and are assigned the attribute 
values that are currently selected in the attribute value list. This method makes it possible to add new 
items with the necessary parameters rapidly and without errors. 
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There is another operation that can be carried out using the Drag & Drop method. Frequently, an 
item is added to the database without being linked 
to a specific audio file or text file. This is characteristic, for example, for the commercials or news items. 
This creates a task to associate the MDB item with 
a file. In principle, this can be done from the File tab of the Objects Properties window. But using this 
method entails executing many operations: opening the Properties window, selecting the File tab, calling 
the file selection dialog window, finding the file, and closing the window. The MDB provides a more rapid 
and simple way of assigning a file to the item. With this method, the item with the needed file name is 
simply dragged from any window (most often, from the File window) and dropped on the MDB item that 
needs to be assigned or changed the file name. During the operation, the <Ctrl> key needs to be kept 
pressed and the item's source cannot be the item window. In the process the mouse pointer will look like 

this: . 
As a result, only the receiving item's file name and the linked marks will change. The source item 

will not change at all. 
Right-clicking an item on the list opens the item context menu (Fig. 4.64). 
 

 

Fig. 4.64. The list item context menu 

Almost all operations executed using the commands of the menu were described earlier. Move to 
another category, type, archive command allows 
to make the transfer to a specified category of another type, for this purpose it the user will be offered to 
select the type category in Selecting category a window. The Set air date allows indicating a prospective 
date of airing for novelties of MDB, the Send to archive sends the item to file archive, and the Toggle 
ready for air command does not need explanations. 

The Object properties opens a standard item properties window, however, here they are edited as 
MDB item properties. 

It remained only to explain the function of the Advanced submenu and the Delete command. 
If prior to executing the Delete selected objects command a category other than All was selected 

in the category list, executing this command will open 
a supplementary menu shown in Fig. 4.65. 
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Fig. 4.65. The supplementary menu 

Selecting one of the menu options, the selected items can be removed from the current category 
but kept in the MDB or removed from the MDB altogether. 

The Advanced submenu opened by the Advanced command (see Fig. 4.64) is shown in Fig. 4.66. 
Let's consider the functions of its commands. 

 

 

Fig. 4.66. The Advanced submenu 

• The Move to group serves to change the type (section), to which the selected items belong. The 
type-change operation moves the selected items from the current section to the one specified in 
the submenu. Moreover, 
all attributes of these items (the author name and all attributes added 
by the user) and the category affiliation are cleared.  

• The Copy to command calls the file converter window, allowing selected MDB item to be copied 
to the assigned place. 

• Export selected objects to file and Print selected objects commands do not need 
explanations. 

• Set radio station command is described in subsection Working with Several Radio Stations. 
• The next three commands serve to edit various parameters of the audio file, linked with the item, 

without resorting to the Properties window. 
o Edit marks… opens the mark editing window. 
o Clear all marks …clears all marks. 
o Normalize normalizes the audio item by pulling its level up to the desired. 

These operations are carried out for all selected audio items. 
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• The functions of the Clear file link and Change file link commands are self-explanatory: the 
former clears the file link, the latter, on the contrary, selects it. The file link can be cleared for all 
selected audio items; however, the assignment is made one item at a time. 

If connection with MDB is lost for some reasons, the item list context menu will be essentially 
reduced. 

The Specifics of Adding and Deleting MDB Items 
What happens when a new item is manually added to the MDB, for example, when copying by dragging 
or using the clipboard from the Files module? 

Even before the item is added to the MDB, it can have certain attributes preset. For example, it can 
have the author, the artist, and the category, as well 
as some other parameters preset. If All is selected in the list of categories and 
in the list of attributes, that is, the attributes for the added item are not set explicitly, the search for the 
preset attributes is first conducted in the MDB. If these values are absent in the MDB, for example, there 
is no specified artist, a request 
to create a new attribute value is issued (see Fig. 4.67). 

 

 

Fig. 4.67. A request to create a new attribute value 

If the user agrees to create a new attribute value, it is added to the MDB and saved in the item 
properties. If the user declines to create a new value, 
it is removed from the properties of the given item. Pressing button Cancel interrupts the operation of 
adding a new item. 

If the attribute values are already present in the MDB, they are saved for the item without issuing 
any warnings.  

A request similar to the one shown in Fig. 4.67 is also issued if the user opens an MDB item 
properties window and modifies the attribute value manually 
by specifying a missing MDB value. This concerns only those MDB item parameters that are displayed in 
the attribute list and the category. All other parameters (for example, comments or RS232 commands) 
are stored in the database unchanged. 

If an audio file is linked to the item being added, it will be automatically copied to the global file 
storage. 

The global storage is a collection of the file system folders, to which the program automatically adds 
files when an item is added to the MDB. The specific folder, to which the file will be copied, is specified by 
the configuring the settings 
on the Audio storage tab of the Global settings window The window is accessed through the Service > 
Global settings menu sequence.(See Section 4.12.2). The file is also copied when it is assigned or 
changed in the audio item properties window or when the Change file link command of the item list 
context menu 
is executed. 

The file is not copied in the following cases: 
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• It is already in the global storage (even if its location does not correspond to the settings 
configured through Service > Global settings > Audio storage). Files are distributed over the 
folders of the MDB global storage only when added for the first time, and their location in the 
storage never changes. 

• The file is stored in the external storage folders specified in the settings 
in the Base settings - External storage directories category on the Other tab of the Global 
settings window, which can be accessed through the Service > Global settings command 
sequence (see Section 4.12.2). 

• There is already a copy of the file being added in the storage. 

When an MDB item is deleted, the file linked with it is not automatically deleted because 
theoretically this file can be used by more than one MDB item. Also, there could be copies of the deleted 
MDB item in the schedule. To scan the entire base every time an item is deleted to determine whether the 
file associated with it is used by any other items is a very resource-demanding and time-consuming 
process. Files that are not referenced from any of the DIGISPOT® II system modules, including the MDB 
module, are deleted by a special function called from the DIGISPOT® II DJin program main menu by the 
Service > Delete unused material command sequence. 

There is no Undo function for the MDB; however, there is a function to restore deleted MDB items. 

Administering MDB 
The MDB is administered by the system administrator; regular users must not have access to the MDB 
operating parameters. 

The database settings window is opened by pressing button  on the MDB toolbar. At that the 
DB Settings opens (Fig. 4.68) (Settings button and tabs 
of DB settings window, except for the Appearance tab which is inaccessible for users.  

Following is a description of parameters of the DB settings window. The Settings button calls 
ODBS Settings window which contains connection to MDB parameters MS SQL (Fig. 4.69). Except for 
name and password the name of DB owner should be indicated here (for DB owner name, determined by 
MDB itself the empty line must be kept). 

The number of flags that define the MDB appearance and its main editing operations behavior are 
grouped into categories: View, Radio station toolbar, Decentralized distributed DataBase toolbar 
and Additional.  

View group: 
• The Show object types parameter enables/disables displaying the list 

of the object types. The object type list contains the same items as the type-switching button on 
the MDB window toolbar. The flag can be used 
as an alternative to the toolbar. By default, the flag is cleared. 

• The Show attributes flag defines whether the attribute list is displayed 
in the MDB window. By default, the flag is cleared. 
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Fig. 4.68. The DB settings window 

 

Fig. 4.69. The ODBS Settings dialog window 

• The Show ‘Filtering by air date ’ button - operates displaying of sorting 
by airing date button; by default the flag is cleared. 

In the Radio station toolbar there are the parameters connected to storage of materials of several 
stations in one MDB. It contains the following parameters: 

• Show radio station toolbar. Displays a supplementary toolbar with buttons that enable or 
disable viewing the material of the corresponding radio station. By default the flag is cleared. For 
example: . The material not assigned to a specific radio station 
is always displayed.  There are only two radio stations in the picture: Radio Region and Radio 
Peter. Currently, only the material belonging to Radio Peter is displayed. 
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• All radio stations are visible when toolbar is hidden does not need explanations. By default 
this point is selected.  

Decentralized Distributed DataBase (DDB) toolbar. The parameters of this group are used when 
the complex operates as a part of several MDBs joined into one system over the Internet by the DDB 
agent utility (see Section 2.3.2). There 
is only one flag in this group: Show "neighbor's" toolbar. By default it is cleared. Shows a 
supplementary toolbar analogous to the radio station toolbar but with the buttons to enable or disable 
displaying the remote stations. 

Additional group. This group comprises flags that define the MDB behavior 
in various situations. The functions of the first three flags are clear from their names. The Start search on 
button press flag modifies the behavior of the filter located at the top of the item list. If the flag is cleared, 
the contents of the item list are changed automatically when the contents of the filter window change. 
Generally, this is a convenient feature. However, when a large list is filtered (tens of thousands and more 
items) the filtration time becomes noticeable and interferes with entering text. In this case, it is advisable 
to set this flag. This will cause the filtration to start only when button  is clicked or when the input 
window loses the focus. 

 

 

Fig. 4.70. The DB administration window, tab Common 

The DB Settings window has five tabs that can be used not only to configure parameters but also 
to perform certain operations. 

The Common tab of the DB administration window 
On the Common tab, the system parameters of the MDB operation are configured.  
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• Query portion size. The greater this number is, the faster the information is read from the 
database, but the longer it takes to process one portion 
of data. It is a good idea to decrease this number if the graphical interface gets noticeably 
sluggish when reading from the database. The more powerful the processor, the larger this 
number can be. 

• Auto update period. This is the time interval, at which the computer accesses the MDB to 
detect modifications made from the other workstations. It affects how expeditiously the 
modifications made at the other workstations are reflected at the given workstation. The 
modifications made at the given workstation are reflected right away. 

• Ask confirmation parameter group is responsible for capability of setting queries for deleting 
audio items, attributes and also for changing audio item’s and attribute’s types, creating a new 
categories and new values 
to be add. 

• Enable modifying "neighbor's" material and Enable deleting "neighbor's" material. The 
functions of these parameters are clear from their names. 

The Attributes and their values tab of DB Settings window  
The Attributes and their values tab (Fig. 4.71) of the DB Settings window serves to administer the 
attributes and their values. 

 

 

Fig. 4.71. The Attributes and their values tab 

The toolbar allows working with attributes of different types of the material. Settings for different 
types are entirely independent of each other. 
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The context menu of the attribute list (shown in the left part of the window) can be used to create, 
rename, and delete attributes. The first three attributes, shown in bold, are standard and cannot be 
changed by the user. 

The list on the right displays the collection of the selected attribute values. The context menu of the 
attribute list can be used to delete, add, and rename attribute values. The values of both the standard and 
the user attributes can be modified. 

The Deleted objects tab 
The Deleted objects tab (Fig. 4.72) serves to administer remote items of the MDB. 

 

 

Fig. 4.72. The Deleted objects tab 

When an item is deleted from the MDB window, it is not removed physically but is simply marked as 
deleted. The information about it is retained in the MDB. 

Using this tab, the administrator can restore in the MDB the items deleted earlier or, on the contrary, 
remove them for good. These operations can be carried out using the buttons in the top part of the 
window or the context menu. When 
a deleted item is restored, all its attributes are preserved. 

The Radio stations tab 
The Radio stations tab (Fig. 4.73) serves to administer the radio stations. 

The administered radio stations are the radio stations using the common MDB to store their 
materials. Using the context menu or the buttons in the top right part of the window, the administrator can 
create, rename, and delete radio stations. 

This is usually done during the configuration stage but can also be carried out at any other time. 
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Fig. 4.73. The Radio stations tab 

The radio station color can be selected by clicking the rectangle on the right 
of the list item. All MDB items belonging to the corresponding radio station will 
be marked this color. An MDB item can either belong to only one radio station 
or not belong to any.  

The Export tab 
The Export tab is shown in Fig. 4.74. 

This tab contains the options of the DB export window described earlier (see Fig. 4.60). In addition, 
the flags determining the MDB part to be exported to a text file are located on this tab.  

The tab serves to archive the MDB (make its reserve copy). It can also 
be used to create files of full or partial copies of the MDB for other programs. 
All saving presets created earlier are available.  

Utils tab of DB settings window 
The Utils tab realizes the opportunity of updating of two MDB fields zero values. 
It is recommended to consult with experts before start of process. 

Joint Operation of Several Stations with One Database 
The following is a description of storing materials used by several radio stations in one database. 

Such situation may arise when an MDB is used 
to automate the operation of a complex of radio stations, for example, a radio station holding or a 
company owning several broadcasting frequencies. 
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Fig. 4.74. The Export tab 

What is the need to combine the material of several radio stations in one database? This makes it 
possible to centralize material storage and to simplify the administration and maintenance of the system. 
For example, all radio stations can have a unified news-gathering or commercials center, in which the 
materials being prepared are sorted as shared and belonging to specific stations.  

In conformance with the MDB principles, its items can either belong to only one radio station or not 
belong to any radio station at all. Items that do not belong to any radio station can be shared for viewing 
and editing by all radio stations.  

What items can be shared by all radio stations? Items like news, commercials, and perhaps a part 
of the music archive (when the musical styles of the radio stations overlap). On the other hand, some 
news and commercials can have only one owner. 

Depending on the system configuration, either only the shared items can 
be displayed on a workstation or the shared items and those belonging to one 
or several radio stations. To select the items to be displayed, the system administrator opens the radio 
station toolbar and selects the necessary stations. Then he can either hide the toolbar or leave the radio 
station switching feature available to the regular users.  

When one administrator configures the radio stations, materials belonging 
to different radio stations should be displayed in different colors. This makes 
it easier to determine what radio station the material belongs to.  

Access to the material belonging to the other radio stations should be disabled at the broadcasting 
workstations. On the contrary, the scheduling and information collection workstations should be able to 
view the information belonging to all the radio stations. Material affiliation to one or another radio station 
can be changed from the Object properties window. The affiliation of a group of selected items can be 
changed from the item list context menu. The radio station, to which the material is to belong, is selected 
in the Set radio station window (see Fig. 4.75). It opens by executing the Set radio station command in 
the Advanced submenu (see Fig. 4.66). 
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Fig. 4.75. The Select radio station window 

Configuring User Access Rights 
User access rights are configured on the DB objects of the Administration window, which opens by 
executing the File > Administration command sequence in the main menu. 

The DB objects (Fig. 4.76) becomes available only after MS SQL connections are made in the 
ODBC settings window (see Fig. 4.69). This tab displays all the types and categories of the MDB 
material. In the list's columns the following operations are enabled or disabled: creating, deleting, editing 
and viewing certain type of the material. 
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Fig. 4.76. The DB objects tab of the Administration window 

The enabled operation is indicated by a check mark in the corresponding column. The check mark 
is placed by clicking the corresponding check box. 

Operations are enabled at the same time for all users with equal rights. Operations are enabled 
hierarchically: By default, when viewing Music material 
is enabled, the users receive rights to view all categories of this type, including those created after the 
system was configured. Permissions can also be set explicitly. 

The symbols for the automatically set permissions are depicted on the gray background; those for 
the manually set permissions are depicted on the white background. 

There is only one explicit permission, shown in Fig. 4.76: for viewing music. 
All operations with the other types of the material are explicitly disabled. 

The access rights to the material categories are defined by the access rights set for the material 
type. As a result of such configuration, all DJs group users can view only the musical contents of the 
MDB; the rights to modify its contents they have not. Of course, a group user can add an item to a player 
and change it in the player, by, for example, setting the playback starting point or splicing it with the 
previous item. 

4.9. The Auxiliary Systems and Modules 

4.9.1. The Prefade Listen System  
To control the contents of audio items, a way is needed to listen to them without the sound going to the 
program's main output. This task is addressed by the prefade listen (PFL) system.  

Only one item can be played using the PFL window; a crossfade between two or three items can be 
prelistened in the schedule or in a player queue. 

An item can be prelistened in several ways: by selecting the PFL command 
in the context menu, by pressing the keyboard key assigned to this action (the spacebar by default), or by 
pressing button  on the Item tools toolbar. The command to prelisten an item can also be called from 
an external button field.  

Pressing the spacebar invokes the prelisten function practically in all modules of the system. 
A crossfade between items can be prelistened by selecting the PFL crossfade item of the context 

menu, by clicking button  on the Schedule tools toolbar, 
or by pressing the assigned hotkey (<C> by default). 

During prelistening, a two- or three-item sequence is played back in the PFL window (Fig. 4.77). 
The playback of a crossfade is started with the end of the first item three seconds prior to the start of the 
playback of the next item and continues until the end of the last item. If the prelisten function is called for 
a jingle or a voice track item, three items are loaded into the PFL window: the item preceding the jingle, 
the jingle, and the item following the jingle. The playback is started from the end of the item that precedes 
the jingle. The names of all items being played back are displayed in the PFL window preceded by the 
word CROSS (Fig.4.78). 

 

 

Fig. 4.77. An example of the PFL window for one item 

The PFL window opens in the list in place the item that is prelistened. 
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Fig. 4.78. An example of the three-item crossfade PFL window 

The PFL windows for one item and for a crossfade are controlled identically. 
The name of the prelistened item or the names of all crossfade items are displayed in the PFL 

window. In the leftmost part of the window, the playback position is displayed. The already played part is 
depicted by the darker color. 

The prelisten playback is controlled by the mouse or the keyboard. Clicking the mouse on any part 
of the playback window moves the playback to that position. The following keyboard keys are used to 
control the PFL playback: 

• Arrows <left> and <right> move the playback position in the direction 
of the start or the end, respectively, three seconds from the current position. 

• Arrows <up> and <down> move the playback position similarly, but with the 10-second step. 
• Pressing the <Home> key moves the playback to the beginning. 
• Pressing the <End> button moves the playback to the point 5 seconds before the audio item's 

end. 
• Pressing the <T> key switches the playback indicator to the countdown mode. 
• The window can be closed by pressing the spacebar or the <Esc> key 

or by clicking the mouse anywhere on the screen outside of the PFL window. 

There are some peculiarities in the way the PFL window operates. If the user does not press any 
key or does not intervene with the mouse during the entire PFL playback process, the window closes 
automatically when the playback ends.  

If the user intervenes into the playback process, the window closes 5 seconds after the PFL 
playback ends, unless during this time the user starts the playback again. 

The PFL window can be maximized. An example of the maximized PFL window is shown in Fig. 
4.79. 

 

 

Fig. 4.79. The maximized PFL window 

Switching to the maximized mode and back is done by pressing the <Ins> key. 
In the maximized mode, the PFL window displays the descriptive and reference information about 

the prelistened audio item and about its file. In this mode, the window cannot be closed by clicking the 
mouse outside of it. The playback in this mode is controlled the same as described earlier. 

The PFL window opens in the mode it was in when it was closed the last time. 
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An audio item (not a crossfade) can be prelistened in the following ways: 
• The PFL window for prelistening the start of an audio item is opened 

by pressing the <Ctrl>+<Space> key combination. If the user does not intervene into the 
playback process, the playback window will close after 
5 seconds of the playback. 

• The PFL window for prelistening the end of an audio item is opened 
by pressing the <Shift>+<Space> key combination. The playback of the last 5 seconds of the 
audio item starts. If the user does not intervene into the playback process, the playback window 
will close after the playback ends. 

Practically all program modules and windows that contain audio items have the capability to call the 
PFL window. Moreover, the module may not have a special context menu item to call this function: By 
default, the PFL is called by pressing the spacebar. 

Note that the PFL is disabled by default. To enable it, the playback device must be specified by 
executing the Service > Settings > PFL command sequence.  

The PFL can be configured to the following three modes:  
• Disabled. The PFL window will not open. 
• Autoselection. This configuration requires that the DIGISPOT® II system have the capability to 

be controlled from the broadcast console control rows and to receive information about their 
state (to be more specific, the information about the CUE/FPL mode being enabled on a control 
row). With the PFL operating in this mode, the program finds the first control row with the PFL 
enabled and currently in this mode, and starts the playback via this row. If there are no available 
control rows, the PFL does not start. For this mode, to work, in addition to selecting it, 
supplementary configuration strings need to be entered into the configuration file. 

• To the specified channel. The playback device can be specified explicitly. 

In last versions of the program the opportunity of multichannel prelistening 
is realized. To switch on the simultaneous listening of several channels mode 
is possible with the help of Enable multichannel PFL parameter of PFL tab 
of Service menu - Settings. 

The PFL system can also issue certain control commands by itself when its window closes or 
opens, for example, to switch a certain console control row into the PFL mode. 

Previewing Text  
If the item, selected when the PFL was called, is a text item in the schedule 
or in some other module (references a text file or a subject file), the Text preview window (Fig. 4.80) 
opens instead of the PFL window. 
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Fig. 4.80. The Text preview window 

The name of the item is shown in the upper left part of the window; in the upper right part, shown is 
the approximate time necessary to read the text.  

The text in the window can be printed out using the context menu. 
The text font is selected by executing the Service/Settings/Text/Fonts menu sequence. 
When displaying an RTF file, its text is reduced to the specified font with 

all specified in the file formatting (font type, size, etc.) ignored. 
The Text preview window is closed by pressing either the <Esc> or <Enter> key. 

4.9.2. The Administration System 
The administration system is intended for setting the access rights of the DJin users. By default, the 
administration system is disabled and all users have full access to all DJin functions. The administration 
system is enabled by creating user groups and users belonging to these groups. This is done from the 
Administration window, which is called by executing the File > Administration command sequence 
(see Section 4.11.1). All the users belonging to one group have equal rights. Operations permitted for the 
group users are specified by enabling 
or disabling specific operations in the list. 

Each user is assigned a login and issued a password. The administrator login and password are 
specified separately. The administrator is a user who has full access to all system functions including the 
administration system.  

User MDB rights can be limited by specifying the types and categories of the material the user can 
access. User MDB access rights are configured on the 
DB objects tab of the Administration window, which opens by executing the File > Administration 
command sequence in the main menu (See Section 4.11.1). The administration system settings are 
applicable to all the workstations of the system with the common ROOT, meaning these are global 
settings.  
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When users have been created, at the system start a typical registration window opens, in which 
the user has to enter his login and password. 

Users can also register automatically using a predefined login and password. In this case, the 
registration window does not show. The name of the current user is shown in the title of the program's 
main window. The current user can 
be changed by executing the File > Login command sequence. 

4.9.3. The On-Air Log-Generation System 
The on-air log-generation system is intended for recording information about the broadcasted schedule 
items to a text file. For each 24-hour period, a file named YYYY-MM-DD.LOG is created in the specified 
folder, in which the information about the broadcast items is stored. The folder, in which the file is created, 
can 
be specified on the Log tab of the Settings window (see Section 4.12.1, Log tab). 

The information about one item is recorded in one line as text fields enclosed in quotation marks 
and separated by commas. The fields to be saved to the log file can be specified on the Log fields tab of 
the Settings dialog window (see Section 4.12.1, tab Log fields). 

By default, all available fields are recorded. These log files can be opened 
in the PL_PRINT.EXE report printing program and printed using a predefined report template. 

In addition to the audio item description fields, the item airing time, the duration of the aired part, 
and the information about the part of the audio item played back to the closed playback channel is saved 
to the file. This information can be used in the future to print a report. The information from the file can 
be imported into an MS Excel file. 

4.9.4. The Printing System 
The printing system provides the facilities for printing various template-based reports. The following can 
be printed: 

• Schedules and skeletons (complete or just the selected blocks). 
• The contents of the F-Categories according to the current sort mode. 
• The contents of the MDB window list according to the current sort mode and the complete 

contents of the specified categories. 
• Reports about the played back schedule items. 

The format of the printed reports is determined by a print template file (with the RPL or RPT 
extension). The system has several predefined print template files. The contents of the documents to be 
printed can be previewed. The print templates can be edited by the user. The user only needs to know 
the template file format and how to use any word processor. 

For example, a schedule is printed by pressing button  in the Schedule window and selecting 
the Print command in the service menu. This will open two windows one after another: 

• The Print schedule window to select the print template from 
• The pl_print window to preview the printed document 

Selecting the Print command in the File menu of the pl_print window opens the standard MS 
Window print settings window. 

4.9.5. The Local Disk Data Reserve System 
The reserve system module solves two tasks: continuing broadcasting in case 
of the communication line (LAN, VPN) failure and delivering audio material to the playback workstation. 
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The reserve system works as follows: all audio files in the schedule are automatically copied to the 
local disk of the broadcasting workstation. The copying is carried out in the background. When a file is 
due to be played back in a player, the system checks if there is a local copy of this file. If a local copy 
exists, it is used for the playback instead of the remote file. When the original file is changed, the system 
automatically updates the local copy. 

The reserve files are kept for two days, which makes it possible to avoid repeated copying of 
frequently used files. Consequently, provided the reserve system is properly configured, the broadcasting 
is never done over the network, which is used only for copying files in advance. In addition to the files, the 
schedule itself is also copied. Thus, should there be a network failure, the broadcasting station will still 
have both the schedule and a supply of audio files for at least 
24 hours of broadcasting. When the connection with the remote server is restored, the local schedule is 
automatically synchronized with the main one. 

When low-speed communication channels are used to connect the broadcasting workstation to the 
data server (e.g., the Internet), the reserve system makes it possible to copy all the necessary files to the 
broadcasting workstation 
in advance to the actual broadcasting. In particular, broadcasting can be organized even if the channel 
throughput cannot support real-time broadcasting in cases where the volume of the transmitted material 
is limited. For example, suppose that there are only 10 minutes of commercials per hour of broadcasting 
for 
a retransmission station and the channel throughput is half the playback rate 
(64 KB/s). It will take 20 minutes to transmit 10 minutes of audio. But if the schedule is prepared, for 
example, 24 hours in advance (which in case 
of commercials is possible), the necessary files are guaranteed to be downloaded 
to the broadcasting computer before they are due to be aired. 

The backup system is configured in the Reserve system status window (see Section 4.12.8). The 
window is opened by executing the Service > Reserve system status command sequence. A reserve 

copy is created by clicking button  in the Schedule window and then selecting the Reserve command 
in the window that opens. 

4.9.6. The System to Merge Schedules to Audio Files 
The schedule-merging system files allows a schedule or its parts (only specified blocks or time slots) to 
be exported to a single audio file of a standard format. The export process is identical to the automatic 
schedule playback process but happens at much faster fate. The attributes of the blocks and audio items, 
the crossfades, and other aspects are taken into account the same as in the playback process.  

The parameters of the merging procedure are configured in the Merging schedule audio items 
into audio file window (Fig. 4.81). The window is opened by clicking button  in the Schedule window 
and then selecting the Merge 
to audio file command in the window that opens. 

Merging schedule audio items into audio files has a number of settings, a part of them are 
understandable intuitively. In the upper right corner of the Block selection group, the buttons to select 
blocks to merge are located. For example 
a commercial/news schedule can be saved as a set of audio files where each file 
is a ready commercial/news block. 
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Fig. 4.81. The Merging schedule into audio file window 

The Audio files properties group of parameters sets a file (files) format 
in which the material will be imported. The Save in directory settings group defines the location of 
created audio file (files). The group Merge into new file when next schedule block is starting operates 
process of formation of one 
or more files from the schedule, and also conditions of the beginning / finishing 
of the next file. In the Info group the information concerning an accessible place 
in selected for saving of the created audio file catalogue is performed and also presumable duration of 
this file taking in account selected format for audio compression. Other parameters do not need 
explanations. 

Specifying the From (HH:MM) and To (HH:MM) time parameters of the merged blocks in a proper 
way, a schedule can be saved, for example, as twenty-four audio files each one hour long. 

The format of the audio file is selected in the window that is opened by button  located in the 
Audio file properties group. Clicking the same button in the Save in directory group opens the 
standard folder selection dialog window. 

The process merging the schedule into audio file is started by pressing the Start button.  
The schedule-to-audio files merging system can be used most effectively 

in news or advertisement agencies, as well as in the centers of network radio stations. The files produced 
by the export process are sent to the other radio stations as ready clips that can be aired fully or partially 
by practically any automated broadcasting system. This makes it possible to use a single material-
production system combined with a complex of different broadcasting systems. 

4.9.7. Module to Import Schedules from Text Files 
This module imports schedules from a text file that was created by another schedule generation program, 
for example, the Power Gold music rotation system. 
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Practically all large radio stations using the DIGISPOT® II system import some schedule parts from 
outside systems. For example: 

• On the Europe+ radio station, the music is imported from the Selector system and the 
commercials are imported from their own commercial schedule-generation system. 

• On the Alster radio station, the music is imported from the Power Gold system and the 
commercials are imported from the DJin Commercials system. 

• On the Berlin's RTL radio station, the music is imported from the Selector system and the 
commercials are imported from the Meridian system. 

The configuration of the import system and the import process itself are described in Section 4.10.8 and 
Section 4.4.4, respectively. 

4.9.8. The Gap Filler Module 
The gap-filling technology is required in situations where fully or partially autonomous broadcasting is 
conducted in automatic mode. When a non-scheduled gap occurs in the schedule (due to, for example, a 
communication line break 
or a schedule error), the module automatically prepares a short schedule fragment from the items stored 
in the MDB, which fills the gap until the scheduled broadcasting can resume.  

Different algorithms are used for filling long (over several minutes) and short (up to several 
seconds) gaps, which provides for the most even filling of the unscheduled gaps. 

The system administrator can configure different gap-filling parameters for different-length gaps, 
specifying the types, filling templates, and other parameters. The efficiency of the module configuration 
can be depicted as a diagram. 

As already said, the gap-filling module serves to automatically generate schedule fragments. This is 
an auxiliary system that makes it possible to avoid pauses when broadcasting in the automatic mode. 
(Gaps can occur when, for example, some schedule files become unavailable because of a network 
failure 
or a breakdown of the computer, on which they are actually located. Another cause may be an error 
made when preparing the schedule, as a result of which a block has less material than is needed to fill its 
allocated time.) 

NOTE 
The gap-filler module requires an MDB to function. 

The module starts generating the schedule fragment when during the schedule playback, the 
program reaches a block that has the No sooner flag set but whose airing time has not arrived yet. In this 
case, the program automatically generates 
a schedule fragment long enough to fill the gap between the end of the last available audio item and the 
start of the first audio item from the block with the time check point. 

The Gap and content filler setup window (Fig. 4.82) opens by the Gap filler system setup 
command of the Schedule window menu (the menu 

is accessed by clicking button ). The window has three tabs. The Gap filler and Content filler differ 
only in their names; therefore, only one of them is shown 
in the figures. The third tab, General settings, is not shown either, because it has only one input field: 
Use Content Filler for gaps longer than __ seconds. 
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Fig. 4.82. The Gap and content filler setup window 

The system employs two algorithms: one for filling short gaps (called Gap filler) and one for filling 
long gaps (called Content filler). 

A database category list must be specified for each algorithm. For this, the following sequence of 
steps needs to be executed. First, the Category settings for time frames window (Fig. 4.83) is opened 
by double-clicking in the work area 
of the Gap and content filler setup window. 

 

 

Fig. 4.83. The Category settings for time frames window 

Next, the Add button is clicked. This action opens the Select category window (Fig. 4.84), in which 
the category is added to the list.  
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Fig. 4.84. The Select category window 

Thus, the database category list is specified for each algorithm. The difference lies in how the Gap 
filler and Content filler algorithms use the data from the specified category list.  

• The task of the Gap filler is to cover a short gap in the most precise way. Consequently, in order 
to cover a gap this algorithm selects from the available audio items the one most fitting by size.  
If one audio item is not enough, a sequence of audio items is created; the audio items in the 
sequence can be taken from any category specified in the list. Only the last airing time and the 
duration of the audio items are taken into account. 

• The Content filler algorithm employs the specified sequence of categories as a template, based 
on which it fills the gap by selecting one audio item from each of the specified categories until 
the gap is filled. The last airing time and the duration of the audio items are also taken into 
account when selecting the audio items. 

Both systems can be configured differently for different days of week and for different time frames 
within a 24-hour period. 

The threshold duration dividing the algorithms is configured on the General settings tab of the Gap 
and content filler setup window. 

So, the DB categories list is specified in both algorithms settings. A difference is how algorithms 
Gap filler and Content filler use the data from the specified categories list. 

There is the Diagram button on Gap filler and Content filler tabs, displaying the Filler versus gap 
duration dissipation window. This window allows estimating visually the equation of musical base from 
the point of view of the possible conflicts solution (the number of audio items with various lengths are 
displayed with the help of the bi-dimensional diagram). 

The Schedule module differently displays the audio items obtained by various filling of unscheduled 
gaps algorithms. Results Gap filler and Content filler operation are marked now with different marks Af 
and Ac respectively. 

4.10. The Auxiliary Windows  

4.10.1. The Audio Item Properties Window 
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The Properties dialog window (Fig. 4.85) is opened by executing the Properties command in the context 
menu of the Schedule window. The Properties window has several tabs whose number varies, the exact 
number depending on the type 
of the selected item. The window can have the following tabs: General, Attributes, Remote control, 
MAG, Comments, File, Marking, Other and Extended.  

Note that at absence of properties editing rights the Item Properties window will be called in any 
case but fields will be blocked for editing (earlier the window itself was inaccessible). 

NOTE 
All settings set in this window pertain only to the selected item of the specific schedule and in no case are permanently applied 
to the file as such. 

The General Tab of Properties window 
The General tab is shown in Fig. 4.85. 

 

 

Fig. 4.85. The General tab of the Properties window 

• File name. Contains the path to the folder where the file linked to the item is stored, and the 
name of the file.  

• Format. Describes the file's audio format. 
• Name. The name of the schedule item. Can be changed. 
• Category, Artist, Author, Media, Track, and Album. These fields contain the information 

determining the audio item's location in the database. Automatic filter can be used as the tips to 
fill these fields. Only those lines which fit to the typed letters are submitted in the dependent list, 
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for example if in the line Artists type three letters, in the list appeared all artists whose names 
with these three letters begin are present. If type “*” following the same three letters all artists 
whose names contain these three letters in any place of this line are shown in the list.  

• Duration. Item's duration. For pauses and inserts, the contents of this field can be edited by 
setting, for example, the desired duration of the microphone insert. 

• Time. The item's scheduled airing time. 
• Broadcasted. This field indicates the fact that the schedule item has already been broadcast. 

This flag is set by the player in the process of playing the schedule. If the flag is set, the Time 
field shows the actual time the item's playback started.  

• Loop playback. Loops the playback of the entire item. 
• Loop outro. Loops the playback of the item's end. 
• Auto start next. If this flag is set, after the current audio item finishes the next audio item is 

started automatically. If the flag is cleared, the playback stops after the current item ends. 
• Sort. The nature of the schedule item is shown in this field. The Type field is the type of 

schedule item.   
• Radio. Shows the radio station, to which the given item belongs. 
• ID Jingle. Contains the number of the jingle that is replaced. Here is what it means. Let's say we 

need to create a radio station network comprising the main station and several daughter 
stations. The daughter stations retransmit the program of the main station but insert their own 
commercial and news blocks and ID jingles. The ID jingle is the station's identifier, 
a jingle that contains the station's name, the city it is located in, and its broadcasting frequency. 
It is clear that the main station and the daughter stations all have different ID jingles. Thus, when 
the main radio station 
is playing its ID jingle, for example "Good morning, everyone listening 
to BBC in London; we are working at the 101 MHz frequency," the daughter station in Glasgow 
must be playing this ID jingle: "Good morning, everyone listening to BBC in Glasgow; we are 
working at the 100.5 MHz frequency." The daughter stations in other cities will be playing their 
own ID jingles. 
All the radio stations have collections of such standardized ID jingles. Each of these jingles is 
assigned the same number that is shown in this field. Starting the jingle on the main radio station 
triggers launching jingles with the corresponding number on the daughter stations. 

• End code. Indicates the type of the audio item's ending, for example, 
C — cut, F — fade. 

• First line and Last line. The first and last words of a report audio item can be entered into these 
fields to control their playback from the Subject window of the BCS Editor program. 

The meanings of the ID Number, DB ID, and Version fields require 
a detailed explanation. 

ID Number. This is the identifier of audio items stored in an external database. Generally, it is 
assigned by the user and is a unique string-type 
(i.e., containing any characters) audio item identifier. 

For example, using the DB Import program, data can be imported from the Selector database into 
the MDB. The description of the audio item, the reference 
to the file, and the unique Selector database identifier is copied to the MDB, with the Selector identifier 
stored in the MDB ID Number field. 

This operation may be needed in various situations. The following are some examples. 
• The Selector database generates a schedule and saves it to a file. DJin imports this schedule, 

uses the ID Number field to find in the MDB the audio items specified in the Selector schedule, 
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and copies them to its own schedule. The item in the MDB can be edited after the import from 
Selector (e.g., renamed), but the unique relation by the ID Number is retained. 

• The Selector database and the MDB are synchronized. The ID Number 
is used to locate new items in the MDB (no such ID Number in the MDB) and removing old 
items (no such ID Number in Selector). 

• The user has created in the F-Categories module an F-Category that has items with explicitly 
assigned ID Numbers. In this case, the user himself defines the format of this value. 

The ID Number field is used jointly with the Version field, which 
is in essence an extension of the former. In Selector (and not only in this database) more than one 
version of an item can exist. Version is a numerical field. 
By default, the version is not used and the Version field is empty. Version without ID Number is 
meaningless.  

NOTE 
The ID Number can be changed even though it may seem at first that this field cannot be modified. The field is enabled for 
editing by double-clicking on its label to the left 
of the field itself. This tricky way of enabling this field for editing is needed to reduce the chances of changing this very important 
(when used) parameter inadvertently. 

Some musical database systems use the item identification system analogous to the CD catalog 
system. In this, ID Number carries user information. For example, G354-14 means that the audio item is 
stored in track 14 of the CD named G354. It is convenient if the CD name is meaningful, for example, 
references Gold hit. 

The DJin ID Number is simply a unique identifier that can be used in audio item lists (in the F-
Categories and MDB modules) and is employed to identify 
an item when importing a schedule or a database. 

Let's move to the DB ID field. This is an MDB item identifier that is added 
to an item when it is added to or created in the MDB and remains assigned 
to it during the item's entire life in the MDB. DB ID is unique and is never changed by the user. An item's 
having a DB ID means that the item was taken from the MDB (e.g., if this is a schedule item). DB ID is 
used to identify items in the MDB when automatically updating items in schedules, importing items, etc. 

The Attributes Tab  
The Attributes tab (Fig. 4.86) of the Properties window serves to view and modify the values of the user 
attributes. 
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Fig. 4.86. The Attributes tab of the Properties window 

For each type of audio items in the MDB, named attributes can be added giving supplementary 
description of the audio item. This is done in the MDB settings window. The attribute name is given by the 
user. The user can also define the allowed attribute value set that is used to give a supplementary 
description 
to audio items. DIGISPOT® II simply stores the value of such attributes allowing them 
to be edited. 

The user attributes are described in detail in Section 4.8.3. 

The Remote control Tab  
The Remote control tab of the Properties window is shown in Fig. 4.87. 

 

 

Fig. 4.87. The Remote control tab 

The tab serves to create commands and assign them to the selected schedule items. For example, 
commands to do the following can be created: 

• To turn an indicator panel on or off during the period when the Microphone insert schedule item 
is active 

• To start the player playback upon a schedule pause, thereby filling it from an outside source 
• To order the switcher to switch to the retransmission 

In addition, the Remote control tab options make it possible to implement many of the radio 
station's package solution, technology, and automation requirements. The ID jingle replacement 
described above is one of such commands. Physically, the command can be executed in most different 
ways; the main requirement is that at a certain time a certain command arrives at the station's serial port 
that can be unambiguously interpreted and converted to the GPI or other format to carry out the intended 
action.  

The command can be either created or added from the existing command library. 
The process of creating a command and adding it to the library is started 

by opening the tab context menu (by right-clicking in the tab work area) and selecting the Select 
command in it. Select one of the commands in the Control dialog window that opens (Fig. 4.88) and 
press the OK button. 
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Fig. 4.88. The Control window 

If there is no needed command in the library, it can be created by clicking the Create button. 
Another dialog window opens (Fig. 4.89). 

 

 

Fig. 4.89. The Control window for creating a command 

If a command needs to be created without adding it to the library but simply to assign it to an item, 
instead of selecting Select in the Remote control tab context menu, select the Create new command in 
it. Of course, prior to creating a command, you should think over what it is needed for, how it is to be 
executed, and what to call it. 

During the command-creation process, fill in the necessary fields. 
Into the Command field, enter a number (the command code) from 0 to 255 (for the hexadecimal 

notation, use prefix 0x, for example, 0x0F). Next, in the Name field enter the full command name to be 
used to remember the command 
in future references; in the Short name field, enter an abbreviation to be shown 
in the schedule. Use the On start and On stop switches to select when the command is to be executed: 
When the item starts or ends, respectively. The Preroll (in milliseconds) is entered into the same name 
field. A preroll of, for example, 22 on start means that the command will be executed 22 milliseconds 
before the schedule item starts. 
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An item can be assigned more than one commands. For example, suppose you want to highlight 
the data display and then turn it off. For this, you are to create two commands (one on start, the other on 
stop) and join them to a microphone insert. An example of the command string is shown in Fig. 4.87. 

The MAG tab 
of Properties window 
The MAG tab of the Properties window displays the item properties with relation 
to the musical rotation program of the same name. There is an opportunity to set Mood, Energy, Start 
tempo, End tempo, Start texture and End texture parameters here, and also to set time intervals 
during which playing back of this item is forbidden at automatic schedule generation (more detailed about 
these parameters read in the description of the MAG program). 

The Comments Tab of the Properties window 
The Comments tab is shown in Fig. 4.90. 
 

 

Fig. 4.90. The Comments tab of the Properties window 

The Comments tab of the Properties window is used to view and edit the text comments of the 
given audio item. The content of the comments is entirely 
up to the user wishes. The fact of an audio item's having a comment is indicated 
by icon  in the Add icons column of the schedule.  

The Media tab on the Properties window 
The Media tab of the Properties window allows setting such parameters 
as Media, Track, Year, LC Code and Publisher. 

The File Tab of the Properties window 
The File tab of the Properties window is shown in Fig. 4.91. Using the options 
on this tab, the user can delete, assign, or change the name of the file that 
is associated with the given item in the Schedule, F-Categories, or MDB module. Some of the situations 
when the name of the file may need to be changed could 
be the following: 

• The item was created in the MDB module without the file and then the file was added. The file 
needs to be linked to the item in the MDB, 
F-Categories, or Schedule module. If the given MDB item was added 
to the schedule and can be automatically updated from the MDB, the item is also updated in the 
schedule. 
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•  The file linked to the given name does not exist or cannot be accessed for technical reasons. 
(For example, the file has been deleted, the file 
is located on another computer and the access to it is denied, or the file was not found during 
the import operation.) 

• The file simply needs to be replaced (for example, for the Morning item 
in the Station ID F-Category). The difference between replacing the item's file and deleting the 
item and then adding a new item with a different file lies in that when a file is replaced, all its 
descriptive information is retained (except for the information related directly to the audio file 
contents: marks, playback levels, etc.). This circumstance is extremely important when the item 
has DB ID and/or ID Number set.  

 

 

Fig. 4.91. The File tab of the Properties window 

The buttons on the File tab have the following functions: 
• Select. Used to select a file with the help of the standard file open dialog window. 
• Clear. Disassociates the item from the file. 
• Restore. Returns the item into the state it was in when the Properties window was opened. 
• Apply. Changes the file and keeps the window open. Also, the contents 

of other tab windows also change. For example, in the Marking tab window the selected new file 
appears or the tab disappears if the file name has been cleared. 

When the file is replaced, the information about the audio marks (Intro, Start, etc.) and the item 
playback level is cleared because these parameters belong to the old file. Moreover, when the Apply 
button is clicked or the Properties window is closed by the OK button, the file may be copied to the 
storage. This depends on the location of the new file and the settings in the Base Settings category on 
the Other tab of the Global settings window (see Section 4.12.2). 

NOTE 
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A file can be assigned to an MDB item by dragging the item's file to the necessary MDB item while holding the 

<Ctrl> key pressed. The mouse cursor turns into symbol  during the process. The MDB item's name 
changes. Other information from the dragged file is not used and the file itself does not change.  

The MDB window always has the File tab. The F-Categories window may 
or may not have this tab depending on the value of the Show File tab in audio item properties 
parameter (located at window Settings, tab Other, category 
F-Categories — Audio item list). The Schedule window also may or may not have this tab depending 
on the value of the Show File tab in audio item properties parameter (located at window Settings, tab 
Other, category Schedule). 

The Marking Tab 
The Marking tab of the Properties window is shown in Fig. 4.92. 

The Marking tab opens only when the selected schedule item is an audio item. Using the controls 
located on the tab, the audio item can be marked with time control points: Start, Stop, Intro, Outro, etc. 

In essence, the tab implements a most basic audio editor that can be used 
to perform several non-destructive editing operations that do not modify in any way the samples of the 
digitized sound themselves. The non-destructive editing involves programming the playback process of 
the audio file. The following operations can be performed: 

• The part of the audio item specified that is to be actually played in the player when the playback 
time of the audio item's block arrives. 

• A block start FadeIn specified. 
• A block end FadeOut specified. 
• The playback level changed. 
• The marks of the next block playback start and of the current block playback end generated, as 

well as some other marks making the operator's work easier. 
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Fig. 4.92. The Marking tab 

Let's consider the functions of the tab's interface controls and fields. 
• Total duration. The overall duration of the audio file is shown in this field. This includes the 

silence parts in the beginning and the end of the audio file (if it has such).  
• Playback duration. The duration of the actually played back portion of the audio file (the 

segment between the Start and Stop marks) is shown 
in this field. 

The most prominent item on the tab is the working area to display the audio file's waveform. 

NOTE 
It may seem at first that the audio on the tab is depicted in the mono format: there are no individual waveforms for the right and 
the left channels. In fact, the waveforms for the both channels are depicted in one image at once. The positive half of the 
waveform corresponds to the right channel, the negative one corresponds to the left channel. They are separated from each 
other by the horizontal zero level line. The savings of the screen area are obvious! 

The main tool is the marker: the vertical red line. Clicking the left mouse button in the work area 
moves the marker to the wanted point. In this case, the marker jumps to the new position. It can also be 
dragged to the new place by left-clicking it and dragging it to the new place while holding the left mouse 
button pressed. The position of the marker on the time axis relative the coordinate origin is numerically 
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displayed in the field located in the left section of the group 
of controls and fields under the waveform (Position field). 

In the rightmost part of the same group, located is the dropdown list 
to change the duration of the waveform section displayed in the working area from 10 second to 1 minute. 
This feature makes it possible to view the waveform and mark the audio item with the necessary degree 
of detail and precision. Selecting option All displays the entire waveform that corresponds to the selected 
schedule block. Waveform can be moved on the screen using the mouse or scroll bar. 

Pressing button   starts the PFL playback to mark the audio item; pressing button  
stops it. 

The current playback position is indicated by the moving yellow marker. The playback starting point 
is indicated by a red marker during the playback. 

The playback is stopped by pressing button  again. This returns the current playback 
position indicator to the point the playback had started from. 

If the playback is stopped by clicking button , the current playback position indicator becomes the 
marker's and remains where it was stopped.  

The controls and fields just described are used to place the mark, visually 
or by ear, into the wanted position. Placing the marker into one position after another is what constitutes 
the main part of the audio item mark up editing. 

To the left of waveform there is the level indicator displaying (in dB) a level 
of the left and right channels. At the switched off playing back, the blue toddler allows to choose sound 
amplification gain for entire track. Double click on the bottom area of the level indicator clears all changes 
(on a segment of the window 
in which numerical values of amplification gain are displayed) 

The marking itself is done using the Mark group buttons. For example, the marker is placed into the 
position corresponding to the player start moment and the Start button is pressed. The program 
remembers this mark. Next, the marker is moved into the position where the player must be stopped and 
the Stop button is pressed. 

Altogether, up to eight distinct points can be placed on the audio item: Start, StartPoint, Intro, 
Intro2, Intro3, StartNext, Stop, and Outro (see also Fig.3.1.). 

• Start is the point corresponding to the start of the given audio item. This mark is placed one time 
and never changes. When the new item is added 
to the MDB, this mark is placed by the musical editor in the position of the audio item's real start. 
For example, this mark cuts off a pause at the start of the audio file or a very low-level part of the 
introduction. 

• The StartPoint defines the position, at which the playback starts in the player. This mark is 
employed when the audio item needs to be started from the point other than the start. This point 
can be searched for using the start point seek module. Usually, StartPoint is placed in the 
schedule for a specific item at the scheduling stage or directly in the multichannel player shortly 
before the airing time.  

• StartNext defines the moment when the player is started to playback the next audio item. 
• Start This is combined with StartNext point of previous audio item (can be used at re-uniting 

audio items)  
• Stop defines the point the player playing the current audio item stops. 
• Intro, Intro2, Intro3 marks have a common meaning: they define the conclusion of the audio 

item's introductory part. They provide the DJ with the information as to how long he can talk over 
the background of the introductory part of the audio item or to where StartPoint can be rapidly 
moved to cut off a long introduction. The three marks have been provided at users' request to 
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perform more detailed marking. For example: Intro marks the conclusion of the introductory 
part, the start of the theme. Intro2 marks the start of the vocal part, etc. Users can use the 
marks 
at their discretion. All players are equipped with the Intro zone countdown timer. 

• Outro (the counterpart of the Intro point) is the point where the theme ends and the final musical 
play starts. It can also be considered as the end of the vocal part. Outro is not used as often as 
Intro. 

Any marking points of the audio item can be set manually; besides to each point is there the 
corresponding  button, allowing audio item to be played back beginning from the specified position. 
The additional  button deletes 
a corresponding point. 

Let's consider the Marking tab buttons. 
• FadeIn. Used to place a fade in from the Start point to the mark. 
• FadeOut. Used to place a fade out from the mark to the Stop point. The nature of the fades can 

be selected either linear or logarithmic, selecting 
is carried out using LOG / LIN buttons.. The logarithmic fades are natural to human ear. 
FadeIns and FadeOuts and their nature are depicted 
by slanted red lines. 

There separate  and  buttons for playing back and removing of fade-ins and fadeouts, 
respectively.  

• Automarking. This button is used to automatically place the Start and Stop marks, cutting off 
the starting and the trailing silence parts of the audio item. The automarking is affected by the 
parameters of the Audio files Marking category (tab Other, window Global Settings). 

Marks already applied to the audio item are cancelled by clicking the Clear all button. Before 
complying with the request, the program asks to confirm it. 

The fields in the Normalization group are used to set and display the maximum signal level and 
gain. 

NOTE 
In the Gain field, such gain factor is displayed that is applied to the audio item 
to produce the peak playback level set in the Playback level field. It is calculated as the difference between the value of the 
Playback level parameter and the audio item's peak level displayed in the Max. level field. These parameters have opposite 
values 
if Playback level = 0. At first, unless the user intervenes, the value set in the Playback level field equals the value of the Max. 
level parameter. As a result, the gain factor 
in this case equals 0 and the audio item is played as is. 

The signal playback level can be set by setting its value in the Playback level field. 
In last Djin versions the opportunity of work in the “rubber line” mode has appeared. The group of 

additional buttons operates this mode. Editing of the item using this mode looks as follows. On “rubber 
line” control panel press the button . This button switches on the mode of editing with the rubber line. 
Then press the next button- ; it switches on the mode of setting of rubber line central points. In this 
mode the left-click on the track sets the rubber line central point 
in a place of click. After setting of necessary number of such points it is possible 
to the switch rubber line mode  off by repeated pressing the button  or right-click on any place of the 
track. 
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Now move the nodes of the line to get desirable picture of changing of the signal level in time. For 
moving node place the mouse cursor on it (thus the cursor will take a specific appearance ) and, 
holding the left key of the mouse move 
it. Moving up and down changes the amplification gain in the given point. Moving 
of a point to the left or right moves the point concerning the item, changing its time position. Releasing  
the left key will fix a new position of the point. Right-clicking holding left cancels moving of the point, its 
position will not change concerning initial. Also possible moving of a straight part of the rubber line 
between two points. For this purpose place the cursor on the part of a line (a green line) and to move 
it the same as also a point. 

The green line in this case displays the diagram of amplification gain changing in time. Red points 
are nodes of the line. 

To remove points of an envelope in the certain area of waveform is possible with pressing of the 
button  and selecting of the necessary area; to remove 
all points on the waveform is made with the help of the button . 

For removal of all rubber line call its context menu: place the cursor of the mouse on the node or the 
line itself and press the right key of the mouse. In the opened menu there is only one command Delete 
level curl. 

Pressing of the button  again causes the end of editing with the rubber line mode. Thus the 
diagram of level changing on tracks will be still displayed 
by a green line, but editing with the rubber line will be impossible. 

Note that pressing the mentioned above Clear all button deletes 
all information on points of a marking and fades, but does not change modulation of the audio item with 
the rubber line. 

The button  located on the toolbar allows to switch a mode of waveform displaying (the pressed 
and not pressed button defines whether the waveform will be displayed with already applied envelope or 
the envelope determining the amplification gain, will be simply shown against a background of initial 
signal). Near to the button of switching modes the element RAW has appeared, allowing to play the 
original sound back (the stop of playing back is made by repeated pressing the same button). 

The Extended Tab 
The Extended tab of the Properties window is shown in Fig. 4.93. 
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Fig. 4.93. The Extended tab of the Properties window 

This tab contains parameters that do not need to be changed often. 
The Keep at the end of a block during import flag is used in skeletons 

to specify the items that must stay at the end of the block after import operations. That is, when importing 
items they are added to the block in front of those with this flag set. This may be necessary, for example, 
to keep the closing jingle at the end of the block. Items with this flag set are marked in the schedule with 
symbol . 

The Update from DB automatically list can be used to modify the update from the MDB system's 
behavior with respect to the given item. The item must 
be an MDB item, that is, have a non-zero DB ID. Whether the given item 
is updated from the database by default is defined on the Update from DB tab 
of the Global settings window. One of the following three options can be selected from the list:  

• Auto (by Global settings) 
• Yes 
• No 

The Playback channel list is used to redefine the standard assignment of the selected schedule 
item to one of the multichannel player channels. The default assignment is defined on the Playback 
channels by categories tab of the Global settings window. 

The Mark as a musical background parameter defines an affiliation of the item schedule to type of 
musical backgrounds. 

The Other tab of the Properties window 
The Other tab contains only one parameter group - the Data base, which includes only 3 listed below 
parameters. 

• Archive item - defines an affiliation of the audio item to the archive realized in DIGISPOT® II 
system. 

• Ready for air - defines readiness of the MDB audio item for airing. 
• Planning air time - defines the date of MDB audio item airing. 

4.10.2. The Clock Window 
The Clock window is shown in Fig. 4.94. 

 

 

Fig. 4.94. The Clock window 

The scalable window displays the current computer clock time. The logo of the DJin system is also 
located in this window. Upon a user's wish, his station's logo can be placed here. 

If the system employs the exact time signal reproduction algorithm (PIP), the digits showing the 
current time start blinking and change their color when the PIP signal time approaches.  
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The window to configure the exact time signal issuance mode, called Hour beeps (Fig. 4.95), is 
called by right-clicking on the Clock window. 

It is assumed that the functions of the elements of the window are explained sufficiently clear by 
their labels and need no further explanation. 

 

 

Fig. 4.95. The Hour beeps window 

4.10.3. The Text Messages Window 
The DJin system provides a capability to exchange text messages among the computers of the complex. 
Text operations are initiated by the Send and Text buttons. 

Clicking the Send button opens the window to create a message. 
The Text messages window is shown in Fig. 4.96. 
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Fig. 4.96. The Text messages window 

The message subject is entered into the field under the button bar; the message text is entered into 
the field below the subject field. The addressee 
is selected from the Receiver dropdown list. The message type can be selected 
in the Type dropdown list. There are three message types: 

• Regular. The message is simply sent to the addressee where it is stored until read. 
• Timed. The addressee receives the message at the specified time.  
• URGENT. The same as Regular but with a higher priority: The message bears a special 

indicator. 

When the Timed message type is selected, the time input field becomes active, into which the time 
to send the message at must be entered. 

Different type messages are created in the same way and only differ in how they are displayed on 
the addressee's side. Messages are sent by clicking the Send button. 

When there are unread messages, the Text button starts blinking in the addressee's program main 
window with its name changing for the number of the unread messages. The button's color indicates the 
type of the unread message: green — Regular, yellow — Timed, red — URGENT. The URGENT 
message type has the highest priority, the Timed type has the next highest priority, and the Regular type 
has the lowest priority.   

If there are more than one unread messages, the button color corresponds 
to that of the highest priority. 

 

 

Fig. 4.97. An URGENT message 

 

Fig. 4.98. A received message can look like this 

The Regular and URGENT messages do not differ in their sending times: The addressee receives 
them practically right after they are sent. The red button color is intended to only attract the addressee's 
attention. Timed messages are delivered to the addressee exactly at the specified time.  

Clicking at the blinking button opens the window, in which the first of the unread messages is 
displayed. 

The sender and the message subject are displayed in the window title; the text is displayed below 
them. The title color depends on the type of the message. After the message display window opens, the 
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appearance of the Text button changes to reflect the current state of the unread message queue. If there 
are 
no more unread messages, the button stops blinking, turns back gray, and the word Text appears on it 
again. The window must be closed after reading the current message. The next unread message is read 
by clicking the Text button again. When all received messages have been read, the button resumes its 
initial appearance. The window is closed by pressing the <Esc> key. 

The functions of the control buttons are as follows:  

 — creates a new message. Clicking the button issues a warning message. Answering Yes to 
it deletes the text entered in the window. 

 — enters into the window text from a file created in an outside text editor. The text file must 
have the RTF or TXT extension. Clicking the button opens the standard file select dialog window. 

 — saves the text in a file to disk. Clicking the button opens the standard file save window. 

 — cancels the last text input. 

The rest of the buttons in the toolbar are used to format text analogous to any text editor. 

4.10.4. The Current Audio Item Status Window 
This window is included in the configurations using players that do not have sufficient horizontal space to 
display information, for example, block players 
in DIGISPOT® II DJin 777 configuration. In Fig. 4.99, the Current audio item status window is located at 
the bottom. This figure shows the information about the item currently selected in the player. 

 

Fig. 4.99. The Current audio item status window 
is located in the lower part of the main window 

The information displayed in the Current audio item status window may pertain to the following:  
• To the selected audio item that has a marker set in an audio item list, for example, in the Files, 

F-Categories, or MDB window. 
• To the audio item being currently played by a player. 

The window displays the audio item's name and the name of the performer, the duration, the 
durations of the Intro and Outro (blue areas), and the current playback position (green area). 

When the information about the currently played item is displayed, accordingly displayed are the 
remaining duration, the remaining Intro, and so on.  
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The information is displayed both numerically and graphically as colored fields holding the item's 
name and author. 

The button on the left part of the window sets its operating mode. If it has number 0 on, the window 
is displaying the information about the currently selected item in some list. When the selected item 
changes, the information in the window also changes according to the new selected item. If a number 
other than zero 
is on the button, the information displayed is about the first item in the playback queue of the player with 
this number. In this case, the information in the window does not depend on the currently selected item 
but changes in sync with the player state change. The modes are changed by clicking the button, which 
cycles the modes. 

4.10.5. The Messages Window  
The Messages window is shown in Fig. 4.100. 

By default, the Messages window automatically displays warnings about various errors or improper 
operator actions. 

The window can also be force opened by the operator. This is done by clicking the dot located left 
of the DJin logo in the Clock window. 

Right-clicking the Messages window opens the context menu. Its Properties command opens the 
same name window (Fig. 4.101). This window is used to select the types of the program messages that 
should cause the Message window 
to appear. 

 

Fig. 4.100. The Messages window 
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Fig. 4.101. The Properties window 

4.10.6. The List Customization Window 
The List customization window is shown in Fig. 4.102. It is opened by right-clicking the audio item list 
title in any of the windows: Schedule, Files, 
F-Categories, and titles of other lists, not necessarily those of audio items. The List customization 
window shown is an example of customizing the audio item list of the Schedule window. 

In the List customization window, the information is displayed in the list form about all columns 
that the list being customized may contain, as well as their current state. 

Users' desires as to the information to be displayed in the list are often at the opposite ends of the 
wish list. Therefore, the DJin system implements a universal system to configure the appearance of the 
lists. It allows the user himself 
to determine the columns to display, the order in which to display them, and the font of the list text.  

All columns available for the list are in their turn displayed as a list. 
The width of columns in the list can be adjusted at the request of the user 

by two different ways; depending on a final purpose it is possible to specify width 
of all columns explicitly or to scale a column similarly to other Windows lists. For scaling mode switching 
on similarly to other Windows lists select the Use classic windows column scaling parameter in the list 
settings window. 

In case if this parameter is not selected the settings set in the List customization window operate. 
There are four types of columns. These are the following: 

•  — proportional  

•  — proportional disappearing 

•  — fixed  

•  — fixed disappearing 
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Fig. 4.102. The List customization window 

The column type defines the way its width is calculated and whether the given column will be visible 
at all at the current horizontal width of the list. This system differs somewhat from the one used in 
Windows, where the column width can 
be changed dynamically by the mouse. This system came to be because it is not very convenient for the 
operator to use the horizontal scrolling bar while on the air and, therefore, it is desirable to get rid of it 
altogether. On the other hand, when the horizontal size of the list increases, the user wants to have more 
detailed information about the audio item. This can be done by increasing the width of the list columns 
(for example, to view long strings), as well as by outputting to the screen the columns that were not visible 
before (the widths of the standard Windows list columns does not change when the window width 
change). 

The list space is distributed in the following way: First, space for all non-disappearing (fixed) 
columns is allocated in the list. The size of the fixed columns 
is determined by the program based on the values specified in the Width and Skeleton fields. Width is 
the columns width is pixels. It does not depend on the font used. Skeleton is a text string specifying the 
column width as the width of the skeleton string printed in the given font. If there is more than one font in 
the list, the width is set by the longest printed skeleton. These values can be specified either individually 
or together; in the latter case they are summed. For example, suppose 
a column has Width = 16 and Skeleton = 00:00:00. In this case, its width 
is defined as the width of string 00:00:00 plus 16 pixels. 

The width for the proportional columns is determined depending on the value specified in the 
Weight column. Weight determines the width as the free space part that falls to the given column in 
relation to the sum of the weights of all visible proportional columns. For example, if the list has three 
proportional columns with weights 1, 2, and 3, then the width of columns is determined as follows: the 
width of the first column is 1/(1+2+3) = 1/6, the width of the second column is 2/6, and the width of the 
third column is 3/6. The free space left over after allocating space to the fixed width columns is distributed 
between the proportional columns according to these coefficients. If Width and Skeleton are specified for 
a proportional column, they define the minimal width of the column. 

If the calculated width of a disappearing column is smaller than Width 
+ Skeleton, the column is not displayed. The horizontal scroll bar appears in the list only in case if the 
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total length of all non-disappearing columns exceeds the width of the list. This is the default setting, for 
example, for the MDB window. 

Disappearing columns (and zero-width columns in general) located between two another columns 
are marked with the vertical blue line. 

Practically all column attributes can be modified in the List customization window. To modify a 
parameter, a double click is made on the corresponding column field. Clicking the column field marked 
with the eye symbol enables 
or disables displaying the column. Clicking the Type field assigns to the column one of the four types 
described earlier. In the Width field, the column width can 
be specified in pixels; a template string, that also affects the width, can be entered into the Skeleton field. 
The weight that determines the width of the proportional columns can be changed in the Weight field. 
The number defining the order, 
in which the columns disappear, can be specified in the Rel. field. When there 
is a shortage of space, the less important columns disappear first. The text alignment mode of the given 
column is specified in the Align field. 

The Up and Down buttons are used to change the order the columns are displayed in the list. 
Button Fonts opens the Fonts setup window with a list of the fonts available for editing in the given 

list (Fig. 4.103). 
 

 

Fig. 4.103. The Font setup window 
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Fig. 4.104. A Schedule window with different fonts 

The font type, its size, and other parameters can be specified in the Fonts setup window. The 
settings made in this window are preserved after the program is reloaded. 

Fig. 4.103 shows an example of the Fonts setup window and Fig. 4.104 shows a schedule window 
using different fonts. 

4.10.7. The Remote Control Setup Window 
The GPI bits configuration window for configuring the remote control of a player is shown in Fig. 4.105. 
This window can be accessed by the Remote control setup command of the player context menu, which 

can be called by clicking button . 
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Fig. 4.105. The GPI bits configuration window 

 

Fig. 4.106. The GPI bit parameters window 

The GPI bits configuration dialog window is used to configure the control 
of a player by a GPI signal source. It is used to configure all types of players. 

The upper part of the window contains a list of actions that can be controlled by the GPI. The 
contents of this list depend on the type of the player being configured. For each list item, the name and 
the current control setting 
is displayed: the GPI source device from which the information is received, the bit number, and the bit's 
active state (0 or 1).  

Double-clicking a list item opens the GPI bit parameters window (Fig. 4.106), in which the device 
can be selected and the control bit and its active state specified. 

In the lower part of the GPI bits configuration window (Fig. 4.105), the available GPI sources are 
listed. The contents of the list depend on the configuration of the specific workstation and the type of the 
remote control devices used. For each device, the current state bits are displayed. This allows the 
configuration to be conducted by experimentally changing the state of the input signals and observing the 
corresponding device changes.  

There is the Disable remote control flag in GPI bits configuration window. Its function is evident.   
The main players (the block player, the double player, and the multichannel player) have a button to 

temporarily disable the remote control. It is usually located on the player's main window and its two states 

are depicted by symbols / . 
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4.10.8. The Import Format Window 
This window is opened by executing the Service > Import format command sequence in the program's 
main menu. This window serves to create and edit import formats: the aggregate of the information about 
the format of the imported file and about the import parameters. The Import format window contains the 
list with all available formats. Editing of these parameters (as well as new format creating) is made in 
Import settings window which can be called with the Add 
or Edit buttons (Add command opens the empty window for new format creating, the second one opens 
created before format for editing, respectively). A screenshot of the Import format window is shown in 
Fig. 4.107. 

Importing a schedule from any type of files has two stages: parsing the file line by line and testing 
its items and reading the metadata.  

The following is a brief description of the file import process.  
The source file for the importing is a text file with the information 

in it organized in text strings delimited by separators into fields. During the importing, the program reads a 
line, recognizes the fields, creates an item with the corresponding parameter values, and places the 
obtained item into the schedule. 
At this stage, new blocks can be created in the schedule or already existing blocks used. After the 
process of reading the information and placing the items into the schedule blocks is completed, the block 
testing process starts. During this process, the program locates the file assigned to a given item (or 
searches for the item itself by the specified parameters in, for example, the MDB) and reads from the file 
(or from the item description) the metadata not specified in the string of the imported text file. 

 

 

Fig. 4.107. The Import format window 

In order to better understand the configurations performed in this window, the import configuration 
process is described using a simple example that covers about 80% of import situations. The source file 
was created by the Power Gold program. The following are some sample lines from the file. 

 
"13:03:12","SYLVER","Forever In Love","\\Srv\MUSIC\SYLVER - Forever In Love.WAV","00" 
"13:05:52","IN-GRID","In-Tango","\\Srv\MUSIC\IN-GRID - In-Tango.wav","00" 
"13:09:03", «VALANTO, DIORIERO","Esperito","\\Srv\MUSIC\VALANTO, DIORIERO - Esperito.wav","15" 
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The field separator in this case is the comma character. The value of each field is enclosed in 

parentheses, which allows the separator symbol to be used as a part of a field value. Without 
parentheses, using commas in the field values would cause errors when parsing the file.  

Each string contains values of the following fields: Airing time, Artist, Name, File name, and Intro. 
A list of the fields used in the import format is created. The Fields list defines the order and type of 

the fields imported from the file. It is located in the left part of the window on Text file tab. 
Fields are added to the list from the Import fields window, which is accessed by clicking the Add 

button. An example of the Import fields window is shown 
in Fig. 4.108. 

 

Fig. 4.108. The Import fields window 

The list of the available fields in located in the left part of the Import fields window; the table 
defining the available time formats is located in the right part 
of the window.  

The table rows contain various formats to record time or duration. The columns contain the names 
of three time format groups. The cells filled 
up determine the time-recording format recognized for the corresponding group. The name of the format 
group used for reading information from the corresponding field is located in parentheses after the field 
name in the list.  

For example, the Time (min) field uses the (min) format group and defines the item's scheduled 
airing time. In this field, time can be written as 13:14, which for this group means 13 hours and 14 
minutes. The Duration (ms) field uses the (ms) format group. The 13:14 string for this field is interpreted 
as 13 minutes 
14 seconds.  

The last three rows of the table — minutes, seconds, and milliseconds — determine how the 
program interprets the number (and not a certain format string) written in place of the corresponding field. 
For example, for the minutes group, number 600 is interpreted as the number of minutes and 
corresponds to 10 hours 00 minutes. For the milliseconds format, number 600 is interpreted as the 
number of milliseconds, or accordingly 0.6 seconds.  

The table is intended to only inform the user about the possible formats 
to record time and duration; the program has no capability for configuring parsing of such fields. 
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The necessary field is selected in the field list and the OK button pressed. After this, the Import 
fields window closes and the field is added to the list of the imported fields. 

There are several specific fields in the available field list:  
• The Skip field is used to ignore the part of the string located in the corresponding position. 
• The Control is a special field containing control symbols. It can occur more than once in a 

string. The field serves to specify the parameters of the imported items, break the imported 
material into blocks specifying time reference for blocks, etc. It will be given a detailed 
description later. 

In our example, the following fields need to be added to the imported filed list: 
• Time (min) 
• Artist 
• Name 
• File name 
• Intro (sec) 

Next, the separator symbols needs to be specified. This is done in the Delimiter field. In our case, it 
is a comma.  

Thus, we have given a complete description of the imported file. Now the options that affect the 
import process and the item testing need to be specified. Some options depend on the way the audio 
items are distributed over the blocks. This can be done in two ways: The audio items are distributed over 
the already existing blocks, or the program itself creates the necessary blocks during the import process. 
Suppose that we are using the skeleton system and already have 
a skeleton with blocks determining the broadcast grid for the date of the imported schedule. 
Consequently, there is no need to create blocks. Neither do the Create music blocks automatically, 
Create non-music blocks automatically, and Create blocks if block type specified flags placed on 
Advanced tab need 
to be set. Because an MDB is not used for the import, the following two flags do not need to be set either: 
Import missing items to MDB automatically and Search in DB by ID Number then by DB ID.  

The block, into which an imported item is placed, is determined by the block type and the item's 
airing time. The airing time is specified in the imported file; the type of block to place the items in is 
specified explicitly in the Block type group 
by setting the Music flag. The item type is specified by setting the corresponding flag in the Item type 
group. This is not necessary, but nevertheless desirable.  

The template for our example has been created. 
Now the import format is given a name in the Format name field on Text file tab and saved by 

clicking the OK button. 
A format name cannot contain symbols prohibited for a file name.  
The case we just considered is the most simple and common, using the minimum number of 

settings. Next, all window's field groups and flags of the Import format window and their use will be 
specified. 

Fields Affecting Determining the File Name 
These fields are used when only a partial audio item file name is specified in the imported file.  

The path to the directory automatically added to the path specified for items 
in the imported file is specified in the Default directory for audio items field. For example, if the name of 
a file is specified as forever.wav and the default catalog field contains \\server\sound, the resulting path is 
\\server\sound\forever.wav. 
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A part of the path can also be specified in the file, for example gold\forever.wav. The resulting path in this 
case is \\server\sound\forever.wav. The program does not verify that the file exists; it simply adds the file 
name and remembers the resulting path. 

The directories, in which the program searches for files if only their names are specified in the 
imported file, can be specified in the Default search directories for audio items field. In this case, it is 
namely files that are looked for and only the file names, without partial paths, must be specified in the 
imported text file. The file search is conducted sequentially, in the order in which the directories are 
specified in the list, prior to the block-testing stage. If a file is not found, another search is conducted at 
the block- testing stage, but this time according to the settings specified on the Service > Settings > 
Other > Import tab. If a file 
is not found after the repeated search, the name of the file in the audio item properties is prefixed with 
??\, for example ??\forever.wav. These schedule items are always displayed in red. To conduct another 
search, the block testing operation needs to be called from the window's service menu by the Test 
blocks command. When the block-testing operation is performed anew, the information specified 
in the import format is not used because the information about which way items are added to the 
schedule is not saved in the schedule.  

This duality of the search settings is due to the necessity to support the old program versions. In the 
new program versions, it is not recommended to specify directories in the list in the Import format 
window but use only the Service 
> Settings > Other > Import search settings. In addition to the list of the catalogs, a list of the file 
extensions used during the search can be specified in this window. The detailed description of the 
relevant configuration settings is given 
in Section 4.12.1. 

Note that either the Default directory for audio items ought to be specified or the directory search 
conducted. Using both of these fields makes no sense, 
as the specified default catalog has the higher priority and no search in the other catalogs is conducted. 

The additional Check version after ID_Number parameter allows working with different MDB file 
versions (MDB allows saving several file versions with the same ID_Number). 

The Preprocessor Window  
The Preprocessor window is used to specify a supplementary format conversion program. This capability 
is needed for importing a schedule from non-standard format files. The program is called with two 
parameters, which are passed in the command line. The first parameter is the name of the source file; the 
second parameter is the destination file, in which the program places the results of its processing as a 
delimited text file. A preprocessor program can be written by the developers or it can be done by client's 
personnel after consulting with us.  

The Definitions tab 
The largest group of fields in the Import format window is placed on Definitions tab: definitions set on 
this tab, generates the control field in the import file string, which comprises a set of symbols.  Each of 
these symbols defines a command execution during the import process or describes some properties of 
the imported item. The field group specifies the relationship between the symbols and the operations or 
parameters assigned to them. If the control field is not used during import, all parameters of the 
Definitions tab have no effect on the import process. The exceptions are the Block type and Item type 
subgroups that specify the type of blocks and items explicitly. The symbols assigned to commands can 
be changed by the user. 

The Control string is used to automatically create blocks in a schedule. For this, the control field 
must have the block start symbol Begin (B by default). If this symbol is detected, the program interprets 
such file string not as a schedule item string but as a block information string and creates in the schedule 
a block with the parameters described by this string. The following fields defined on the Text file tab 
pertain to the block: 
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• Time (min). Interpreted as the block's airing time. 
• Duration (ms). Interpreted as the scheduled duration of the block. 
• Name. Holds the block's name. 

The Control string can contain various symbols (set on the Definition tab) detailing the block 
description:  

• The symbols from the Time subgroup define block's time reference. 
• The Block type symbols define the block's type. 
• The symbols from the Block subgroup define additional flags of the block. 

The last string of the block must have the end of block string (E by default). 
The following is an example of a set of strings in the imported file that create 

a schedule block. 
 
"BMT", «13:00:00","20:00","","Music block name","","" 
"F", «13:03:12","","SYLVER","Forever In Love","\\Srv\MUSIC\SYLVER - Forever In Love.WAV","00" 
"F", «13:05:52","","IN-GRID","In-Tango","\\Srv\MUSIC\IN-GRID - In-Tango.wav","00" 
"F", «13:09:03", «","VALANTO, DIORIERO","Esperito","\\Srv\MUSIC\VALANTO-Esperito.wav","15" 
"E", «13:00:00","","","","","" 
 
Two more fields have been added to the fields in the previous example. 

A string is started with the Control field containing control characters. The Duration field was added after 
the airing time field. In the example, this field 
is used only for blocks, but it can also show the audio item duration.  

Note that strings for blocks and audio items have the same format, contain the same number of 
fields, and the order of fields is also the same. If a field is not used, its position is taken by a blank string.  

The first string contains the block information. The "BMT" contents of the control field mean the 
following: B — create block of  M — music type and T — set the Fixed time flag. The block's airing time 
is 13:00:00. The block's duration 
is specified as 20 minutes in the Duration field. The Name field holds the block's name. The rest of the 
string fields are not used for blocks. 

The Control fields in the rest of the strings in the example have the 
F character of the Block item defining the strings as describing audio items located on the hard disk. 
Other characters can be used to create pauses, info, and other types of items in a block. 

The Item type subgroup is used with audio items only to specify the item's material type; the Item 
properties subgroup is used to set its flags.  

Other parameters 
Settings located on the Advanced tab of the Import settings window affect 
to executing of import process. In a case described in last example, it is necessary to set one flag - 
Create block if block type is specified. Flags Create musical blocks automatically and Create non-
musical blocks automatically are used 
if blocks are absent in the schedule and there is no information about creation 
of blocks in a file. In such case the program will automatically create hour-long blocks for the items 
present in the imported schedule. For example, if the file contains a string with the item for which airing 
time 13:15:00 is specified the program will automatically create the block for 13:00:00 and place this item 
in it, and also all subsequent which airing time is within the limits of this hour. 
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On this tab also there are following parameters: 
• Minimal part of item - the parameter operates a condition of audio item accommodation in the 

block (By default the value by default 50 % more often is used; in this case the audio item is 
considered "got" in the block 
in case that its half fits there); 

• Check block duration (for music) - the parameter allows to include the registration of musical 
blocks filling; 

• Fix start time for automatically created music blocks - the parameter operates the Fixed time for 
automatically created blocks flag; 

• Put no music audio items to - the parameter which in version 2.8.84 appeared, operates 
accommodation of imported non-musical elements. 

• The Merge group - operates data of items at import. 
• The group of parameters Set block properties - operates properties 

of blocks for automatically created blocks of the certain types. 

The directory for saving of the created skeletons and also directories in which already existing 
settings can be found are set on the Skeletons tab. 

Importing from the F-Categories Module 
When importing from the F-Categories module, the name of the item's file is not specified. Instead, in the 
imported file, the search of one of the module's components is defined in one of the two ways. To include 
import from the 
F-Categories, one of the Search by name or Search by ID Number flags of the Search in F-
Categories must be set. Accordingly, if the first flag is set, during the import the item is searched for in 
the F-Categories by its name; if the second flag is set, the search is conducted by the ID Number. The 
imported file must contain at least the item's name or its ID Number. An item from an F-Category is 
copied to the schedule in its entirety, including the file reference, marking, etc. 

Importing from the MDB  
Import from the MDB is often used when working with outside schedule preparation systems if the MDB 
contains a full or partial copy of the external rotation system database. In this case, the imported file 
contains the item's unique identifier: 
DB ID for the MDB or ID Number for the external database. During the import process, the item is 
searched for in the MDB by the specified parameter and the description of the found item is copied to the 
schedule analogously to importing from F-Categories. If the file has both identifiers, the program first 
searches 
by DB ID and then by ID Number. Setting flags Search in DB by ID Number then DB ID allows the 
program behavior to be changed. Setting the Import missing objects into DB automatically causes 
new items to be created in the MDB containing information read from the imported file. The items are 
placed into the MDB category corresponding to material type specified for the item; the name of the 
category is read from the string of the imported file. If no category name 
is specified, items are not linked to categories.  If the material type is not specified, the Music type is 
assumed. To import from the MDB, the imported fields only need to have ID Number (if the search by ID 
Number in F-Categories is disabled) 
or DB ID and a connection to the MDB.  

Note that the different import methods — with the file specified explicitly, via F-Categories, and via 
MDB — are mutually exclusive. 

Testing Blocks 
The block testing operation mentioned earlier is performed automatically after the import operation; it can 
also be called manually by the Test blocks command 
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of the Schedule module service menu. At this stage, the item file is searched for 
or the item is searched for in the F-Categories or MDB module. An error during the block-testing stage 
opens a special window with a list of the errors found. Analyzing the error list makes it possible to 
determine the wrong items and 
to determine the cause of the error. A screenshot of the Errors detected list window is shown in Fig. 
4.109. 
 

 

Fig. 4.109. Errors detected during block testing 

The error list can be saved as a text file by clicking the Export to file button. Also, items with the ID 
Number set can be added to the MDB (into the NOT FOUND category) right from the window by clicking 
the Add to DB button. 

4.11. Overview of the DJin Program Main Menu  
The main menu of the DIGISPOT® II DJin program comprises the following submenus: 

• File. Contains functions to restrict access to the DIGISPOT® II DJin program components, to 
reload the program, and to exit the program. 

• Edit. Used to perform editing operations. 
• View. Controls the display of the main window components and the access to some dialog 

windows. 
• Service. Used to configure various settings. 
• Help. Calls the on-line reference system. 

Each submenu contains several commands. The majority of the commands open dialog windows, 
the rest perform other operations (which sometimes do not manifest themselves outwardly in any way). 

Let's consider the functions of the main menu commands. The basic commands are described in 
detail; others, deemed to be impossible to be fully understood at this stage of mastering the program, are 
given only brief descriptions of. These commands are described in detail in the sections of the User's 
Manual that consider their corresponding windows or functions.  

4.11.1. The File Menu 
The File menu comprises commands dealing mainly with limiting access rights, configuring the system, 
exiting the system, and its reloading: 

• Select profile. Used to change profile (selecting of one of the prepared beforehand program 
settings). 

• Login. Used to change the current user. 
• Administration. Serves to assign program resource access rights to users. 
• Restart. Reloads the DIGISPOT® II DJin program. 
• Exit. Used to terminate the DIGISPOT® II DJin program. 



Cooperation for Development of Hard-and Software 
for Audio and Video Broadcast Studios in East and 
West Europe. Design and Manufacturing of Studio 
Equipment  for the Audio recording Industry and the 

 

 
e.mail: info@tract.ru   e.mail : infor@barthkg.com  
 web :http//www.tract.ru   web : http://www.barthkg.com 
 

    

 

copyright: RBKG&TRC  Page 169 of 219 

in field of Video Postproduction. 

The following are descriptions of the File menu commands. 

Command File > Select Profile 
The File > Select profile command opens the Profile setup window (Fig. 4.110). 

 

 

Fig. 4.110. The Profile setup window 

In essence, a profile is nothing else but a collection of user program settings saved in a file by the 
program developer, a system administrator, or a user. The program is delivered with one, Base, profile. 

If the user needs additional profiles, he creates them himself; otherwise, 
he can work with the Base profile that is created by default. The latter approach 
is the one used most often, although creating a personal profile would allow the user to work in the 
conditions most comfortable for him. 

The matter is that the studio computer is not really personal in the full sense of the word. Various 
people can work with the DIGISPOT® II DJin program installed 
on it, solving various tasks. In the course of time, each user works out his preferential program settings 
(the simplest case being interface windows of the most comfortable sizes). So every time you start 
working, instead of setting your favorite configuration settings manually, you can make the program 
remember them once as a profile and in the future apply this profile by executing a couple 
of simple operations. 

Selecting the needed workstation profile in the Profiles field and clicking the Select button loads 
the selected profile. 

The selected profile can be deleted (with the exception of the Base profile) 
by clicking the Delete button. 

The name of the current profile is displayed in the upper part of the window. 
The Apply button is used to select the profile loading mode. The changes become effective when 

the program is reloaded. There are two options available: selecting one of the existing profiles or loading 
the selected profile next time the program is started. 

The current profile does not change when button Apply is pressed. For the changes to become 
effective, the program has to be explicitly reloaded. Restarting the program by executing the File > 
Restart command sequence loads the active profile regardless of the settings made in the profile select 
window. 
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In the On loading group, one of the two ways a profile is loaded during the program start is 
selected. If the Always load default profile flag is set, the default profile is loaded without any 
interrogations when the program is started. The default profile is the one that was the current in the 
previous program work session (before it was closed). If the Select profile manually flag is set, when the 
program is started, the first thing that appears is the window similar to the one shown in Fig. 4.110, in 
which the necessary profile needs to be selected, and then the button Select is clicked. 

How is a custom profile added to the list? You should do this only after you have configured all the 
program settings to liking. First thing, open the Profile setup window by executing the File > Profile 
select command sequence. Select the name of the current profile (e.g., Base) in the Profile field and 
press the Copy button. A line with the name of the new profile appears, Copy of Base in our example.  
It is useful to change this name on one that can be easily associated with the profile contents or its owner 
(e.g., Editor profile, or John Smith profile, etc).  

Command File > Select configuration 
The File> Select configuration command calls Configuration dialogue window 
in top line of which the dropdown list is placed. Available configurations of the program are listed in it 
(configurations which have been got by the user). Select one of them, necessary at present moment. The 
name of a configuration and its description are displayed below. 

After pressing OK button restart of the program occurs and the main window will open in such 
appearance which it is stipulated in the selected configuration. Usually this setting is carried out once 
after installation of system. The configuration of a concrete workplace during work varies seldom enough. 
Parameter Show this window on startup if no config selected needs 
no explanations. 

Command File > Login 
The File > Login command is used to enter the password that gives the specific user access to the 
resources in the volume defined by administrator. Executing this command opens the Enter user name 
and password window (Fig. 4.111). 
 

 

Fig. 4.111. The Enter user name and password window 

Command File > Administration 
The rights of users with different passwords are defined by the administrator. The File > Administration 
command opens the Administration window. This window is used to configure the user access rights 
and his name and password assigned. Only the administrator can access this window. 

Command File > Restart 
Command File > Restart restarts the DIGISPOT® II DJin program. 

Command File > Exit 
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Command File > Exit closes the DIGISPOT® II DJin program. 

4.11.2. The Editor Menu 
The Editor menu comprises the traditional editing commands users are familiar with from many Windows 
applications: 

• Undo cancels the last executed editing operation.  
• Cut cuts the selected object and puts it into the clipboard. 
• Copy copies the selected object and puts it into the clipboard. 
• Paste pastes the object from the clipboard into the project. 

Schedule items and block contents can be edited. Blocks cannot be moved but copies of blocks can 
be pasted. 

4.11.3. Menu View and Toolbars 
To execute the main operations, the DJin program has special toolbars. Clicking 
a button causes the corresponding action to be executed in the currently active window. The current 
window determines whether the button action is available; buttons of the actions unavailable in the 
current window are gray color. Displaying any of the toolbars can be enabled or disabled by the View 
command of the program's main menu. 

Brief descriptions of the toolbars follow. 
 

 

Fig. 4.112. The Tools toolbar 

This toolbar holds the tools for the clipboard operations and the search window call button.  
The toolbar can be used to work with audio items and other items practically in all modules of the 

DIGISPOT® II system. 
The panel comprises the following tools: 

 — cuts the selected object and puts it into the clipboard (duplicates the Editor > Cut 
command). 

 — copies the selected object and puts it into the clipboard (duplicates the Edit > Copy 
command). 

 — pastes the object from the clipboard into the project (duplicates the Edit > Paste command). 

 — searches for the item by the specified parameters. Clicking this button opens the Find dialog 
window (Fig. 4.113). 
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Fig. 4.113. The Find window 

The following steps are carried out in the Find window: 
• In the Search field dropdown list, select one of the fields, on which the search can be 

conducted (Artist or Name). 
• Enter the item’s artist or name into the input field in the upper part of the window. 
• Select the search direction (Up or Down). 
• Press the Find button.  

Clicking the Cancel button closes the window. 
The editing tools are used with the objects that support the copy, paste, and cut operations. Most 

often, these are audio items located in different modules, such as Files, F-Categories, Schedule, or 
Skeleton wizard. The buttons being active or inactive depends on the current active window. If copy, cut, 
or paste operations are allowed in the current window, the corresponding buttons are active. The search 
function operates in the same way: If the current window can search for 

a string in its contents, button  is active. The search function is primarily intended for list windows. 
Depending on the window, in which the search 
is conducted, the Search window provides a specific list of field (columns) that can be searched. 

 

 

Fig. 4.114. The Schedule tools toolbar 

This toolbar is used to work with schedules. It has several button groups. The first group comprises 
the buttons used to create special items in blocks. These are: 

 Inserting a pause into the currently selected block 

 Inserting a stop into the currently selected block 

 Inserting a microphone pause into the currently selected block 

 Inserting an Info item into the currently selected block 

 Inserting a voice track mark into the currently selected block 

 omit the schedule item 
The second button group comprises the final schedule editing buttons. These are: 

 Opening the search for the start point window 
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 Calling the editor for editing the contents of an audio or text item 
of the schedule 

 Calling the crossfade editor for editing crossfades between two or three items 

 Calling the crossfade editor for editing crossfades between  three items 

 Prelistening a crossfade 

 Calling the voice track recording module 
The third button group comprises the service command buttons. These are: 

 Creating block 

 Moving to the current time in the schedule 
 

 

Fig. 4.115. The Item tools toolbar 

The main command buttons used to work with schedule items are located 
on this toolbar: These commands can also be accessed from almost all system modules. 

 Prelistening audio items and viewing text items 

 Viewing the text of the comment of a schedule item or another module 

 Opening the properties window of an audio item or another schedule item 

 

Fig. 4.116. The Rotation tools toolbar 

 Left button (green). Adding a rotated item to the schedule 
 Right button (red). Replaces the rotated items with the actual audio items 

The primary function of the View menu is to select the items displayed in the main window. In 
addition, it has several commands to call certain dialog windows. The View menu comprises the following 
commands:  

• Toolbars is used to show/hide the Tools toolbar and the state string in the bottom of the screen. 
• AudioEditor starts the standard audio-editor. 
• Files opens the Files module floating window. 
• F-Categories opens the F-Categories floating window. 
• GPI status opens a floating window to view the status of the remote control system pins.  
• Restore default sizes returns the interface window sizes to the original state.  

Command View > AudioEditor 
Command View > AudioEditor allows opening of the standard audio editor window. 

Command View > Files 
The View > Files command opens the Files module floating window. This may 
be handy when working with a program configuration version using only one monitor. By default, this 
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command is called by the <Alt>+<F> hotkey combination. All functions of the regular Files module are 
available in its floating window version.  

Command View > F-Categories 
The View > F-Categories command opens the floating version of the 
F-Categories module window analogously to the View > Files command. 

Command View > GPI Status 
The View > GPI status command opens the Remote Control Status window (Fig. 4.117) for viewing the 
status of the remote control system pins.  

The window is used to configure the remote control system. 
 

 

Fig. 4.117. The Remote Control Status window 

4.11.4. Menu Service 
The Service menu comprises the commands providing access to the configuration windows including 
those for configuring the DIGISPOT® II system, for selecting the DIGISPOT® II DJin program 
configuration, and for configuring numerous parameters. The following are descriptions of the menu 
commands.  

• Settings calls the Settings window for configuring a specific program (DIGISPOT® II DJin in 
the instant case). The programs comprising the DIGISPOT® II system do not read each other 
settings, nor share them among themselves. 

• Global settings calls the Global settings window for configuring parameters shared by all 
DIGISPOT® II system programs on all workstations 
at once. To this type of settings, for example, the default audio format, the rules for adding files 
to the storage, the external storage directories, etc. pertain. 

• Workstation settings opens the Workstation settings window 
to configure all DIGISPOT® II system programs on the given workstation. Modifications made in 
one program affect the other programs. 

• Show error log calls Message window which contains two tabs: Text messages and Test 
values. 

• Customize settings calls Customize keyboard and remote keypads window. 
• Fonts calls Fonts setup window. 
• Import formats calls Import format window. 
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• Reserving status calls the File reserve system info window. 
• Fast jingles setup calls the fast jingles player setup window. 
• Hardware devices opens the submenu comprising commands Digigram, Antex, Audio 

Mixers, Retransmission channels that open configuration windows for the corresponding 
hardware devices (Digigram, Antex commands are disabled if you do not use the equipment of 
these producers). 

• Delete unused material calls the same-name window, in which the process of the automatic 
search for non-used audio files is performed. The process can be interrupted by clicking the 
Cancel task button. All files (audio, text, project, and other registered in the system) found in the 
global storage but not intended for use in all schedules from the current day onward are 
displayed in the window. All found files or only part of them can be deleted at user request. The 
contents of the files intended for deletion can be prelistened or previewed. Moreover, 
automatically deleted are all waveform files (files with the SS8 extension) without the original 
audio file. 

A detailed description of the configuration system is given in Section 4.2. 

4.11.5. Menu Help 
The Help menu comprises three commands: 

• About DIGISPOT® II DJin opens the same-name window, in which the version 
of the DIGISPOT® II DJin program and the author rights information are displayed.  

• Components and licenses opens the window, in which all available DIGISPOT® II DJin 
components are listed. 

• Look for updates - installation of new versions of the programs which are included in the 
DIGISPOT® II system. This command requires the administrative access rights and is included 
depending on the software set supplied. 

4.12. The DIGISPOT® II DJin Program  
Configuration System  
The DJin program was developed with these important principles as the foundation: 

• The functional flexibility of the program allowing the most diverse user requirements to be met. 
• The ease of reconfiguring the functional setup, the graphical interface, and the program 

parameters.  
• The reliability of the program operation eliminating the possibility 

of occurrence of gaps in the broadcasting.  
• Simultaneous operations over the schedule by several persons performing 

a common task or individual tasks at different workstations. 

The program created in the process of implementation of these fundamental principles and of 
numerous specific technical requirements is bound to have 
a developed configuration system.  

The DJin program, the same as the DIGISPOT® II system as the whole, has three types of settings. 
These are the following: 

• Global settings. These are a group of parameters stored in files that are located in a network 
directory accessible from all workstations of the system. The path to this directory is one of 
system's most important parameters and is called the root path or simply the Root. Global 
settings parameters are common for all workstations. Modifying these parameters from one 
workstation affects operation of the other workstations. However, these modifications become 
effective on the other workstations only after their programs are restarted. Practically all 
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DIGISPOT® II complex programs use global settings; although, not all of them can edit these 
settings or even display their current values. To this type of settings, for example, the default 
audio format, the rules for adding files to the storage, the external storage directories, etc. 
pertain. 

• Workstation settings. These settings are stored in files located in the SYSTEM directory, 
which is always in the same directory as the program's executable file. These settings are 
common for all programs installed into this directory. Modifications made in one program affect 
the other programs. An example of such settings is the root path itself, which must be the same 
for all programs of a workstation.  

• Program settings. This is a set of parameters specific for a particular EXE module. None of the 
DIGISPOT® II programs reads this type of settings belonging to the other programs. 

As a rule, the global settings and the workstation settings are configured 
by a representative of the developer or at least by an experienced system administrator.  

Most of the non-critical program parameters have default settings. Thus, even if the user does not 
undertake any special steps to configure the program, he can still start learning how to use it. When an 
attempt is made to access a component that has not been configured, a corresponding message is 
issued. 

NOTE 
This section should be considered as a reference. It is advisable to first cursory familiarize yourself with its contents and as you 
master more of the program functions, return to it in order to comprehend the settings performed.  

Most of the settings are accessed through the Service menu (whose commands are reviewed in 
Section 4.2.1). 

This section is devoted to describing in detail performing settings in the windows that are opened by 
the following commands:  

• Service > Settings 
• Service > Global settings 
• Service > Workstation settings 
• Service > Customize keyboard 
• Service > Fonts 
• Service > Import formats 
• Service > Reserving status 
• Service > Fast jingles setup 
• Service > Hardware devices (submenu) 

Some of the listed commands take the user or the system administrator to the windows used to 
perform critically important settings. Other settings do not affect the operability of the system or the 
program but make it possible to create suitable conditions for more efficient use. 

4.12.1. Service > Settings 
The Service > Settings command opens the Settings window for configuring 
a specific program (DIGISPOT® II DJin in the instant case). The Settings window has the following tabs: 
General, PFL, Text, Playback, Log, Log fields (fields saved in the log file), Language (the interface 
language), Shares, and Other. Let's consider the functions of the controls and fields of the enumerated 
tabs. 
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The General Tab 
The General tab of the Settings window is shown in Fig. 4.118. 

 

 

Fig. 4.118. The General tab of the Settings window 

The functions of its controls and fields are as follows: 
• Day start hour. This field is used to set and display time (in the HH:MM format) that is used as 

the date change time. Usually, 00:00 is considered the new day start time, but sometimes this 
time must be different. For example, if a station broadcasts from 06:00 to 01:00, it is more 
convenient to have one schedule covering this period than to plan one extra broadcasting hour 
in another schedule. 

• Radio station. This dropdown list is used only when several radio stations work jointly sharing 
parts of the schedule. 

The PFL Tab  
The PFL tab of the Settings window is shown in Fig. 4.119. 

Prelistening an item (PFL) means listening to an item without broadcasting 
it. The PFL tab is used to set the PFL operating mode in the interface windows. 
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Fig. 4.119. The PFL tab of the Settings window 

The PFL group has three radio buttons for selecting one of the following options: 
• Disabled. The PFL is disabled. 
• Autoselection. A free output channel, not used for broadcasting at the given moment, is 

selected for the PFL automatically. This mode requires particular settings specified in the 
configuration file. This PFL mode should be selected only after consulting with us. 

• To selected channel. The device selected in the dropdown list to the right is used for the PFL. 
When selecting the device, you must make sure that the output signal of this device will not get 
to the system's main output, that is, on the air. 

• Enable multichannel PFL. Allows to start PFL mode simultaneously several items in different 
channels. 

The Text Tab 
The Text tab of the Settings window is shown in Fig. 4.120. 

 

 

Fig. 4.120. The Text tab of the Settings window 

The functions for exchanging text messages among the DIGISPOT® II DJin system workstation are 
configured on this tab.  

The path to the shared directory of the system for storing the text exchange files is selected in the 

Path field. The path is selected by clicking button  located to the right of the path field. A standard 
dialog window for file system operations opens, in which the necessary directory is located or created. 

The name, under which the computer will appear in the message recipient list, is entered in the 
Name field.  If the field is empty, the computer network name 
is displayed. 

Setting the Delete old messages after _ days flag makes its field available for specifying how 
many days the program is to store the messages.  

Setting the Show the "Send" button flag places a prominent Send button 
in the upper part on the main window of the program. This button is handy for sending text messages. 

The Playback Tab 



Cooperation for Development of Hard-and Software 
for Audio and Video Broadcast Studios in East and 
West Europe. Design and Manufacturing of Studio 
Equipment  for the Audio recording Industry and the 

 

 
e.mail: info@tract.ru   e.mail : infor@barthkg.com  
 web :http//www.tract.ru   web : http://www.barthkg.com 
 

    

 

copyright: RBKG&TRC  Page 179 of 219 

in field of Video Postproduction. 

The Playback tab of the Settings window is shown in Fig. 4.121. 
 

 

Fig. 4.121. The Playback tab of the Settings window 

The Player settings group is used to set up the parameters of the interface with the audio card. 
The number of the player buffers and the buffer size 
in milliseconds can be configured here. These settings should be modified only 
if problems with the signal playback are encountered, and only after consulting with us.  

The Default crossfade group is used to configure the automatic crossfade parameters for cases 
when the crossfade location cannot be determined 
in advance. (For example, when an audio item is cut by the player to observe 
a time check point or when going to the next item by clicking the Start next button in the double player.) 
In essence, the duration of the crossfade is specified here, that is, the time in milliseconds it takes for the 
first audio item's level to fade and for the level of the next one to increase to the nominal value.  

The point of equal audio levels of the first and the next audio items in the crossfade can be 
specified in the Start next at fade-out level field. (The equal levels are those on the diagram depicting 
the crossfade process and not the actual audio levels during the playback.) 

NOTE 
These settings affect the system functioning and must be performed only by a qualified administrator.  

The Log Tab  
The Log tab of the Settings window is shown in Fig. 4.122. 
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Fig. 4.122. The Log tab of the Settings window 

The Log abbreviation stands for "logging": saving the information about the actual broadcasting of 
the scheduled audio items. 

The logging filters are set using radio buttons No logging, From selected directories only, 
Exclude selected directories, and Log all files. Logging 
of only certain type audio items can be performed (for example, commercials), excluding certain type 
audio items, of all audio items, or none at all. The logging data can be used to generate reports of the 
audio items broadcasted and their airing time.  

The items in the Create log files in directory group are used to set the path to the directory, in 
which the text report of the program operation is to be saved (information on played back audio items, 
playback time etc.) 

Specify the paths to directories of file system in the Path list in which logging should be carried out. 
For creation of an item of the list click the Add button. Select the directory in appeared standard dialogue 
window and finish procedure 
by pressing OK button. For removal of the catalogue from the list, select it and press Delete button. 
Change of the order of directory sequence is made by  and  buttons. 

The Log fields Tab 
The Log fields tab of the Settings window is shown in Fig. 4.123. 
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Fig. 4.123. The Log fields tab of the Settings window 

The Log fields tab is used to select the fields to be saved in the broadcasted item log. The user 
can select the fields at his own discretion or according 
to advertiser or radio station administration requirements. 

The object, whose set of the saved fields is edited, is selected in the dropdown list in the upper part 
of the tab. This can be done for two options: to configure the log file fields (the Fields stored in log file 
version) or the text file fields (the Fields stored in text file version). Each version has its own set of 
available fields listed in the same-name list. Finally, the Stored fields list is created. This is done using 
buttons  and  to move entries from the left list to the right one and vice versa. By default, all 
available fields are saved. 

The Language tab 
The Language tab of the Settings window is shown on Fig. 4.124. 

 

 

Fig.4.124. The Language tab of the Settings window 
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In the dropdown Language list the language of the graphical interface can 
be selected. The possible options are Russian and English. 

Character set. This is one of the parameters affecting the visual depiction 
of the utilized fonts. If you do not experience any problems with displaying fonts, do not change this 
parameter. Its values are the following: 

• Russian charset specifies the Russian character set explicitly. 
• Default charset and ANSI these are two different ways to select one 

of the character sets depending on the system settings. They work slightly differently with 
different versions of MS Windows (XP, 2000, NT). 

The Shares Tab 
The Shares tab of the Settings window is shown in Fig. 4.125. 

 

 

Fig. 4.125. The Shares tab of the Settings window 

The DJin system has network paths to the shared system files used by all the workstations. In this 
case, the computer, on which the system resources are located, must access these resources (i.e., 
access itself) over the network. The settings on the Shares tab of the Settings window allow the network 
path 
to be replaced with the local path for this computer and to significantly speed up its access to those 
resources. 

The replacement is carried out as follows: Clicking the Add button opens 
a standard dialog window named Browse for Folder, in which the network resource is selected. After 
this, another window named Local path for (network resource name) opens, in which the local path is 
selected. After the path 
is selected, a line with the selected paths appears on the Shares tab of the Settings window. The path 
selection can be repeated for several substitutions. 

Clicking the Delete button deletes the selected path line.  
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Setting the Check on startup flag allows the computer to determine its network resources at 
startup to optimize the access to its own files via the network name. (This option is available only to users 
with the administrator rights). 

Setting the Scan on startup flag makes it possible to check whether the given resource exists, and 
to delete it from the list if it is not. (This option 
is available to all users.) This makes it possible to avoid problems with old resources deleted by the 
administrator. 

The scanning for network resources procedure can be started at any time 
by clicking the Scan button.  

The Other Tab 
The Other tab of the Settings window is shown in Fig. 4.126. 

 

 

Fig. 4.126. The Other tab of the Settings window: 
the Interface category list is opened 

The Other tab contains additional parameters and is used as follows. The left part of the tab 
window contains a list of categories of the additional parameters named Parameter. Clicking one of the 
categories (for example, Interface), opens the next category level containing, in our example, the Filter 
window and Colors categories. When a category is opened, the + symbol in front of it turns into the — 
symbol. Clicking the Filter window and Colors subcategories, we obtain access 
to all additional parameters of the Interface category (Fig. 4.126). In the same way, the complete lists of 
the additional parameters for all root categories, sown 
in Fig. 4.125, can be opened. Clicking a category again folds its tree 
of subcategories and parameters. 

Now all is set for editing the additional parameters. This is done in the right column of the work area 
containing the Value list. Double clicking a parameter value in this list opens the window for editing this 
parameter value. The appearance of the window depends on the parameter being edited. If a parameter 
can take 
on several fixed values, its value-editing window has a dropdown list of these values. For example, the 
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Search by mask parameter takes on values From the beginning and From any part of line (Fig. 4.127, 
a). Its current value is From any part of line. 

Many of the additional parameters take on one of the two values: Yes 
or No (enabled/disabled). If a parameter can take on any numerical value, its value-editing window has a 
field for entering it.  For example, the Active button highlighting parameter can be any integer (Fig. 
4.127, b). If a parameter is used to set the file storage path, the value-editing window reduces to the 
standard file search dialog window (Fig. 4.127, c).  

 

 

a 

 

b 
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c 

Fig. 4.127. Different parameter editing windows 

If a parameter sets a color (for example, Active pane border), clicking it for editing opens the 
standard Windows interface color-editing window (Fig. 4.128). 

NOTE 
The parameter value editing window can be opened by the right click instead of the left. In this case, first a one-
item menu opens. Clicking its only command — Change — opens the editing window.  

The functions of many parameters are clear from their names. In addition, editing windows, as a 
rule, offer help as to the allowed parameter values. Some additional parameters substantially affect the 
program functioning, others have 
no principal importance but only allow the user to individually setup the interface 
in the most comfortable way. The parameters have default settings and these are better not to be fiddled 
with at first. It is advisable to attempt adjusting parameter values only after you have mastered working 
with all important operations and have a clear understanding of the interface components and the 
operation modes 
of the functional modules. It is recommended to consult the material in this section during the process of 
your mastering the program. 
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Fig. 4.128. The item color-editing window 

The supplementary parameters are structurally grouped by the following categories: Interface, 
Audio files marking, Text, Base settings, Schedule, External programs, AudioEditor,  Audio files, 
Prelistening, Parameters of the audio reserving system, XML (Logs), Skeletons, Jingles, MDB, 
Voice track, Files, F-Categories. 

Let's consider each of them. 

The Interface Category 
In addition to several individual parameters, the Interface category also comprises the following two 
subgroups of supplementary parameters: 

• The Filter window 
• Colors 

The Filter window subgroup has a single parameter, Search by mask, which can take on one of 
the two values: From the beginning and From any part of line. Let's consider its function in detail. 

The Search by mask is a parameter of the filtration system that functions 
in the Files, F-Categories, and MDB windows. The "mask" is a string in a list field, by which the list is 
filtered. An example is shown in Fig. 4.129. In this case, the contents of the window have been filtered on 
the Name field. Only those items that have string s in their names are displayed. The value of the Search 
by mask parameter is From the beginning. 

The results of the same filtration, but with the value of the Search by mask parameter being From 
any part of line are shown in Fig. 4.130. 

 



Cooperation for Development of Hard-and Software 
for Audio and Video Broadcast Studios in East and 
West Europe. Design and Manufacturing of Studio 
Equipment  for the Audio recording Industry and the 

 

 
e.mail: info@tract.ru   e.mail : infor@barthkg.com  
 web :http//www.tract.ru   web : http://www.barthkg.com 
 

    

 

copyright: RBKG&TRC  Page 187 of 219 

in field of Video Postproduction. 

 

Fig. 4.129. Only the items containing string s in their names are shown: 
the value of the Search by mask parameter is From the beginning 

 

Fig. 4.130. Only the items containing string s anywhere in the item name are displayed: 
 the value of the Search by mask parameter is From any part of line 

The filter string can contain character * analogously to the file name mask. Character * stands for 
any number of any characters (none is also an option). 
If this character is not specified in the query explicitly, the search string is built depending on the 
described parameter. That is, in the first example, the string actually searched for was s* and in the 
second example it was string *s*. 

If character * is specified explicitly in the query string, the value of the Search by mask parameter 
is ignored and the string is searched for as is, for example pretty*scarlet (Fig. 4.131). 
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Fig. 4.131. Using explicitly specified symbol * in searches 

The value of the Search by mask parameter is set according to the user preferences and takes 
effect after the program is restarted. It affects any similar filters in all other program windows. 

The supplementary parameters of the Colors subgroup are assumed 
to be understood and not needing additional explanations.  

Directly in the Interface category, included are several parameters that define the color theme of 
the interface components. Their meanings are clear from their names. Parameters Display artist in the 
'Title' column and Use 'Directory Tree' window can be accessed from the Interface category. These 
parameters need some explaining. 

The supplementary parameter Display artist in the 'Title' column takes 
on Yes or No values and affects all audio item lists in all system modules that have the Title column (F-
Categories, Files, Schedule, MDB, etc.). 

Enabling this option adds a string with the audio item's artist name to the Title field value attached 
to it through a hyphen. The option is usually enabled 
on workstations to give DJs more complete information about audio items. It has 
no effect on the schedule playback: The added string is not used in filtering on the Title field. 

If the Use 'Directory Tree' window parameter is given value Yes, then when a directory needs to 
be selected, the program opens the standard Windows dialog window for viewing a directory tree. If this 
parameter is given value No, the standard Windows system window for selecting a file is used instead. 

The Use old style phonograms marking window parameter allows 
to select a way of audio items marking; strongly recommended to set this parameter to No value. By the 
way, an old window with Use old style phonograms marking window parameter will be removed in 
future DJin versions. 

Other parameters of the Interface group concern only appearance of the application and need no 
additional explanations. 

The Audio Files Marking Category 
The Audio files marking category has subgroup Search for start point containing supplementary 
parameters that define a search for a position in an audio item by ear. These are the following: 

• Algorithm. One of the several options to control the start, stop, speed, and direction of the 
playback. It is used only in the Search for start point window, but plans are in the making to 
introduce it everywhere where 
a certain position in an audio item needs to be found by ear.  Depending 
on the algorithm, the program reacts to the same playback control buttons in a different way. 

• The Minimal speed (nominal 1.0) and Maximum speed (nominal 1.0) are the upper and the 
lower boundaries, within which the program allows the playback speed to be changed relative to 
the conventional speed unit, which is taken to be the normal playback speed. For example, 
parameter value of 2 means two times the nominal speed, a value of .5 means half the nominal 
speed.  

• The From minimal speed (ms) and From nominal speed to maximum speed (ms) 
parameters regulate the playback acceleration. They set the time taken by program to reach the 
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corresponding playback speed limit starting at the nominal speed when the acceleration or 
breaking mode 
is enabled. The longer the acceleration or breaking time, the smother the speed changes. 

The Text Category 
The parameters of the Text category define the characteristics of the text in the view windows. The 
parameters and their functions are as follows: 

• Reading speed, char/min. Sets the value used by the system to estimate how long it will take 
for the announcer to read the text.  

• Highlight color. Sets the text color. The standard color selection window is used to select the 
parameter value.  

• Font. The parameter values in this subgroup are set for the selected text items using the 
standard Windows font-selection window. 

• Colors. When this parameter subgroup is selected, supplementary color setup lines appear to 
select different subject items. 

The Base Settings Category 
The Base settings category contains mostly tools for specifying paths to where different data are stored.  
The parameters in this category need to be configured only in special cases; usually, there is no need to 
modify them. 

• F-Categories path (ROOT\BMK). Used to specify the directory where descriptions of F-
Categories are stored. Generally, this is the BMK subdirectory of the ROOT directory specified 
in the workstation settings. The need to change the path may arise, for example, when more 
than one version of F-Categories is needed within one complex, for example for different studios 
(e.g., for the news and musical broadcasting). For some workstations, the path set by the 
administrator is specified, while for the rest of them the standard path is specified (i.e., this 
parameter is not set). This affects the information displayed in the F-Categories module and the 
jingle machine. Different F-Category description paths can be associated with different profiles. 
In this case, loading one profile makes one set 
of F-Categories available for use, while loading another profile makes another set available.   

• Main schedule storage path (ROOT\PLAYLIST). This parameter 
is similar to the previous one. However, instead of the F-Categories, the path to the main 
schedule is defined. The parameter may come in handy when, for example, working with 
schedules for several stations or with schedule versions for different regions. The parameter 
defines the standard schedule of a given workplace, but it can be reconfigured in the settings 
of the specific schedule module.   

• Reserve schedule path. If this path is specified, every time the working schedule is modified, 
the program stores a copy of the schedule in the specified directory. This allows the workstation 
to switch to working with the local copy of the schedule in case of a communications failure with 
the main computer, on which the original schedule is located (see Main schedule storage 
path). This is one of the ways to enhance the reliability of the system. This parameter is most 
often specified on the broadcasting workstations. Switching to working with the local schedule 
copy disables editing the main schedule because the original can be changed from other 
workstations while it cannot be accessed from the given workstation. When the communications 
with the main workstation are restored, the local schedule copy is automatically synchronized with 
the original. The use of this parameter is often combined with the use of the reserve/spooling 
system. 

• Fragments storage directory. This is the directory where specific audio files of the BCS Editor 
workstation are stored. This parameter should not 
be edited in the DJin program.  
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• Storage for editor temporary files. This is the directory where temporary audio files of the 
BCS Editor workstation are stored. This parameter should not be edited in the DJin program. 

• Copy to global storage. This parameter defines the necessity of audio item copying to the 
global storage at its addition to MDB. 

• Convert to default audio format. This parameter defines the necessity 
of audio item conversion into the standard audio format accepted in MDB. 

For the modified settings of this category to become effective, the program must be reloaded. 

NOTE 
The operating system does not need to be rebooted for any of the modified settings 
to become effective. 

The Debug logs category (restart needed) 
This category contains the parameters used by developers at debugging of one 
or another functions. In ordinary work these parameters are not necessary. 

The Schedule Category 
Let's consider the supplementary parameters of the Schedule category. We start with the parameters 
used to display block duration in the schedule and block duration errors. 

• Show block duration. Enables displaying in the block header the scheduled block duration, 
specified when the block was created. The possible values: Yes or No. The value of Yes 
enables displaying in the block header the block's scheduled duration, which is specified in the 
Duration field of the block properties window. The duration is displayed only if it is other than 
zero, that is, it is actually set. 

• Show block duration error. Enables or disables in the block footer the difference between the 
scheduled duration of the block and the actual duration of its contents. With the parameter set to 
Yes, the block duration error is always displayed even if it equals zero, but only if the scheduled 
block duration is other than zero.  

• Show block length error in header) - the parameter is analogous 
to previous one, but displayed in the block header line. The difference 
is that the error is displayed in header line only if it is more than 1 seconds, and desirable 
duration of the block is other than zero. 

• Show block end error. Used to display in the block footer the difference between the 
scheduled end of the block (the block's airing time + the block's scheduled duration) and the 
actual end time. The actual end time 
is calculated as the airing time of the first item plus the block's actual duration (the sum of its 
items runtimes). In the blocks that have the Fixed time flag set in the block properties (such 
blocks are marked in the schedule by a clock-face icon on the right to the block start/end 
symbol), this error always coincides with the block duration time error because their airing time 
is fixed. This can be seen in Fig. 4.132 in the footer of the first block. In the blocks whose airing 
time is not fixed but is determined as the end time of the previous block, the error depends on 
the nature of the schedule planning. It shows by how much the block end time differs from the 
scheduled end time at the current state of the schedule (the block's airing time + the block's 
scheduled duration). In this case, the block's airing time is considered as recommended or 
expected because it is not fixed. The error is displayed only if it is greater than 1 second 
provided that the scheduled bock duration is other than 0 seconds.  
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Block duration error in the footer Block end error

Block duration error
in the header

Scheduled block duration

 

Fig. 4.132. Displaying block duration and the various errors 

Let's continue the description of the Schedule category parameters. 
• Time calculations inside the hour only. Defines the time reference point 

in the schedule. 
• Ask confirmation before delete operation – Defines the necessity 

of confirmations before deleting operation. 
• Type OVER instead of overplaned music item start time. Setting "overplaned" audio items 

indication in the schedule. 
• Preload blocks (min). Used to set the block loading time (for any block 

or only for the specified-type blocks) into the block player when broadcasting in the automatic 
mode. The block is loaded the specified time in advance of its scheduled airing time. Changing 
the value of the parameter affects all configurations that automatically load blocks into the block 
player (for example, the 777 configuration). If the value of the typified parameter is 0, the time 
from the first, common, parameter 
is used. 

• Unload blocks (min). If a block loaded into a player for some reason has not been broadcast, it 
is removed from the player after the specified time relative to its scheduled airing time. 

• Show hour headers. Displays the hour start lines in the schedule. The possible values: Yes or 
No. 

• Show hour end. Displays the hour end lines in the schedule. The possible values: Yes or No. 
• Show empty positions. Inserts a line with the word EMPTY between two schedule blocks if the 

scheduled end time of the current block is earlier than the start time of the next block. The 
duration of the gap is shown after the word EMPTY. The possible values: Yes or No. 

• Show conflicts. Inserts a line with the word OVER between two schedule blocks if the 
scheduled end time of the current block is later than the start time of the next block (i.e., the 
blocks overlap). The duration of the overlap is shown after the word OVER. The possible values: 
Yes or No. 

• Show next item position (yellow line). In the schedule window, highlights in yellow the position 
of the item following the one currently played. (The current item is highlighted in bright green.) 

• On startup load schedule for … - Selecting of the day, the schedule 
on which is loaded at the program startup. 
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• Keep visible active item – this parameter allows scrolling the schedule automatically keeping 
the active audio item in sight. 

• On double click. Selects the function called when a schedule item 
is double-clicked with the left mouse button. The following four options are available: calling the 
PFL (prelisten the item), calling the audio item Properties window, or calling one of the 
crossfade editors (Crossfade 
or Crossfade3). 

• Show 'File' tab on item properties window. Controls displaying the File tab in the Properties 
window that is opened by the Properties command of the context menu. There are three 
options: Yes — always show; Only for items without a file — show only for those schedule 
items whose file is for some reason not specified or unavailable.  No – never show. 

• Editor type. Indicates the editor called for editing of items. The possible values: BCS-Editor or 
Built-in. 

NOTE 
Parameters Show hour headers, Show hour end, Show gaps, Show conflicts cause additional controls to be displayed in 
the list showing how the time of one schedule hour is utilized. By default, these parameters are disabled for schedules and 
enabled for skeletons. Usually, the parameters are not enabled or only the hour start is enabled 
to indicate this important moment in a more visible way.  Of importance is the fact that gaps and overlaps are calculated using 
the scheduled times. The actual contents of the block do not affect the time-usage analysis. During broadcasting, the information 
displayed in the EMPTY and OVER lines may not reflect the actual situation. 

Several supplementary parameters of the Schedule category are grouped 
in five subcategories: Import, Colors, Zone broadcasting, Appearance and Time frames. 

• Import. The subgroup for setting of import parameters of the schedule. 
o Clear schedule before import. Setting this flag clears the schedule before import 

operations. The flag must be set if the entire schedule 
is imported by one import operation.  

o Show import dialog when opening empty schedule. Setting this flag causes the import 
window to open when accessing a schedule for the first time, that is, when creating it. 

o Warn when dates do not match while importing. With this flag set, the program issues a 
warning when encounters a situation of the date in the text of the imported schedule not 
matching the date of the destination schedule. 

o Change schedule date while importing. With this flag set, in the case of the differing 
dates described in the previous item, the date 
of the destination schedule is automatically changed to the date of the imported schedule. 

o Ext-format. This parameter is used to associate the extensions of the imported files and 
import formats. This adds a filter with the specified extension to the Open file-selection 
window for the import operations 
of the corresponding format, which facilitates locating the necessary files. Otherwise, the 
Open window extension list has only two items: *.txt and All files (*.*). 

o Remember DB ID. Blocks are always tested after importing 
a schedule from a file. Block testing can also be carried out independently from the menu 
called clicking button  in the Schedule window. This parameter is used to remember 
the MDB item identifier found by the ID Number is such testing. If the parameter value is 
set to Yes, in the first testing the program finds in the MDB the schedule item linked to the 
ID NUMBER and remembers its DB ID, after which it no longer pays attention to the ID 
NUMBER. If the parameter value is set to No, during a successive testing the program 
searches for the item in the MDB by its ID NUMBER. Consequently, this gives a possibility 
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to correct a schedule item's ID NUMBER and test the blocks again, after which the 
contents of the schedule item can change (e.g., if the contents need to be changed 
explicitly). The value of the parameter is set depending on the schedule import procedures 
employed by a particular radio station. It is usually set 
to Yes. 

o Search DB only for imported items. Used to search in the schedule for only those items 
that were added to the schedule through the import from a text file ignoring explicitly added 
items. The value of this parameter is set depending on the import procedures employed. 
It is usually set to Yes. 

o Force-test for all items. This parameter is used mainly to redefine the previous two 
settings, although it also has other functions. Setting its value to Yes causes the system to 
constantly search in the MDB for all schedule items. Usually, during block testing the 
search in the MDB for an item terminates after an item with actually existing file is found. 
Setting the value of this parameter to Yes forces the system 
to constantly search in the MDB for a schedule item even after an item with an existing file 
has been found. The value is usually set to No.  

o Search in F-Categories (no DB). Setting corresponding flags in this group enables item 
search in the categories of the F-Categories module by the specified characteristic: 

o Search by name. Enables search for the imported item by name among all items in all 
categories of the F-Categories module. The categories are searched in alphabetic order; 
finding the first matching item name ends the search.  

o Search by ID Number. Setting this flag enables the search 
by ID Number. (ID Number is the identifier used for audio items stored in a database 
external to the DIGISPOT® II system.) The search algorithm in the case is the same as in 
the search by name.  

o Directories for searching item file. The list of directories, in which the search of files 
connected with imported schedule items should 
be carried out. 

• The parameters of the Colors subgroup serve to highlight different schedule items. 
• Zone broadcasting – control of zone broadcasting mode. This given option works together with 

Logger, recording the basic signal of radio station. The broadcasting software searches files 
recorded by Logger and substitutes them in the schedule before the iteration module. Starting of 
this mode 
is carried out by setting of Use repeat items and Fill repeat items parameters (the latter is for 
radio configuration). After starting of given mode in the service menu of the Schedule module  
the additional point Zone broadcasting appears, which selecting causes opening of the window 
of creating and changing of these items, where the catalogue 
of logs storage and an interval of time which should be repeatedly played back, can be 
specified. 

• Last subgroup of parameters is the Time frames group. It contains the parameters operating the 
displaying of the schedule (the time interval, 
to which the schedule is displayed) mode. 

The External Program Launch Category 
The External programs category contains tools for selecting commands for launching external 
applications simultaneously with the start or termination of the DIGISPOT® II DJin program. The following 
are some examples of the potential use of this capability:  

• Launching a program for controlling or configuring an external signal-switching device 
simultaneously with the launch of DIGISPOT® II DJin. 
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• Launching a program for automatic copying and/or sending broadcast item report files to some 
predefined place. 

The category does not belong to the required settings and is intended 
to be used at user's discretion.  The On load configuration subgroup is specific for the subgroup, in 
which its parameters are configured; the other two subgroups (On startup and On shutdown) do not 
depend on the configuration.  

The Audio editor category 
The Audio editor category contains subgroups of settings for operating of the built - in audio editor. 

The subgroup of parameters the User interface allows to set many elements of DIGISPOT® II 
system at the request of the user. From the given subgroup following parameters require to be explained: 

•  Auto crossfade (ms). This parameter allows to specify which length value of auto crossfade 
will be used in the Autoglue settings window, called by Auto glue marking command of the 
Schedule module context menu; 

• Save auto crossfade last value. In contrast to the previous parameter, this option allows to 
save the length value of auto crossfade, specified 
by the user in the Autoglue settings window, offering it "by default" 
by the following call of this command; 

Concerning additional information on parameters of this group address to the Manual of BCS-
EDITOR program. The nested group of parameters Mouse wheel operates functions which are assigned 
to this option in DIGISPOT® II system. It contains the following options: 

• Action. The parameter has 4 values: Zoom from center, Zoom from active marker, Zoom 
from play marker and Zoom from mouse position; it allows to adjust the action which is 
carried out by scrolling wheel in the audio editor. 

• Action (glue).The parameter is similar with previous one, adjusting the action of the scrolling 
wheel for the audio editor in the crossfade editing mode. 

• Zoom step. This is a value specified in percentage and determining speed of scaling with the 
help of scrolling wheel of for both audio editor modes. 

The subgroup of Shuttle parameters of the Audio Editor category allows operating displaying of 
the shuttle element of the audio editor interface. 

The subgroup Default project settings contains only two elements: 
• Set edit step for mp2 blocks - defines a mode of block editing for files 

of MP2 format; 
• The Record gain - defines the recording level of voice tracks in the project. 

The subgroup of Crossfade editor parameters of Audio Editor category operates parameters of 
editor start in the crossfade of two and three items mode. It contains only two settings: View area and 
Create additional empty track loading schedule item. 

The subgroups of Playback and Record parameters contains similar settings Number of blocks 
and Block size, allowing fine-adjusting of playback and recording modes respectively. 

The Audio files category 
Following parameters are present in the Audio files category: 

• Enable SEQUENTIAL SCAN mode. The parameter is added since 2.8.36 version. It controls 
the SEQUENTIAL_SCAN mode (the mode of preliminary consecutive scanning of audio file 
before playback). 
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• Write file block size, Read file block size. These parameters control processes of recording 
and reading files, allowing adjusting them according to hardware capabilities. 

• Write file blocks count, Read file blocks count. The second group 
of the parameters controlling recording and reading files. 

• Video devices buffer size – needs no explanations. 

The Prelistening Category 
The Prelistening group contains the following parameters: 

• End part prelistening. Controls the time which is played back by a call 
of prelistening of audio items finishing part. 

• Start part prelistening. The similar parameter for prelistening of audio items starting part. 
• Close window automatically after end of playback. This parameter needs no additional 

explanations. 

The Copyright registration category 
The new group of parameters Copyright registration includes following parameters: Enable 
registration, Server address, Reregistration server address and Block size. 

The Audio Devices Category 
This category has only one subgroup: Playback. It is used to configure the parameters of the Software 
Processing (SP) device and WAVE.  

A software processing device is a standard Windows device whose capabilities are expanded by 
the means implemented in the DIGISPOT® II system. These devices serve to ensure the execution of the 
necessary functions regardless of the audio card type used. The special algorithm implementing the 
exchange with the audio device allows the following capabilities: 

• Variable playback speed  
• Signal-level adjustment 

A most important feature of a software processing device is the short system-response time to the 
changes in the external control signal. For all practical purposes, it may be assumed that the processing 
is performed in real time. 

The Playback subgroup has two parameters: 
• SP device: block size (samples, multiples of 1152). The size of a data block processed as 

one unit. 1152 ADC samples is the size of one MPEG stream block. An SP device's block size 
being a multiple of this number makes for the optimal internal processing.   

• SP device: No. of blocks. The number of blocks the SP device's internal buffer holds. 

NOTE 
A sample is an ADC sample. At the 44,100 Hz sampling frequency, 44,100 samples are made per second. 

The block size and number of blocks may have to be increased to deal with the distortions some 
audio cards produce when processing the audio. The system-response time to the control signal 
increases in this case. 

For the modified settings of this category to become effective, the program must be reloaded. 
The same subgroup contains parameters for WAVE-devices. All of them are responsible for 

interaction with an audio card and change only in case if standard values cause any malfunctions at 
working with devices. 
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The Audio Reserving System Parameters Category 
This category comprises the parameters used to control the audio file reserve system. The reserve 
system is used to copy to the workstation's local disk schedule files used in the F-Categories that can be 
physically located on other computers. This enhances the fail-safety of the DIGISPOT® II system in event 
of the communications failure. Another use of the reserve system is spooling the needed files over slow 
communications lines. 

Let's consider the parameters of the Audio reserving system parameters category. 
• Archive path (restart needed). This is the main parameter. If this path 

is set, the reserve system is enabled after the program is reloaded; if the path is cleared, after 
reloading the program the reserve system is disabled. This local directory is used by the reserve 
system to store the local copies of the files whose originals are stored on the other computers.  

• Enable to reserve F-Categories. If the value is set to Yes, the files used in the F-Categories 
module are reserved, otherwise they are not.  

• Copy files from local hard drive. This storage is used to copy files stored in other directories 
on the given computer. This approach makes it possible to obtain a complete archive of all the 
files used by the system.  

• Maximum traffic (KB/s). The maximum file spooling rate. Files are spooled in the following way. 
From the schedule, the program learns the scheduled airing time of a given file. If less than an 
hour remains to the airing time, the spooling over the network is conducted at the rate specified 
in the parameter. By default, the parameter value is set to 0, which means that the copying is 
performed without any traffic limitations, that is, at the maximum possible rate. If the LAN or the 
VPN becomes overloaded and other programs experience problems using the network, this 
parameter needs to be changed thereby unloading the network. The suitable value 
is determined experimentally and is specified as a number, for example 256. 

• Normal traffic (KB/s). When more than an hour remains to the file's airing time, the file is copied 
at the rate specified in this parameter. The parameter can be changed should it become 
necessary.  

• Minimum disk free space (MB).  This parameter indicates the guaranteed amount of free 
space on the disk where copies are stored. It is used 
to leave space on the disk for other needs. If the program needs to copy files that take too much 
space, it starts deleting the files whose airing time has lapsed but the default deleting time has 
not come yet.  

• Block size, KB. An internal parameter specifying the block size for the copying operation. Users 
are recommended not to change the value of this parameter. This should be done by a qualified 
administrator only when fine-tuning the network. 

• Playback newer files on a network. This parameter allows playing newer files from a network 
resource back in case if they have not been copied to local storage yet. 

• Keep files in storage, Trace schedules beforehand for - these parameters operate the 
"depth" of archive. 

• Path to external file reserve archive. When there are several programs in the complex (e.g., 
DIGISPOT® II DJin, DIGISPOT® II BCS Editor, DIGISPOT® II DDB agents, etc.), the storage 
path (described above) is set only for the DJin program, which is the one that takes care about 
the reserve. The settings for the other programs specify only the path to the external file reserve 
archive. This is necessary, for example, when connecting two LANs into a Virtual Private 
Network (VPN), when references to the original files point from one LAN to another. This way all 
programs know where to look for the copies 
of files within their own networks. Other programs located on the same computer must also be 
specified this path in order to prevent their accessing the original copies. Hence, the first path 
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(Storage path) 
is specified for DIGISPOT® II DJin and the second one (Path to external file reserve archive) 
for the rest of the programs. 

The XML Category 
This category has a single subgroup: Items currently played. It comprises the following parameters: 

• Enable write to an XML file. Enables and disables recording to an XML file information about 
the currently played audio item and the audio items loaded into the players. It allows the other 
applications to be informed 
as to what the broadcasting station is broadcasting at the moment and what it is going to 
broadcast next. (That is, the information about the current and the next items is provided). The 
contents of the file are updated in sync with the changes of the players' contents. This function 
is used to generate the RDS string employed by the modern radio receivers to indicate the 
station's name and the title of the current music piece. 
It is also used to display the corresponding information on the station's site, posting to pagers 
and SMS, etc.  The information about the audio item title, author, etc., is stored in the file.  

• XML file name. The name of the XML file used for the recording. 
• Write log about (?) preloaded items – defines the number of items about which recording in 

log will be made. 
• Ignore items from directories, allows to exclude, for example, audio background and other, 

located in the listed directories, from a mention 
in the XML-report. 

• Run application upon file change. Allows to load the external appendix or to execute an 
external command at occurrence of new records in the XML-file. 

The Skeletons Category 
The Show hour headers, Show hour end, Show empty positions, Show conflicts that are 
supplementary parameters of the Skeletons category correspond to the analogous parameters of the 
Schedule category described previously. The difference is that settings in this category are effective only 
when preparing skeletons and do not affect the appearance of schedules in the program window.  

The Jingles Category  
The Jingles category has two subgroups: List of items and Jingle machine 'Jingles'. 

The List of items has the following two supplementary parameters: Show 'File' tab on audio item 
properties window and On double click, which are assumed to be understood without additional 
explanations. 

The Jingle machine 'Jingles' subgroup comprises many parameters to make working with the 
jingle machine more convenient. These are: 

• Columns. Sets the number of button columns in the jingle machine window. 
• Lines. Sets the number of button rows in the jingle machine window. 
• Banks. Sets the number of bank call buttons in the upper bar of the jingle machine window. 
• Additional rows of banks. Sets the number of additional bank rows in the jingle machine 

window. 
• Banks in additional rows. Sets the number of banks in additional rows. 
• Horizontal space (pixels) and Vertical space (pixels). Set the horizontal and vertical space size 

between the jingle machine buttons. 
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• Playback progress control height. This is the height of line (pixels) displaying the playback 
process. 

• Jingle restart. When set to Yes, clicking a jingle button again starts the jingle from the start; 
when set to No, doing this stops the playback. 

• Enable remote commands and Jingle ID's. When a jingle is played, issues to the COM port a 
control command linked to the given jingle. Used by the jingle replacement system. 

• Start only on active button press (mouse). When set to No, clicking 
a jingle button starts the playback immediately. When set to Yes, the first click activates the 
jingle button and the second click starts the playback.  

• Start only on active button press (keyboard). This parameter is similar to the previous one, 
but is used with the keyboard, when a jingle is started or a jingle button activated by pressing 
the corresponding key on the keyboard or the button field.  

• Stop playback on selection change. Stop of jingle playing back in case 
if selection changes. 

• Show time. Used to show the duration of a jingle in the upper right corner of its button. The 
possible values: Yes or No. 

• Show number. Used to show the jingle bank number in the upper left corner of its button. The 
possible values: Yes or No. 

• Show artist. Used to show the artist name in the button. The possible values: Yes or No. 
• Show 'First line' and Show 'Last line'. Used to display on the jingle machine button the 

contents of the First line and Last line fields of the audio item properties.  
• Show banks. Displaying of banks. By default this value is Yes. 
• Show PFL button - at switching on of the PFL mode, pressing the jingle button plays it back in 

the PFL device instead of airing it. The given operating mode can be switched on during airing 
any jingle (and check other jingles in the same time), however, switching of this mode off causes 
playing back stop. 

• Show playback progress. For displaying playback indicator. 

The MDB category  
The group of MDB parameters were added to new DJin versions. At the moment 
it includes only one parameter - On double click, which needs no explanations. 

The Voice Track Category 
A voice track is the speech recorded between two audio items. 

The voice track recording procedure usually comes down to the following. The user starts the 
playback of the first of the two audio items, between which a voice track needs to be inserted. The 
playback of the audio item is started shortly before its end. Sometime later, the user lowers the level of 
the audio item, turns on the recording, and starts his talk. At any moment he can stop the first audio item 
or start the other one. The playback of the second audio item is usually started 
at a low level. Having finished recording the voice track, the user raises the level 
of the second audio item to the nominal level and finishes the voice track recording by stopping the 
second audio item. The program provides means for remote control of the voice track recording by 
special blocks that can send to the program information about the fader movements (including the fader 
start and fader stop signals). 

Let's consider the supplementary parameters of the Voice track category. 
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• First playback device and Second playback device. These are the devices employed to play 
the audio item pair (currently, these are usually software processing devices). 

• Record device. Selects the record device that is fed the microphone signal. (Theoretically, the 
output of the entire console can be fed to this device to add various effects to the microphone 
signal.) 

• MIKE record device. This parameter allows selecting the MIKE device. 
• GPI source. Specifies the object that issues the fader start and fader stop information. When 

the playback is controlled by an external remote control device, these signals can be used to 
control the start and the end of the audio items playback. This is legacy parameter from the 
earlier versions 
of the program: Currently, all the necessary information can be obtained using the Mixer 
parameter. When configuring this parameter, the GPI source (of the remote control signals) 
linked to the Mixer object needs 
be to specified. The parameter is not used when the voice track recording 
is controlled from the keyboard or the mouse.  

• Mixer. This is special software object: a controller of virtual faders. When configuring this 
parameter, the name of the mixer linked to the required fader group needs to be specified. 
Usually, there is only one Mixer object 
in the system (if any at all), but the program can have more than one mixer should it be 
necessary. The parameter is not used when the voice track recording is controlled from the 
keyboard of the mouse.  

• First fader No. and Second fader No. These are the numbers of the Mixer object faders used 
for controlling the playback. For example, if the mixer has four faders, fader No. 3 can control 
the first audio item and fader No. 4 to control the second. The parameter is not used when the 
voice track recording is controlled from the keyboard or the mouse.  

• Record fader number. This is a number of the Mixer object faders, used for controlling as well 
as two previous parameters.   

• Seek step, sec. Before starting recording a voice track, the user can use the keyboard (or the 
mouse, or an external button field) to move the first audio item's playback starting point. The 
parameter defines the step, 
at which the start point moves when the left or right move key (button) 
is pressed once. 

• Preroll, sec. Upon opening of the window, the start point of the first audio item is defined 
automatically as the point located left on the time axis from the Outro point at the distance equal 
to the preroll value. If the audio items are not marked, that is, have no Outro marks, this is 
simply the distance from the audio item's end. It is configured to suit the user's wishes and 
preferences. 

• Fader B max deviation, ± dB. This parameter is meaningful only when the playback is 
controlled from an external fader. In a perfectly executed crossfade, the user moves the fader of 
the second audio item playback device exactly to the 0 dB point. But in the imperfect real life, 
when the recording is stopped the fader in most cases stops not exactly at the 
0 dB point, but somewhere on one or the other side of it. The parameter defines the maximum 
distance from the 0 dB point the fader can stop 
at the end of the recording. If the fader stops within the allowable range, the program corrects 
the stop, bringing the fader to the 0 dB point. In the process, the audio pattern changes a bit and 
the decision as to saving the result is made by the user after listening to the recorded crossfade. 
If the fader stops outside of the allowable range, the recording is considered 
to have failed and the result is not saved.   

• Temporary local path. The voice track recording file is saved 
in a directory named as the date of the schedule, for which the voice track is made. This 
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directory is in turn a subdirectory of the ROOT\SND_TMP directory. Most often, this directory is 
located on another computer. 
To avoid writing the file to the remote computer over the network, 
a directory can be specified on the local computer to store a temporary file in. The file is written 
to the permanent place on the remote computer only when the voice track recording is 
successful. By default, the temporary file path is blank. It is advisable to specify it only when 
there are problems writing over the network. 

• Autostart record. The parameter defines the state of the Autostart record mode when the voice 
track recording window is opened. It can be changed after the window is opened. If the mode is 
enabled, the recording starts automatically when the playback of the first audio item reaches the 
Outro point. If it is disabled, the recording starts upon the audio item's completion. The user 
retains the possibility to start the recording at any time. The parameter is set according to the 
user's preferences. 

• Notify if voice track should be ONAir in less than. This parameter operates automatic 
warnings of the system at speech tracks recording. 

• Use custom audio format. This parameter allows setting a separate format for recording of the 
speech tracks, distinct from the declared general format in system. 

• Custom audio format. In the given point configuration of the user record speech format is 
made. 

• Set PFL mode – Setting of the PFL mode at starting of the application. 

The rest of the Voice track category parameters are applicable only when the recording is 
controlled from the keyboard or the mouse (without a remote control system). Because in this case the 
user cannot use faders to smoothly control the fade ins and fade outs, he is offered one of the three 
predefined automatic level control settings (separate ones for the first and the second audio items). The 
speed, with which the program automatically adjusts the level, is set in settings Fast fade (F) (dB/sec), 
Mid fade (M) (db/sec), and Slow fade (S) (db/sec) as the rate of the level change in dB/sec. In the 
window, the Mode is indicated 
by letters F, M, and S (Fast, Medium, and Slow, respectively). 

After the playback of audio item 1 starts, by pressing the special key the operator can lower its 
playback level to the level set by the Lowered level, 
dB parameter. 

Pressing the second special key lowers the playback level to inaudible, which can be set by the 
Start fade-in from, dB parameter. The operator can start lowering the signal to the inaudible level at 
once by pressing this key first. 

The Files Category 
The Files category has the following two parameters: 

• On double click. Defines the action executed on double-clicking a file name: Prelisten 
prelistens the file; Properties displays file's properties. 

• Display directory on startup. Defines the catalog opened by default 
in the file-open dialog window. The possible values are My Computer, Favorites, Last open 
directory.  

• Allow delete files – needs no explanations. 

The F-Categories Category 
The supplementary parameters of the F-Categories category and their functions are given below. The 
possible values of the parameters are Yes or No. 
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• Clear filter on F-Category change. Clears or saves the file-viewing filter when switching to 
another F-Category.  

• Enable duplicate names enables placing audio items with the same names into one directory. 
• Ask for confirmation to delete item outputs a dialog window to confirm a file deletion request.  
• In addition, this category has the List of item subcategory comprising the following parameters: 

o Show 'File' tab in item properties window. The possible values are Yes or No. 
o On double click. Defines the action executed on double-clicking a file name: Prelisten 

prelistens the file; Properties: displays file's properties. 

4.12.2. Service > Global Settings command 
The Service > Global settings command calls the Global settings window for configuring parameters 
shared by all DIGISPOT® II system programs on all workstations at once. The Global settings window 
has the following nine tabs: Audio storage, DB storage; News tape; Schedule, Skeletons; Audio 
format, Other, Update from 
DB, and Playback channels by categories. 

The Audio Storage Tab 
The Audio storage tab of the Global settings window is shown in Fig. 4.133. 

 

 

Fig. 4.133. The Audio storage tab of the Global settings window 

The Audio storage tab of the Global settings window is used to specify the storage directories for 
files added to the MDB and F-Categories modules. The aggregate of all directories, into which 
DIGISPOT® II DJin automatically places files when they are added manually or automatically to the MDB 
or F-Categories module, 
is called the global storage. This can be accessed from any workstation. The global storage system 
always has one permanent directory that the system works with 
by default. This is the ROOT\SND directory. When a file is added to MDB 
or F-Categories, by default it is copied to this directory, becoming guaranteed available for access from 
all workstations by the virtue of being located in the ROOT catalog accessible from all the workstations. 
(See the discussion of Global settings > Other > Base settings for details on configuring the program 
actions upon adding a file.) 

Additional directories for adding files can be specified in the Storage directories list of the Audio 

storage tab. Catalogs are added to the list by clicking button ; only network resources can be added, 
like \\COMP\SHARE. Paths like D:\FFF cannot be added. F-Categories can work only with one storage 
directory; 
by default, this is ROOT\SND, the real path to which is shown in the Storage directories list.  
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To switch F-Categories to another directory, add its path to the upper list and then click the Def 
column field of the new path. After this, the files added to the 

F-Categories module will be copied to the specified directory. Clicking button  deletes the selected 
directory from the list, but only if neither the directory itself nor any of its subdirectories are used in the 
bottom list.  

The Def attribute for the ROOT\SND directory is set by default. Unlike other items of the directory 
list, the ROOT\SND directory cannot be deleted. 

For editing directories list, in which audio files are stored, use the buttons: 

 — opens the dialog window for selecting the directory to add it to the storage directory list. 

 — deletes the selected list item. 

The DB storage tab 
The DB storage tab is intended for distribution of files in storage depending 
on material type and category to which it belongs. This list is used only at working with MDB. 

Pressing of the Add button opens a window allowing the administrator 
to select material type and category, and also to specify the directory to which files should be located at 
addition of material of the given type to the specified category. The path should be the directory from the 
top list or any its subdirectories, 
i.e. should be inside the storage. Any quantity of records can be added in the list. For example, all items 
of News type should be located in the \\SERVER\NEWS directory (while adding records the Category 
field was empty), and item of News type, belonging to the SPORT category, will be located in the 
<\\SERVER\NEWS\SPORT> category. 

Pressing Add button opens the DB Storage Item window, allowing to select material type and its 
category, and also to specify the directory to which files after addition to the specified category of 
materials of other type should be located. 

The News tape tab 
The list of categories of news to display and parameters of the news filter are located on the News tape 
tab of the dialogue window Global settings. This group of settings is used only if in the corresponding 
module is applied. 

The Schedules Tab 
The Schedules tab of the Global settings window is shown in Fig. 4.134. 

 

 

Fig. 4.134. The Schedules tab of the Global settings window 
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The Schedules tab is used to inform the system of the location of the schedules others than the 
standard schedule located in the ROOT\PLAYLIST directory. 

The information specified in this tab is used by the system on loading 
a schedule and providing user with a choice of which schedule to open. In addition, this information is 
used by the system itself, for example, to weed out unused material. The need to use the tab arises only 
when more than one schedule is used, for example for several stations or for several broadcasting 
frequencies.  

A schedule is added by clicking button  and entering first the schedule name and then the path 
to the directory it is stored in.  

The Skeletons column contains the information from which skeletons the corresponding schedule 
will be created. 

The Skeletons tab 
The Skeletons tab of the Global settings dialogue window in many respects 
is similar to the Schedule tab; the list of accessible skeletons consisting of two columns also contains 
here: Name and Path. 

The Audio Format Tab 
The Audio format tab of the Global settings window is shown in Fig. 4.135. 

 

 
Fig. 4.135. The Audio format tab of the Global settings window 

The Audio format tab is used to set the digitized audio parameters 
to be used as default when recording audio, saving the results of an editing workstation work, etc.  

The dropdown list Sampling frequency, Hz is used to select one of the three standard sampling 
frequencies: 32000, 44100, or 48000 Hz. 

The Audio format field displays the audio format currently installed in the system. Clicking button 
 opens the Default format window (Fig. 4.136), 

in which the current setting can be changed. 
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Fig. 4.136. The Default format window 

The Sampling frequency field displays the value set on the Audio format tab itself. The sampling 
frequency cannot be changed in the Default format window.  

The radio buttons of the Compression group are used to select the recording compression 
algorithm. With the Linear option selected, the audio is recorded uncompressed. The other options 
compress the recording in one the MPEG standard version. 

With one of the MPEG algorithms selected, the Stream dropdown list can 
be used to select the stream rate that defines the compression coefficient. This list is inactive for the 
linear mode. The recording type is selected by the radio buttons left of the Compression group. A mono 
and three stereo options are available. 

NOTE 
Broadcast quality recording is obtained with the following settings: Mpeg1 Layer2 compression, 256 Kb/s stream for stereo or 
128 Kb/s stream for mono.  

The current format of record set in the system is displayed in the Record Format field. Pressing on 
 button calls the similar Default format window (Fig. 4.136), in which to change the current settings is 

possible. 

The Other Tab 
The Other tab of the Global settings window is shown in Fig. 4.137. 
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Fig. 4.137. The Other tab of the Global settings window 

The Parameter working field of this tab has three categories of the supplementary parameters: 
Base Settings, Schedule, Audio files marking, Audio, Audio files, MDB, Audio log, Video log. Let's 
characterize additional parameters available here. 

The Base settings category  
The Base settings category contains following parameters: 

• Storage of waveforms for URL files (ROOT\\SS8). These parameters make it possible to 
optimize the disk space usage and to reduce the processor workload by specifying the directory 
for storing the waveforms. The waveform is displayed in some windows. Calculating the 
waveform every time anew requires additional time. Therefore, after a waveform was calculated 
for the first time, the data necessary to display it are saved 
in a file with extension SS8.  For a file opened over a network path (like 
\\SERVER\MUSIC\AAA.WAV), the SS8 file is placed into this directory because there is a good 
chance that it can be opened from another workstation. The network name does not change in 
the process and the program uses the image calculated at a previous access, possibly even 
at another workstation. It is expedient to change the path explicitly because generally, the larger 
part of the waveforms is stored exactly in this directory and their size can amount to hundreds of 
megabytes. If the parameter is blank, ROOT\SS8 is used.  

• Audio update source path. Defines the address on which the search 
of automatic updating should be done. 

• External storage directories. This list is used to specify directories that are not part of the 
storage (consequently, the program will not add 
or delete files in these directories) but accessible from all workstations. Files added from these 
directories (or from any of their subdirectories) 
to the F-Categories and MDB modules are never copied to the storage. The user is responsible 
for having the files that the system has remembered as being in these directories actually there. 
The system takes his word for it. For example, a radio station already has the \\SERVER\MUSIC 
directory with subdirectories for storing the musical archive. In order to prevent repeated file 
copying to the DIGISPOT® II system storage (e.g., when working with the F-Categories or 
MDB modules), the path \\SERVER\MUSIC is added to the list of the external storage 
directories. Because this path is not included into the storage, the DIGISPOT® II system never 
attempts to delete files from there. As a result, the musical archive is safe regardless of whether 
or not it is used by the DIGISPOT® II system.  
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• Copy to global storage. This parameter defines whether the file should 
be added to the storage when it is added to the F-Categories or MDB module. As a rule, the 
default Always setting should be kept. The Never and Ask are used quite seldom to meet 
specific requirements and only after consulting with the program developers.  

• Search for previous copy of added file (DB) and Search for previous copy of added file (F-
Categories). These are analogous parameters but each works with its corresponding module. 
Before attempting to copy the file to the storage, the system searches the storage for a copy of it 
in there. If an old copy of the file is found, the system does not copy the file again but 
remembers the reference to the file's old copy instead. This results 
in saved disk space and in shorter times taken by the operation of adding files to F-Categories 
or the MDB. A special search system is used to look for copies of the file. This makes it possible 
to locate even those file copies that have been recoded into different audio format when added 
to the storage. In this case time savings are even more significant. By default, this parameter is 
set to Yes. 

• Convert to default audio format (DB) and Convert to default audio format (F-Categories). 
These parameters serve to convert the copied file audio format to the default format (which is 
set in Global settings/Audio format). In this way, the uniformity of the files in the storage is 
achieved. By default, this parameter is set to No. 

• Don't add to F-Category when file names are the same. The default value is No, meaning 
add the file even if there is a copy of it. In this case, a numerical postfix is added to the file 
name. For example, if file ROOT\SND\1.WAV already exists, a copy is added and named 
ROOT\SND\_(09827356).WAV. With this parameter set to Yes, in this situation the system 
issues a warning messages and the copying operation fails. The parameter is used for solving 
particular tasks connected with specific material storage organization. 

• File access timeout and Network connection timeout. - The parameters allowing lowering 
essentially the server load at presence of the big local broadcasting network. The given 
parameters should be specified by developers; it is not recommended to change them without 
consultation. 

• Allow local paths for storages. This parameter needs no explanations. 

The subgroup of Clean unused material parameters contains the following options which meaning 
are clear from their names: 

• Delete schedules after; 
• Delete temporary files after. 

The Schedule category 
The group of the Schedule parameters includes the following parameters: 

• Time calculations inside the hour only. This parameter needs 
no additional explanations. 

• Ask for confirmation on delete operation. Enables an additional query to the user at attempt 
to delete the schedule item; by default it is switched off. 

The Audio files marking category  
The Audio files marking category comprises the following supplementary parameters:  

• Start threshold (dBFs) sets the signal value (in dB, relative to the maximum level) interpreted 
by the system as the audio item start.  

• Stop threshold (dBFs) sets the signal value (in dB, relative to the maximum level) interpreted 
by the system as the audio item end. 



Cooperation for Development of Hard-and Software 
for Audio and Video Broadcast Studios in East and 
West Europe. Design and Manufacturing of Studio 
Equipment  for the Audio recording Industry and the 

 

 
e.mail: info@tract.ru   e.mail : infor@barthkg.com  
 web :http//www.tract.ru   web : http://www.barthkg.com 
 

    

 

copyright: RBKG&TRC  Page 207 of 219 

in field of Video Postproduction. 

• Fade-in (ms) sets the fade-in time (in ms) (the time it takes the fade-in to go from the starting 
threshold level to the maximum). 

• Fade-out (ms) sets the fade-out time (in ms) (the time it takes the fade-out to go from the 
maximum level to the output threshold level). 

The Audio category 
The Audio group comprises the following parameters: 

• Default method FADE-IN (OUT) processing. The parameter is used 
to specify the default way to play fades specified on the Audio marking tab of the audio item 
Properties window. With the parameter value set 
to Linear, the gain factor (as a multiplier) changes linearly from 0.0 to 1.0. With the parameter 
value set to Logarithmic, the gain factor changes linearly as a unit expressed in dB, which 
produces more natural sound. The value is set according to the user preferences. 

• Default VU meter settings. Defines default settings for indicators 
of a level in the program. Selecting this parameter calls the standard window Indicator settings 
where it is possible to set all necessary values. 

The Audio Files Category 
The Audio files category has only one parameter: Read damaged WAV files. 
It defines whether damaged WAV files should be attempted to be played back. The possible values: Yes 
or No.  

The MDB category (DB) 
The MDB group includes the following parameters: 

• Store file SRC in the DB. This parameter allows control a file change with the help of the 
control sum kept in MDB. 

• Show items count for categories. 
• Use SQL_MODE_READ_ONLY mode for SELECT. Setting of the given parameter in case of 

need helps to reduce MDB server load in case of a big number of the connected workplaces. It 
is recommended not to change this parameter on your own. 

• Use static cursors for SELECT. 
• Use service to get DB modifications. 
• Time-out for background SELECT as setting of SQL_MODE_READ_ ONLY mode, this 

parameter allows to reduce MDB server load in case 
of a big number of the connected workplaces. It is strongly recommended not to change this 
parameter on your own, address to our developers. 

The subgroup of Drag and Drop parameters also contains here, including following items:  Without 
extensions keys, With Ctrl and With Shift, determining the response of the application to various ways 
of applying Drag and Drop method by the user. 

Audio / Video log categories 
The groups of parameters Audio log and Video log contain only one by one parameter Channels (the 
name and path of files storage). This parameter allows operating the list of logging channels. 

The Update from DB Tab  
The Update from DB tab of the Global settings window is shown in Fig. 4.138. 

The parameters on the Update from DB tab are used to configure the automatic synchronization of 
the schedule items when the source data in the database change. On this tab, you can specify the 
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material type and the categories of this type, for which the synchronization is enabled or, on the contrary, 
disabled. These are general settings. 

The material type is selected in the Type dropdown list. 
The Categories to sync group is used to set the synchronization algorithm. The names of the 

algorithms are self-explanatory:  
• Do not sync 
• Categories from list only 
• Except categories from list 
• Synchronize all categories 

 

Fig. 4.138. The Update from DB tab of the Global settings window 

In the F-Categories and MDB modules, the automatically synchronized items are marked with a 
special icon  (with a red arrow at the bottom). 

This is a general setting. The automatic synchronization for a specific schedule item can be 
enabled/disabled from the item Properties window on the Other tab. The item must have a DB ID.  

Suppose, for example, an item has been added to the schedule from the MDB (or it has been 
imported to the schedule and linked with an MDB item) and then 
an MDB item with the same DB ID has been changed. If the given item belongs 
to the MDB area, for which the automatic update is enabled, sometime later the contents of the schedule 
item get updated and become identical to the item's description in the MDB.  

This capability is needed to enable adding items to a schedule that have 
no actual contents at the moment they are scheduled. Most often, such situation arises when working 
with news. On receiving the information, the news editor fills the contents of the given items, which is 
reflected in the schedule. 
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The Playback channels by categories Tab 
The Playback channels by categories tab of the Global settings window 
is shown in Fig. 4.139. 

Specific categories can be assigned to specific player channels by clicking the dot on the 
intersection of the category row and the player channel column. For example, in Fig. 4.139 a 
configuration is shown, in which commercials are played over channel A, jingles are played over channel 
B, music and broadcasts are played over channel C, and news and voice tracks are played over channel 
D.  

Being able to distribute categories over the channels not only creates comfortable working 
conditions for the operator but also makes it possible 
to process materials of different audio nature differently, thereby optimizing the parameters of the signal 
fed to the transmitter.  

 

 

Fig. 4.139. The Playback channels by categories tab 
of the Global settings window  

4.12.3. Service > Workstation Settings  
The Workstation settings command opens the Workstation setup window (Fig. 4.140), in which all 
DIGISPOT® II system programs on the given workstation can 
be configured. 

NOTE 
Modifications made in one program affect other programs of the given workstation. 

The workstation settings parameters are grouped into two categories: Base settings (restart 
required) and Database. 

The Base settings (restart required) has the following two parameters: 
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• Root path (ROOT). This is a certain network path accessible from 
all system's workstations (computers). This path is one of the system's most important 
parameters and is called the Root path or simply the Root.  

• Storage of waveforms for local files (START\\SS8). This parameter makes it possible to 
optimize the disc space use and to reduce the processor workload. In some program windows, 
the signal waveform 
is displayed. Calculating the waveform every time anew requires additional time. Therefore, after 
a waveform was calculated for the first time, the data necessary to display it are saved in a file 
with extension SS8. If the file that was accessed was located on the local disk, its corresponding 
waveform 
is placed into this directory.  

• The Software update parameter needs no additional explanations. 

 

Fig. 4.140. The Workstation settings dialog window 

The names of the Database parameters and their functions are as follows: 
• ODBC source. This is the data source via which the DJin works with the MDB proper. A data 

source linked with a MS SQL SERVER 2000 database, 
in which the contents of the MDB are stored, must be specified as a value for this parameter. A 
convenient way to edit this parameter is from the 
DB settings window that can be opened from the MDB window 
by pressing button  on its toolbar.  

• User name. 
• Password. The database access password. 
• DB owner name. Defines the name of database owner in a case if several broadcasting 

stations work with the same network. 



Cooperation for Development of Hard-and Software 
for Audio and Video Broadcast Studios in East and 
West Europe. Design and Manufacturing of Studio 
Equipment  for the Audio recording Industry and the 

 

 
e.mail: info@tract.ru   e.mail : infor@barthkg.com  
 web :http//www.tract.ru   web : http://www.barthkg.com 
 

    

 

copyright: RBKG&TRC  Page 211 of 219 

in field of Video Postproduction. 

• Period for checking changes (sec). This is the time interval, at which the program queries the 
database for any new changes. 

• Use service to get DB modifications. 
• Show floating window with new devices. Displaying on top 

of all windows a window, in which the information about all the new MDB objects is displayed in 
a ticker-tape message. Clicking this window opens another window, in which these items are 
displayed in a list, after which the window disappears until new items are added.  

4.12.4. Service > Customize Keyboard  
The Service > Customize Keyboard command calls the Keyboard and remote control settings 
window (Fig. 4.141). This window comprises the DJin functions and commands that can be assigned 
keyboard keys, thereby creating a bank 
of hotkeys for direct calling of commands and functions. If the system is equipped with remote control, the 
remote control commands (GPI or RS232) can be similarly configured. 

 

 

Fig. 4.141. The Customize Keyboard and remote keypads window 

You can make the program easier to use by assigning a remote control button, or a keyboard key, 
or a key combination to frequently performed operations. For example, the jingle machine can be 
configured to be controlled from the keyboard and then a jingle can be played by simply pressing a single 
key.  

Let's consider the functions of the window's fields and controls.  
In the Name column of the Functions work area, a list of various operations employed by the 

program is located, for example, starting/stopping and loading players, playing a jingle, changing jingle 
banks, etc. A list of the default hotkeys 
is located in the Key column. A list of the remote control system buttons assigned to different operations 
is located in the RS-232 column. There are no default buttons of this type.  
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An operation is selected by left-clicking on the corresponding line in the Name column, upon which 
the name of the key assigned to this operation appears in the Keyboard-Key column in the bottom 
working area. Double clicking on the set action in columns Standard mode and Mode REC  (or on an 
empty field in the same columns) opens Edit key window (Fig. 4.142). 

Let's consider elements of the interface of Edit key window. The information on the chosen action 
is located in Info group. The Currently assigned keys list contains the information on operation ways 
already appointed for the given action. By default this list is closed for editing. To remove a combination 
of keys, 
it is necessary to take a tick off from Use default settings parameter. Later, if this parameter will be 
chosen again, all user settings will be removed. 

 

Fig. 4.142. The Edit key dialog window 

The new key is set by means of the Assign new key group of parameters. The Distinguish main 
and ext. keyboard parameter allows expanding a range 
of used buttons. At a new key selecting the actions which have already been appointed to the given 
keyboard command (conflicts) are highlighted in the Selected keys also used window. It is possible to 
select RC buttons analogously. DU. Note, that there is a possibility to set more than 1 key combination for 
each action. 

The Fast assign mode button allows bringing the settings directly in the Customize keyboard and 
remote keypads window. The Print button allows sending all current configuration on the printer. Reset 
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to defaults returns 
all settings to accepted in system by default. 

All keyboard settings executed in the Customize keyboard and remote keypads window, are kept 
in configuration file *.keys. 

Note, that any floating window now blocks the keyboard commands "intended" to other windows. 

4.12.5. Service > Fonts  
Command Service > Fonts opens the Fonts setup dialog window (Fig. 4.143). 
It allows the user to set fonts for different windows and lines of the DIGISPOT® II DJin system. 

 

 

Fig. 4.143. The Fonts setup dialog window 

You can change the parameters of the fonts used in the program: the font type, its size, the color, 
etc. This allows you to set out the components important for you, to reduce the distraction from the 
secondary components, and to enhance your perception of the presented information. 

The window lists the window components and font types used in the program at the present time. 
To change the used font, double-click the selected list item, and in the standard Windows font attributes 
window that opens configure the font to your preferences. 

4.12.6. Service > Import Formats 
The Service > Import formats command opens the Import format dialog window to configure the format 
of the imported schedule. A detailed description 
of this window is given in Section 4.10.8. 

4.12.7. Service > Reserve System Status 
Command Service > Reserve system status opens the corresponding dialog window (Fig. 4.144). 

The window File Reserving system info is used to obtain information about the state of the 
reserve system in the following ways: 

• To view a list of files present in the system and to ascertain their status: Whether a file is 
reserved or not and the deletion date. Files can be filtered by the filter located at the top of the 
list.  
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• To obtain information about the current state of the system: Which file 
is being copied and at what speed. 

• Find out the amount of the free space left in the destination directory. This information is 
displayed in the progress indicator bar located at the top 
of the window with the bright-green stripe corresponding to the occupied disk space. 

The Reserve system status window can be used to copy files for a specific broadcasting day by 
selecting the date in the standart date entry window and clicking the Reserve button.  

 

Fig. 4.144. The Reserving system status dialog window  

Using the context menu of the file list, items can be deleted before their scheduled deletion time or 
their automatic deletion date changed. Also, the order 
in which files are copied can be changed by explicitly specifying their airing date. 

4.12.8. Service > Fast Jingles Setup 
Command Service > Fast jingles setup calls the same-name dialog window (Fig. 4.145). 

The window is used to view and modify the settings of the fast jingles system. Button field layouts 
can be created or deleted and their contents edited: buttons added or deleted and their contents 
changed. These settings affect all workstations of the system, that is, they are global. 

The bottom part of the window, the Players work area to be more exact, 
is used to create players and to configure them by specifying the playback devices associated with them 
and the layouts to be played. These settings are effective only for the workstation they are configured at. 
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A player is added in the Fast jingles player setup dialog window (Fig. 4.146), which is opened by 
clicking the Add button. 

 

  

Fig. 4.145. The Fast jingles setup dialog window 
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Fig. 4.146. The Fast jingles player setup dialog window 

This window can also be opened from the Fast jingles setup window 

by clicking the button  and then clicking the Details button in the window that opens. 

4.12.9. Service > Hardware devices 
Command Service > Hardware devices opens a submenu comprising commands Digigram, Antex, 
Audio Mixers, and Retransmission channels that in turn open configuration windows for the 
corresponding hardware devices. 

Command Service > Hardware > Audio Mixer 
Command Service > Hardware > Audio Mixer opens dialog window Mixer controls setup with two tabs 
on it: Audio devices and mixers (Fig. 4.147) and Calibrate mixer controls (Fig. 4.148). 

 

 

Fig. 4.147. Dialog window Mixer controls setup, Audio devices and mixers tab 

The options of the Audio devices and mixers tab are used to link playback devices and mixer 
controls. Namely, mixer controls can be specified to be used 
to control the level of the signal recorded or played over the selected audio device.  

There are three types of controls in the program: 
• Recording. This control is associated with a recording device and controls the level of the signal 

recorded by this device. 
• Retransmission. This control is associated with a specified recording device and controls the 

signal transit from the given input to the audio card output.  



Cooperation for Development of Hard-and Software 
for Audio and Video Broadcast Studios in East and 
West Europe. Design and Manufacturing of Studio 
Equipment  for the Audio recording Industry and the 

 

 
e.mail: info@tract.ru   e.mail : infor@barthkg.com  
 web :http//www.tract.ru   web : http://www.barthkg.com 
 

    

 

copyright: RBKG&TRC  Page 217 of 219 

in field of Video Postproduction. 

• Playback. This control is associated with a given playback device and controls the level of the 
signal emitted from the specified output.  

 

Fig. 4.148. Dialog window Mixer controls setup, Calibrate mixer controls tab 

All controls must operate independently: changing the recording level must not affect the signal 
transit, and vice versa. The reason for the settings in the Audio devices and mixers is the circumstance 
that the controls cannot be defined automatically. 

The settings are used for real-time signal regulation — for example, when working with the 
DIGISPOT® II DJin 777 configuration and having to smoothly switch from and back to the retransmission 
or when recording a voice track and controlling the signal level of the device from an external fader. This 
setting need not 
be configured when using software processing playback devices. The options of the Audio devices and 
mixers do not apply to the Antex and Digigram audio cards. These cards have special configuration 
windows. 

The Calibrate mixer controls tab is used to calibrate mixer controls. In the Windows operating 
system, a signal is regulated by a mixer slider within a certain conventional unit range: from 0 to 65,535, 
the minimum and the maximum, respectively. The program does not know the exact gain factor 
corresponding 
to a certain position of the slider and there is no way for it to find it out. Neither does it know the law, 
pursuant to which the gain factor changes (e.g., linearly, logarithmically, etc). All program settings (gain 
factors, fades, crossfades) are specified in decibels.  

The Calibrate mixer controls tab can be used to specify the correlation between the positions of 
the slider and the gain factor in dB by specifying node points in the control range. This is done by 
selecting the mixer regulator used in the Audio devices and mixers setting in the tree on the left and 
setting the node points in the list on the right, specifying the correspondence between the position and the 
gain factor for each point. Clicking the Add button opens the Position and gain window (Fig. 4.149), in 
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which the coordinates of the node points can 
be specified.  

 

Fig. 4.149. The Position and gain window 

The gain factor values between the node points are linearly approximated 
by the program. The coordinates of a node point can be edited by clicking the Edit button on the 
Calibrate mixer controls tab.  A node point is deleted from the list on the right by selecting it and clicking 
the Delete button. 

Command Service > Hardware > Retransmission channels 
Command Retransmission channels opens the Retransmission channel properties window (Fig. 
4.150). 

 

 

Fig. 4.150. The Retransmission channel setting dialog window 

A retransmission channel is a recording device and a playback device, through which pair the signal 
transits physically when retransmitted by hardware (with the level regulated by the mixer) or by software 
(recorded by the recording device and played by the playback device with the level controlled by 
software). The Retransmission channel settings window (Fig. 4.151) is used to create 
a retransmission channel by selecting the device pair and specifying the type of the signal transit. It is 
opened by clicking the Add button. 

The information about the retransmission channel is used when configuring the retransmission 
system in DIGISPOT® II DJin 777 and in other retransmission modules. When software data transfer is 



Cooperation for Development of Hard-and Software 
for Audio and Video Broadcast Studios in East and 
West Europe. Design and Manufacturing of Studio 
Equipment  for the Audio recording Industry and the 

 

 
e.mail: info@tract.ru   e.mail : infor@barthkg.com  
 web :http//www.tract.ru   web : http://www.barthkg.com 
 

    

 

copyright: RBKG&TRC  Page 219 of 219 

in field of Video Postproduction. 

employed, both devices must be clocked from the same clock source, otherwise there will be breaks in 
the retransmission. 

 

Fig. 4.151. The Retransmission channel settings window 


	Appreciation
	TABLE OF CONTENTS
	1�STRUCTURE OF THE MANUAL
	2�INTRODUCTION TO THE DIGISPOT® II SYSTEM
	2.1. The Purpose and Application Areas of the DIGISPOT® II S
	2.2. DIGISPOT® II Functions
	2.3. DIGISPOT® II Software Structure
	2.3.1. The Basic Software
	2.3.2. Utilities for Database Work
	2.3.3. Data Manipulation Utilities
	2.3.4. Auxiliary Utilities

	2.4. System Requirements
	2.5. Recommended Audio Cards
	2.5.1. Antex Audio Cards
	Advantages
	Peculiarities

	2.5.2. Digigram Audio Cards
	Advantages
	Peculiarities

	2.5.3. RME Audio Cards
	Advantages
	Peculiarities

	2.5.4. Audio Cards from Echo Audio
	Advantages
	Peculiarities

	2.5.5. Creative Labs Audio Cards
	Advantages
	Peculiarities

	2.5.6. Audio cards Marian
	Advantages
	Peculiarities

	2.5.7. Audio cards Lynx
	Advantages
	Peculiarities

	2.5.8. Axia IP Audio Driver

	2.6. Remote Control

	3�DIGISPOT® II OPERATION AND TECHNIQUES
	3.1. Data Types
	3.2. Digitized Sound
	3.3. Metadata
	3.4. Audio Files Supported by the DIGISPOT® II System
	3.5. Text Files, Projects, and Subjects
	3.6. Schedules and Skeletons
	3.7. Schedule-Creation Methods
	3.8. Blocks
	3.9. Block Creation Methods
	3.10. Block Items
	3.11. Time-Referencing and Conflict-Resolving Methods

	4�DJIN – A SCHEDULING AND BROADCASTING SYSTEM
	4.1. Planning and Editing a Schedule. The Skeleton Wizard an
	4.2. Displaying Schedules and Skeletons
	4.2.1. Displaying Blocks
	4.2.2. Displaying Items and Calculating Time
	4.2.3. Displaying Schedule Conflicts
	4.2.4. Displaying Auxiliary Schedule Items

	4.3. Creating Skeletons
	4.4. Editing Skeleton and Schedule Contents
	4.4.1. Loading a Schedule
	4.4.2. Working with Blocks. The Block Properties Window
	4.4.3. Adding Items to a Block
	4.4.4. Importing a Schedule from a Text File. The Import fro
	4.4.5. Editing Item Properties. The Item Properties Window
	Automatic Update from the MDB
	Rotated Items

	4.4.6. Controlling Item Contents
	Prefade Listen
	Text Preview

	4.4.7. Decking Out a Schedule
	4.4.8. Editing Crossfades. The Crossfade Editing Module
	Autoglueing (Auto crossfade)

	4.4.9. The Schedule Audio Item Edit Module
	4.4.10. The Search for Start Point Module
	4.4.11. Voice Tracks Record Module in the Schedule

	4.5. Configuring the Skeleton Wizard and the Schedule Module
	4.6. Working with Players
	4.7. Player Modules
	4.7.1. The Block Player
	Functions of the Block Player Window Controls
	The Block Player Context Menus
	The Player properties window

	4.7.3. The Multichannel Player (X Player)
	The Multichannel Player Operating Modes
	The Functions of the X Player Window Controls
	Х-player context menu
	Configuring the X Player Window

	4.7.4. The Retransmission Player (Player 777)
	Functions of the Retransmission Player Window Controls
	The Retransmission Player Properties Window

	4.7.4. The Jingle Machine Player
	The Jingle Machine Player Window
	The Jingle Machine Player Context Menu

	4.7.5. The Fast Jingles Player

	4.8. Data Modules
	4.8.1. The Files Module
	4.8.2. The F-Categories Module
	4.8.3. The Media Database Module
	The MDB Module Window
	The MDB Window Toolbar
	The List of Categories
	The Attribute Values List
	The Item List
	The Specifics of Adding and Deleting MDB Items
	Administering MDB
	The Common tab of the DB administration window
	The Attributes and their values tab of DB Settings window
	The Deleted objects tab
	The Radio stations tab
	The Export tab
	Utils tab of DB settings window
	Joint Operation of Several Stations with One Database
	Configuring User Access Rights


	4.9. The Auxiliary Systems and Modules
	4.9.1. The Prefade Listen System
	Previewing Text

	4.9.2. The Administration System
	4.9.3. The On-Air Log-Generation System
	4.9.4. The Printing System
	4.9.5. The Local Disk Data Reserve System
	4.9.6. The System to Merge Schedules to Audio Files
	4.9.7. Module to Import Schedules from Text Files
	4.9.8. The Gap Filler Module

	4.10. The Auxiliary Windows
	4.10.1. The Audio Item Properties Window
	The General Tab of Properties window
	The Attributes Tab
	The Remote control Tab
	The MAG tab�of Properties window
	The Comments Tab of the Properties window
	The Media tab on the Properties window
	The File Tab of the Properties window
	The Marking Tab
	The Extended Tab
	The Other tab of the Properties window

	4.10.2. The Clock Window
	4.10.3. The Text Messages Window
	4.10.4. The Current Audio Item Status Window
	4.10.5. The Messages Window
	4.10.6. The List Customization Window
	4.10.7. The Remote Control Setup Window
	4.10.8. The Import Format Window
	Fields Affecting Determining the File Name
	The Preprocessor Window
	The Definitions tab
	Other parameters
	Importing from the F-Categories Module
	Importing from the MDB
	Testing Blocks


	4.11. Overview of the DJin Program Main Menu
	4.11.1. The File Menu
	Command File > Select Profile
	Command File > Select configuration
	Command File > Login
	Command File > Administration
	Command File > Restart
	Command File > Exit

	4.11.2. The Editor Menu
	4.11.3. Menu View and Toolbars
	Command View > AudioEditor
	Command View > Files
	Command View > F-Categories
	Command View > GPI Status

	4.11.4. Menu Service
	4.11.5. Menu Help

	4.12. The DIGISPOT® II DJin Program �Configuration System
	4.12.1. Service > Settings
	The General Tab
	The PFL Tab
	The Text Tab
	The Playback Tab
	The Log Tab
	The Log fields Tab
	The Language tab
	The Shares Tab
	The Other Tab
	The Interface Category
	The Audio Files Marking Category
	The Text Category
	The Base Settings Category
	The Debug logs category (restart needed)
	The Schedule Category
	The External Program Launch Category
	The Audio editor category
	The Audio files category
	The Prelistening Category
	The Copyright registration category
	The Audio Devices Category
	The Audio Reserving System Parameters Category
	The XML Category
	The Skeletons Category
	The Jingles Category
	The MDB category
	The Voice Track Category
	The Files Category
	The F-Categories Category

	4.12.2. Service > Global Settings command
	The Audio Storage Tab
	The DB storage tab
	The News tape tab
	The Schedules Tab
	The Skeletons tab
	The Audio Format Tab
	The Other Tab
	The Base settings category
	The Schedule category
	The Audio files marking category
	The Audio category
	The Audio Files Category
	The MDB category (DB)
	Audio / Video log categories
	The Update from DB Tab
	The Playback channels by categories Tab

	4.12.3. Service > Workstation Settings
	4.12.4. Service > Customize Keyboard
	4.12.5. Service > Fonts
	4.12.6. Service > Import Formats
	4.12.7. Service > Reserve System Status
	4.12.8. Service > Fast Jingles Setup
	4.12.9. Service > Hardware devices
	Command Service > Hardware > Audio Mixer
	Command Service > Hardware > Retransmission channels




